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Introduction

Welcome to Mastering Autodesk® Revit® MEP 2016. 1 have worked diligently to bring you a book
that takes you through the core features and functionality of Revit MEP 2016 from both the
design and documentation perspectives.

I first started using Revit MEP in 2006 when it was known as Revit Systems. Since then the
software has been on a fast-track development pace to bring it up to speed with the Autodesk®
Revit® Architecture and Autodesk® Revit® Structure programs. This 2016 release of Revit MEP
provides platform improvements (that is, of features shared among the three discipline-focused
versions) along with MEP-specific features that make this a very exciting edition.

When Revit Systems was first released, it was intended primarily to allow MEP engineers to
join the move toward building information modeling (BIM) that was being adopted by architects
and structural engineers. The features and functionality were, in the opinion of most, limited to
provide a complete MEP project. The development team has been listening to the needs of users
and has now delivered tools and features that many of us have desired from the beginning. The
focus has been on performance in this release, improving performance by managing when cal-
culations are performed and how elements are processed in views, resulting in more efficiency
while users navigate views. With the introduction of fabrication parts, Revit can now go the full
distance in a project, from concept to handover.

The primary focus of this book is on the MEP disciplines, but there is plenty of information
that applies to Revit in general. My goal is to take you through the major points of the design
process and requirements for completing a building design and project submittal. This book
focuses on building engineering, but it may also be helpful for other types of engineering
projects, such as process piping design or any others that require a combination of data and
model components.

The book consists of five parts, the first of which covers general functionality that is useful
for all disciplines. You will find suggestions throughout the book for including features
and components in your project templates. The first part does not cover every pick and click
available in the software; it approaches the use of Revit from a best-practices standpoint, which
I hope will inspire you to think about ways to make Revit work best for you. Any specifics not
covered were not omitted to imply that they are unimportant but simply because you can find
information about these features in the documentation provided by Autodesk and in Revit MEP
2016 Help.

The next three parts of the book are MEP specific and have been written to cover the key
design areas of each individual discipline (mechanical, electrical, and plumbing). Again, I'm
focusing on best practices by relating my professional experience with not only the software
but also the design industry. In an effort to tie it all together, the fifth part of the book contains
information to help you optimize your Revit experience by learning the tools and features
available for creating the various components that make up an MEP model.
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Computer Maintenance

In my experience, some of the most common problems associated with any type of computer
use are directly related to the user not maintaining their hardware. Now, I'm certainly not
trying to antagonize anyone, but having been a user, manager, and implementation specialist for
a number of years, poor maintenance is the number one reason for problems. Let’s take a look at
some of these issues and what can be done to rectify them.

Hardware

If you don't get this right, you are going to struggle from the outset. The majority of BIM- and
CAD-related programs—and, let’s face it, the operating systems they run on—are memory
intensive and will require a good spec machine to run on. Check out www.autodesk.com
/certified-hardware to make sure that at the very least, your hardware matches the
specifications shown there.

RAM

I can’t repeat this enough: the more RAM the better. In the scheme of things, RAM is cheap.
Don’t skimp on it, and although system requirements are adequate, my laptop is configured
with 32 GB of RAM and my workstation has 64 GB. How much RAM you buy largely depends
on your budget and the type of projects you are likely to work on. System requirements can be
found here: http://knowledge.autodesk.com/support/revit-products/troubleshooting
/caas/sfdcarticles/sfdcarticles/System-requirements-for-Autodesk-Revit-2016-
products.html.

Graphics Card

One of the best options when choosing a graphics card is to visit the Autodesk website:

www . autodesk.com/certified-hardware. The search function allows you to explore certified
and recommended graphics cards. It’s worth bearing in mind that those same manufacturers
also build cards that are incompatible with Revit, and more expensive. Don’t buy an expensive
card just because you can. Some are designed for gaming and they may not work at all for Revit
applications.

Graphics Driver

Unless you install the graphics card and a driver that was used during testing, Revit will return
an error in the options dialog box. The best advice is to install the latest graphics driver for your
card and, if you experience problems, turn off hardware acceleration.

Graphics Driver Settings

Be extremely careful of changing settings and make a note of all defaults. If you are experiencing
really slow graphic performance, take a look at your graphic driver settings, especially if you have
a nice shiny new laptop. Many corporate environments have one, maybe two, images for deploy-
ing their standard environment. The majority of the time this cannot cater to every graphics card,
even if they regularly keep the same setup. It is common for laptops to have a built-in graphics
card, so if the settings point to the default card, take a look and make sure you are using the right
card and driver combination for the job.


http://www.autodesk.com
http://knowledge.autodesk.com/support/revit-products/troubleshooting
http://www.autodesk.com/certified-hardware

INTRODUCTION | XXVII

Computer Performance

There is a performance setting in Windows: Control Panel > System and Security > System >
Advanced System Settings. Click the Advanced tab (if necessary) and then click the Settings
button under Performance. You will notice there are four settings; the default is Let Windows
Choose What'’s Best For My Computer. At the risk of sounding like a control freak, I either opt
for Adjust For Best Performance or a custom version of the best performance option. Windows
is not an expert in BIM. There are instances where some Autodesk software actually requires
an Aero-based theme, so it is a good idea to have one or two saved, customized desktop themes
that incorporate these visual settings.

Additional Settings

Here are a few more settings you should check before you install Revit and get to work on your
MEP project.

VIRTUAL MEMORY

With the Performance Options dialog box open, select the Advanced tab and click Change For
Virtual Memory. If you are having performance issues, this is almost the last stop before you
buy or upgrade your machine. Managing the paging file can give you good returns—but test it.
If you have two physical hard drives (not a single hard drive partitioned into two), then consider
having two managed pagefiles also. Set the initial size to the same as your RAM and the maxi-
mum to double that size.

DEFRAG

If you have a traditional hard disk drive, then do this regularly (weekly). If however, you have a
solid-state drive (SSD), then don'’t defrag at all. In fact, defragging an SSD can harm performance
and reduce its life!

TEMPORARY FILES

Type %temp% in your Windows Explorer address bar. This takes you to your temporary files
folder. Select all files in this folder and delete them—any files in use will prompt you to skip that
action.

RECYCLE BIN

Once again, in the Windows Explorer address bar, type Recycle Bin and hit Enter. Delete every-
thing in here too.

REVIT BACKUP FILES AND FOLDERS

Here, I am making the assumption that you are using worksharing and you know the path to
your local project files (refer to Chapter 3, “Worksets and Worksharing,” for more details). There
is nothing wrong, when using worksharing, in appending a date and time stamp automatically
to your local file when creating a new local file. Make a regular practice of deleting anything
you don’t need—Ilike last month’s files, which will also include the associated backup folders.

In addition to this, if you are working on library content locally before integrating it with a
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centralized one, perform a search in your local directories for *.0??2.r?? This will find any Revit-
related backup file—it’s okay to delete historical versions of these too.

What’s New in Revit 2016

You've asked for it, and I'm very pleased to be able to provide a relevant list of new features with
this version of the book. As with the rest of this book, there may be some omissions because
I'have selected those new tools that have an impact on the MEP disciplines. You will see some
architectural updates, but no structural. That’s because some architectural or platform enhance-
ments also affect the MEP fields. Also with this release, there are some updates that you may or
may not have already seen in 2015. Confused? If you are a subscription customer, then you will
have probably had some of these updates as Revit 2015 Release 2, which was the midyear sub-
scription update. In order to make this clearer, for each update that was included in that release,
I've appended 2015 R2.

MEP Enhancements

Here are the MEP enhancements that have been included in this version of Revit MEP.

Circuit Sequencing In the Electrical Settings dialog box, you can now specify the sequence
in which power circuits are created. 2015 R2

Most Recently Used Panel Circuiting When creating a circuit, Revit automatically
connects to the most recently used panel in the current session. You can also search the Panel
drop-down list. 2015 R2

Move Circuits You can now move a circuit directly to a target destination without
disrupting other circuits by using the Move To tool. 2015 R2

ASHRAE Tables The ASHRAE Table Settings dialog box displays the graphical representa-
tions that are associated with duct fitting tables. 2015 R2

Piping Flow Units When you define project units for piping, you can now specify values for
flow in liters per minute (L/min).

Performance and Volume Only Settings for Calculations For most duct and piping
systems, Performance has been added to the Calculations drop-down. With this set, no
system-level calculations are processed. It is a complete “off switch” for calculations.

Volume Only has been added to the Calculations drop-down while you're working with
Fire Protection, Vent, and Other classification system types. Upgraded projects will have the
Calculations parameter set to Volume Only for systems in which the Calculations parameter
was set to None.

Improved Snapping While working with large models, you should observe an improvement
in snapping. Snap filters are now based on the zoom level, and when Snap to Remote Objects is
disabled, snapping to connectors in linked files is excluded.

MEP Fabrication Detailing You can now place fabrication parts, available through Fabrica-
tion Part configurations (Imperial and Metric), which are based on the LOD 400 content that is
part of the Autodesk® Fabrication products CADmep™, ESTmep™, and CAMduct™.

Revit Extension for Autodesk Fabrication You canimportand export fabrication jobs
between Revit and the Autodesk Fabrication products.
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Platform and Architectural Enhancements
Here are the platform enhancements that apply to all the Revit 2016 family.

Allow Navigation During Redraw Enabled by default, this option allows you to pan and
zoom while the view is redrawing.

Dynamo A visual scripting tool that leverages the Revit API to enhance and extend model
behavior. 2015 R2

Edit/Load aFamily When editing a family, you now have the option Load Into Project And
Close. 2015 R2

Energy Analysis for Autodesk Revit (for Subscription Customers) Use Conceptual Mass
Mode and Use Building Element Mode have been integrated within the Energy Settings
dialog box.

New Analysis Mode Use Conceptual Masses and Building Elements allow you to perform
energy analysis on a model that includes both types of design.

File Upgrades This is a new dialog box that shows the release of the file when opening,
loading, or importing. In most cases, you can cancel before completion of the upgrade. 2015 R2

IFC You can use geometry in a linked IFC model as references for dimensions, alignment,
and snapping. Some face-based families can be hosted in the Revit model. Linked IFC elements
are assigned to a default phase. 2015 R2

IFC Links and Rooms When creating rooms in the host model, you can use many IFC-based
elements to define room boundaries.

Import/Link Position Default positioning option is now Auto - Origin to Origin. If you
change the default, the option you select for Positioning becomes the default for the current
session. There is one default for Revit models and another for CAD files. 2015 R2

Open Sheet View Right-click a view in the Project Browser and click Open Sheet. This
option is disabled when the view is not placed on a sheet, or if the view is a schedule or a
legend.

Perspective Views You can now perform the following commands in a perspective view:
Move, Align, Pin, and Unpin. 2015 R2

Reset Target Tool Restores the camera target position to the center of the field of view. You
can toggle between perspective and parallel representations of the view. 2015 R2

Pin/UnpinIcons These icons have been changed subtly to indicate whether an element has a
relationship with a host system such as a curtain wall panel. 2015 R2

Properties Palette When comparing properties of different family instances, you can scroll
in the Properties palette, click outside the palette, and retain the context you were looking at.
2015 R2

Rendering When rendering a static 3D view, you can now choose between two rendering
engines: NVIDIA mental ray® and Autodesk Raytracer. This is part of a multiyear project to
replace mental ray with Autodesk’s own rendering engine.

Reveal Constraints Use the toggle on the View Control Bar to see all dimensional and
alignment constraints in a view. 2015 R2
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Revisions Select multiple rows in the Revision dialog box to delete multiple revisions at
once. The starting number for a numeric sequence can be 0 or any positive number. The
alphabetic sequence type is now called alphanumeric, and it will accept any sequence of
characters. Each value in the sequence can consist of more than one character. You can add a
prefix and/or a suffix to display with values in a sequence.

Revit Link in a Closed Workset If a Revit link is not visible in a model view, you can check
its status in the Manage Links dialog box. 2015 R2

Rotate Project North Improvements have been made to the reliability of this existing
feature, with view-specific annotation elements that should be rotated along with the model
when it is used.

Schedules You can use the Insert Data Row tool, available directly on the Rows panel, to add
a data row to a schedule. 2015 R2

Search Thereis a new search feature in the Type Selector and in drop-down lists. You can
enter keywords to search for. 2015 R2

Selection Boxes You can select Elements from the Modify tab, and then select View >
Selection Box to isolate the elements in a 3D view.

Solon Integration Originally available through Autodesk Labs, Solon has been incorporated
into the Autodesk® Green Building Studio® application so you can personalize the building
performance analysis in Revit. 2015 R2

Thin Lines If you like working in Thin Line mode, the Thin Lines state is remembered
between sessions, based on its setting when you close Revit. 2015 R2

View State When you save and exit Revit, the zoom and pan states for each view are remem-
bered for the next time the model is opened. The views have to remain open when you close
the project, however.

Who Should Buy This Book

This book is intended for readers who are at least somewhat familiar with Revit MEP. It is not
intended to be a “how-to” book by simply explaining picks and clicks; it is for readers who are
looking to find ideas on how to make the software work for them. Engineers, designers, modelers,
and CAD technicians will all find useful information related to their workflows. If you are
hoping to move further with your Revit MEP implementation, you should find this book to be a
useful resource. Even if you are familiar with the topics discussed in this book, we hope you will
be inspired to think of new ways to improve your Revit MEP experience.

FREE AUTODESK SOFTWARE FOR STUDENTS AND EDUCATORS

The Autodesk Education Community is an online resource with more than five million members
that enables educators and students to download—for free (see website for terms and conditions)—
the same software used by professionals worldwide. You can also access additional tools and
materials to help you design, visualize, and simulate ideas. Connect with other learners to stay
current with the latest industry trends and get the most out of your designs. Get started today at
www . autodesk.com/joinedu.
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What’s Inside

Here is a glance at what’s in each chapter:
Part 1: General Project Setup

Chapter 1: Exploring the User Interface The ribbon interface is designed for optimal
workflow. In this chapter, you will discover the features of the user interface that allow
you to work efficiently. Some new features in Revit MEP 2016 improve the user interface
dramatically.

Chapter 2: View Filters and View Templates This chapter takes you through the major
areas for creating and applying view filters and view templates that help you deliver
consistent-looking documentation for all your projects.

Chapter 3: Worksets and Worksharing This chapter guides you through the process
of setting up a project file in a multiuser environment. The features of a worksharing-
enabled file are explained in a manner that promotes ideas for project workflow
efficiency.

Chapter 4: Project Collaboration Revit has many features that make project collabora-
tion easy to manage. In this chapter, you will learn about ways to use the power of Revit
MEP to coordinate your design and documents with other members of the project team.

Chapter 5: Multiplatform Interoperability: Working with 2D and 3D Data This
chapter provides best-use techniques for importing non-Revit data into your projects. You
will learn about the data types available and how to use them effectively in your Revit
project files.

Chapter 6: Parameters Parameters are the intelligence within a BIM project. This
chapter explores how parameters can be used in both projects and families for applying
computable data to your Revit models. The creation of shared parameters and their use is
also covered.

Chapter 7: Schedules The best way to extract the data contained in your Revit project
model is to use the power of schedules. In this chapter, you will learn about the tools
available for scheduling model components and how to use schedules to manage data
within your projects. The panel schedule template feature is also covered in this chapter.

Part2: Mechanical Design

Chapter 8: HVAC Cooling and Heating Load Analysis Mechanical design must start
with understanding how your building will perform in different weather conditions and
climates. In Chapter 8, you will learn that properly produced building loads can ensure
that the mechanical design has been sized for maximum efficiency, saving energy and
money while reducing the impact on the environment.

Chapter 9: Creating Logical Systems In this chapter, you will learn how to set up
logical systems and how each system is affected by the type you assign it. From mechani-
cal systems to fire-protection systems, all have a certain role to play in BIM.

Chapter 10: Mechanical Systems and Ductwork Understanding how to route
ductwork successfully can lead to error reduction and better coordination. In Chapter 10,
you will learn how to locate mechanical equipment and how to use the proper routing
methods for ductwork.
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Chapter 11: Mechanical Piping Routing mechanical piping can be a daunting task. In
this chapter, you will learn how to route and coordinate your piping and how, through
these techniques, you can speed up production and take full advantage of what Revit
MEP 2016 has to offer.

Part 3: Electrical Design

Chapter 12: Lighting  In this chapter, you will learn how to place lighting fixtures,
including site lighting, into your projects. The use of lighting switches is also discussed,
along with the relationship between lighting fixtures and the spaces they occupy. This
chapter also covers the basics for using Revit MEP for lighting analysis.

Chapter 13: Power and Communications In this chapter, the basics for placing power
and communication devices into a model are covered. You will also learn how to place
electrical equipment and connections for use in distribution systems. Conduit and cable
tray modeling tools are also explored in this chapter.

Chapter 14: Circuiting and Panels Creating systems for your electrical components is
just as important as it is for mechanical components. In this chapter, you will learn how
to set up your projects to your standards for wiring, create circuits within your model,
and create panel schedules to report the loads. The tools for load classification and
demand factors are also covered in this chapter.

Part4: Plumbing

Chapter 15: Plumbing (Domestic, Sanitary, and Other) In this chapter, you will

learn how to modify plumbing fixture families and create custom systems to speed up
plumbing design. You will also learn how to use the Copy/Monitor feature in ways never
discussed before.

Chapter 16: Fire Protection Fire-protection systems protect buildings and lives. You
will learn how to lay out a fire pump system and assemble components to help in your
design process. You will learn how to coordinate with other disciplines and how to enter
into the BIM arena effectively through the use of Revit MEP.

Part 5: Managing Content

Chapter 17: Solid Modeling The foundation for custom content creation is having the
ability to create the forms required to build component families. In this chapter, you will
learn how to use the tools available in Revit MEP to create model geometry. You will also
learn how to make geometry parametric, increasing its usability.

Chapter 18: Creating Symbols and Annotations Because so much of MEP design
information is conveyed with schematic symbols, it is important to have the symbols and
annotative objects commonly used for projects. Revit MEP has the tools needed to create
schematic symbols for use in component families or directly in projects. In this chapter,
you will learn how to use these tools and how to create constraints within families for
display of the symbols in your projects.

Chapter 19: Creating Equipment Equipment families are an important component of a
Revit model because of the space they occupy within a building. In this chapter, you will
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learn how to use solid modeling tools to create equipment. You will also learn how to add
connectors for systems and how to create clearance spaces for coordination with other
model elements.

Chapter 20: Creating Light Fixtures Lighting fixture families are special because they
can hold photometric data that allows for lighting analysis directly in your Revit model.
This chapter covers how to create lighting fixture families and add the data needed for
analysis. You will also learn how lighting fixture families can be represented in project
model views using detail components, linework, and annotation within the family file.

Chapter 21: Creating Devices This chapter examines the process for creating MEP
system devices and how to use annotations to represent them on construction docu-
ments. In this chapter, you will also learn how parameters can be used to control and
manage symbol visibility.

Chapter 22: Details Although creating a model with computable data is the primary
reason for using Revit MEP, you do not want to model every minute detail of the design.
The tools for creating detail drawings of your design are examined in this chapter. You
will also learn how to use existing CAD details along with strategies for creating a library
of Revit details.

Chapter 23: Sheets When it comes time to submit a project, you need to have a set of
coordinated construction documents. In this chapter, you will learn the ways you can
create and manage your project sheets. You will also learn how you can print and export
your project sheets for submittal or coordination with clients.

Chapter 24: Fabrication This is a totally new workflow for Revit MEP 2016. Fabrication
tools are a step in the direction of a fully life-cycle building project, from conceptual
design to construction.

Chapter 25: Creating a Project Template The key to success with Revit projects is to
have a good template file. Chapter 25 takes you through the major areas of a template
file, offering ideas for settings that will make starting a project as simple and efficient as
possible.

The Mastering Series

The Mastering series from Sybex provides outstanding instruction for readers with intermediate
and advanced skills in the form of top-notch training and development for those already working
in their field and clear, serious education for those aspiring to become pros. Every Mastering book
includes the following:

¢ Real-World Scenarios, ranging from case studies to interviews, that show how the tool,
technique, or knowledge presented is applied in actual practice

¢ Skill-based instruction with chapters organized around real tasks rather than abstract
concepts or subjects

¢ Self-review test questions so you can be certain you're equipped to do the job right
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How to Contact the Author

I welcome feedback from you about this book or about books you'd like to see from me in the
future. You can write to me at the following email address: simon.whitbread@outlook.com.

For more information about my work, please visit https://uk.linkedin.com/1in
/simonwhitbread.

For More Information

Sybex strives to keep you supplied with the latest tools and information you need for your work.
Please check the website at www. sybex.com/go/masteringrevitmep2016, where we'll post
additional content and updates that supplement this book if the need arises.


mailto:simon.whitbread@outlook.com
https://uk.linkedin.com/in
http://www.sybex.com/go/masteringrevitmep20
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Chapter 1

Exploring the User Interface

The Autodesk® Revit® MEP 2016 software is similar to the majority of the software produced

by Autodesk in that it uses a ribbon interface. This allows for not just ease of access to the tools
needed for mechanical, electrical, and plumbing (MEP) design and modeling but also a familiarity
between those different software packages, making the transition between them easier.

Although this book is titled Mastering Autodesk Revit MEP 2016, having a good knowledge of
where tools are located and how to access the commands easily is the best way to efficiently use
the software, so I included this chapter on the user interface. Improvements and changes have
been made to the user interface for this version through the addition of tools in contextual tabs
and improved functionality.

The ribbon-style interface works well in Revit because it allows many of the tools to be
organized in one area of the interface, which gives you more screen real estate for viewing the
model. Although the user interface is customizable, you are limited in the amount of customiza-
tion and number of features that you can change. At first this may seem a bit restrictive, but as
with any software, with familiarity comes an increased proficiency.

Some features have been added to improve workflow and efficiency, and typical workflow
features that were previously accessed through buttons in the interface are now available as part
of the interface itself.

In 2012, Autodesk introduced the Autodesk® Revit® program, which combined all the fea-
tures of the Autodesk® Revit® Architecture, Autodesk® Revit® Structure, and Autodesk® Revit®
MEP platforms. This version is available to those who purchase either Building Design Suites
Premium or Ultimate packages released by Autodesk and gives users the option to deploy/
install either each separate version of Revit or the all-inclusive one, giving them all the available
Revit tools in one box. Knowing your way around the Revit MEP 2016 user interface is the first
step to reaping the benefits of using a building information modeling (BIM) solution for your
building projects.

In this chapter, you will learn to do the following:

¢ Navigate the ribbon interface
& Utilize user interface features

¢ Usesettings and menus

The Ribbon

If you are familiar with the Revit MEP user interface prior to the 2010 version, transitioning to
the ribbon-style interface may indeed take some getting used to. Once you understand the way
that the ribbon is set up and how you can customize it to better suit your workflow, you will see
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FIGURE 1.1
The Systems tab

FIGURE 1.2
Architecture and
Structure tabs

CHAPTER 1 EXPLORING THE USER INTERFACE

that it is an optimal interface for a BIM and design application. If you are transitioning from an
earlier ribbon interface, you will inevitably notice some changes to the location and order of the
tabs and the introduction of additional tabs/commands.

Using Tabs

The ribbon portion of the user interface consists of several tabs, each organized by panels that
relate to the topic of the tab. Each panel contains one or more buttons for the relevant features
available in Revit MEP 2016. You can access a tab by simply clicking the name at the top of the
ribbon. Although each tab is designed to provide a unique set of tools, some of the features of
Revit are repeated on different tabs. Depending on your screen resolution, some of the buttons
on the panels may become compressed to fit on your screen. In addition to this, there may be
subtle differences in these images and those you see in your Revit interface. This is because the
software used for the images in this book come from Revit, rather than Revit MEP. The panels
and tools for each tab are described here (not all panels are shown for each tab):

Systems The Systems tab, shown in Figure 1.1, is the main tab for MEP modeling tools. Once
known as the Home tab, this tab has been renamed to allow for continuity between Autodesk
Revit MEP and Autodesk Revit. The tab is divided into panels that are specific to each of the
main disciplines. Each of the discipline panels has a small arrow in the lower-right corner that
provides quick access to the discipline-specific settings dialog box (1) or, new to Revit MEP
2016, the Fabrication settings dialog box (2).

Architecture and Structure There will always be a need for creating architectural elements in
a Revit MEP model, whether this is purely during a Copy/Monitor operation or if you are
building an as-built model and have no architect to work with. This tab features most of the
architectural tools required for this. From the Build panel with the basic architect’s tools to
openings, grids, and rooms, these are all available on the Architecture tab. Note that access to
Color Schemes and Area And Volume Computations is available by clicking the small diagonal
arrow on the Room & Area panel, as shown in Figure 1.2.

The Structure tab contains tools for modeling structural elements as well as some common
tools for grids and reference planes. Both of these tabs are available in their entirety if you
install Revit as part of a Building Design Suite (Premium or Ultimate) package.
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Insert Whether you want to link another Revit project file, overlay Design Web Format
(DWF) markup, or insert 2D elements from another file, the Insert tab contains all these tools
and more for bringing other files or objects into your Revit projects, as shown in Figure 1.3.
The tab is organized by panels for linking and importing files, and it also contains tools for
loading Revit families. The small diagonal arrow at the lower right of the Import panel is for
accessing the Import Line Weights dialog box, where you can associate imported computer-
aided design (CAD) color numbers to a Revit line weight, as indicated in Figure 1.4. The Insert
tab also contains the Autodesk Seek panel, which provides a search window for content
available on the Autodesk® Seek website.

FIGURE 1.3 Systems  Architectwe  Stuctre  Insert  Annotte  Analyze  Massnofite  Colsborate  View  Manage  Addns  Modfy (-
The Insert tab VR OB @ 2157 E% s &
Vodfy| Lnk Unk Lk DWE  Dersl  Point Manage Import Inport  nssit Vanage  Load L0805 Find and dennload bulding product models, drawings, and spees
Revt IFC CAD Makup 7 oud Links | CAD abL  from Fie Inages | Faniy Graup
Select ~ Lk Tport | Load from Library Autardzsk Seek
FIGURE 1.4 Import Line Weights: C:\Program Files Autodesk’Revit Copernicus’Data\importlineweights-dwg-default.txt [ %]
Import Line —
. . DWGE/DRF Colar Mumber Line Weight :I |L°a—d"‘|
Weights dialog
: 1
box > i
3 1
<+ 1
5 1
13 1
T 1
L] 1
9 1
10 1
11 1
12 1
13 1
14 1
15 1 ;I
MNOTE: These values only apply to lines and layers set bo DEFALILT lineweight in source DWEDRF File,
Lines and layers with set lineweight value are automatically imparted at that width.
0Ok I Cancel | Help |

Annotate On the Annotate tab, you can find the tools needed to add annotations to your model
views along with drafting tools for creating details. The Dimension and Tag panels can be
extended by clicking the arrow next to the panel name, which reveals the tools for establishing
dimension settings and determining the default tags to be used upon initial placement, as shown
in Figure 1.5. The Symbol button is used for placing annotation families onto views or sheets.
The small diagonal arrow at the lower-right corner of the Text panel provides access to the Type
Properties dialog box for creating or modifying text styles, as shown in Figure 1.6.

FIGURE 1.5
The Annotate tab

& = i @ B Sa It
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FIGURE 1.6
Text Type Properties
dialog box Family: em Family: Text Load. .. |

Tyvpe:

i arial

j Duplicate. .. |
Rename. .. |

Type Parameters

Parameter | Value |
ap
Calar LTy
Line Weight 1
Background Opaque
Show Border
Leader/Border Offset 5/64"
Leader Arrowhead Arrow 30 Deqgree
Text 2
Text Font Arial
Texk Size 114"
Tab Size 152"
Baold [
Ttalic [
Underline
‘Wwidth Factor 1.000000

== Preyview | o4 I Cancel | fpply |

4

Analyze Tools for model analysis and systems checking are located on the Analyze tab.

Other tools on this tab allow you to add color to your ductwork and piping based on defined

criteria. The Spaces & Zones panel contains the tools for placing Space objects and space

separator lines. The Check Systems panel contains tools for checking MEP systems to ensure

proper connectivity and valid system assignments of components. Note that access to the
Color Schemes and Area And Volume Computations options is available by clicking the
down arrow on the Spaces & Zones panel, as shown in Figure 1.7, whereas building and

space properties, as shown in
Schedules panel.

FIGURE 1.7

Figure 1.8, can be accessed from the arrow on the Reports &

- Systems  Architsct
The Analyze tab

Modify|  Space  Space

Separator

Select »

| [ (& [ [

Space Zone

Spaces & Zones =,

ure  Structurs  Insert  Annotate  Anslyze  Massng&Ske  Colsborate  View  Manage  Add-ns  Madify

HE & & & SB &

Heatingand  Panel  Schedule/ Duct Pressure Pipe Pressure  Check Duct Check Pipe Check
Cooling Loads Scheddles Quartities Loss Report  Loss Report | Systems

Show
Tag Systems  Circuits Disconnecks

Reports & Schedules M

N

Check Systems

[E'g Color Schemes

[ frea and Yolume Computations

Spaces & Zones




FIGURE 1.8
Building/Space Type
Settings dialog box

Building/Space Type Settings

Filter: IEnter Search Words

&+ Building Type

Courthouse

Dining Bar Launge ot Leisure
Dining Cafeteria Fast Food
Dining Farnily

Darmitory
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Post Office
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I Parameter

Walug
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Latent Heat Gain per person
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Lighting Load Density
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Retail Lighting - 7 AM to & PM

Opening Time

0g:00
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18:00
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Tools on the Energy Analysis panel allow for choosing a mass model or the building compo-
nents to use as the basis for generating an energy analysis report:

Massing & Site The Massing & Site tab combines the conceptual tools used for creating
masses and the Modeling By Face objects. It provides MEP users with access to site tools,
including topography, site and parking components, and building pads or foundations,

as shown in Figure 1.9. The Site Settings dialog box, shown in Figure 1.10, for adjusting
contour separation and site cut material, can be accessed by clicking the arrow on the Model

Site panel.
FIGURE 1.9 Systerns  Archibecture  Struckure  Insert  Annotate  Anabyze  Massing &Sike Collaborate  Wiew  Man.
g Vassing & 5 U 0008 4 [
Site tab ol

Modify show Mass  In-Place Flace | Curtain Roof Wl Floor | Toposurface Sike Parking
by Wiew Settings Mass  Mass | Syskem Cormponent Cormponent
Select + Conceptual Mass Model by Face Model Site 3

y
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FIGURE 1.10

Site Settings

FIGURE 1.11 -
The Collaborate tab L Qﬁ?ﬁ e = DQ Fﬂ‘a Eﬁ Eﬁz
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—Contour Line Display
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o4 I Cancel | Apply | Help |

Collaborate You need tools that allow you to keep your model coordinated with other
disciplines and work within a multiuser environment. These tools can be found on the
Collaborate tab. The Manage Collaboration panel has a drop-down list for setting the active
workset, and the Coordinate panel contains tools for copying and monitoring objects from
linked files. The Coordinate panel also has a tool for locating face-hosted elements that have
lost their association to their host. You can check for clashes between model objects by using
the Interference Check tool on the Coordinate tab. The Editing Requests button on the Syn-
chronize panel allows you to see any requests that have been made to modify elements you are
borrowing or own. You also have the option to connect to a Revit Server Accelerator by clicking
the arrow, as shown in Figure 1.11.

Systems  Architecture  Struckurs  Insert  Annotate  Analze  MassingRoSite  Colaborste  View  Manage  Adddns  Madfy =

Show  Restore Copyi . Coordnation _ Coordination Reconcie

Modfy| | workssts
History Backup Maritor Review Settings  Hosting

Select v Manage Collaboration Synchronize Coordinate

[ Manage Connection o a Revit Server Accelerator

Synchranize

View Figure 1.12 shows the View tab; here you can use the tools to create different types of
views. This tab also has tools for managing the views you have open in the drawing area. On
the Graphics panel, there are tools for creating view templates and filters. The arrow on the
base of this panel accesses the Graphic Display Options dialog box, shown in Figure 1.13.
The Sheet Composition panel has tools for creating sheets as well as adding match lines or
revisions. The User Interface button allows you to toggle the visibility of key user-interface
features including the Properties palette, System Browser, and Project Browser.
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FIGURE 1.12
. =) ) R
The View tab < = = ogonds Scocs S
FIGURE 1.13
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G aP ¢ splay | Model Display
Options

Style: IHidden Line j
¥ Show Edges

I Smooth lines with anti-aliasing

Transparency: | I 1}
[

Silhouettes: I <nong

1ﬂ Shadows |

m Skekchy Lines |

1ﬂ Lighting |

1ﬂ Photographic Exposure |

Save as View Template. .. |

How do these settings affect views qraphics?

OF | Cancel | Apply |

Manage On the Manage tab, you can find the tools needed to establish project settings. The
Inquiry panel has tools that can be used to locate specific objects in your project model, and to
display any warnings associated with your project. Along with the settings that can be
accessed from the tools on the Settings panel, clicking the Additional Settings button opens a
drop-down list of even more options. The MEP Settings button is located on the Settings
panel. This is where you can establish settings related to MEP components and system
behavior. The Selection panel, as indicated in Figure 1.14, has tools that allow the user to save,
load, and edit a selection set of objects for use in a filter list.

FIGURE 1.14
The Manage tab

Modify The Modify tab, as shown in Figure 1.15, is located at the end of the tabs by default so
that it is closer to the center of the user interface, for easy access. The Modify tab has the tools
needed to make changes to components or linework in your project views. The tools on the
Modify panel have been arranged with the more commonly used tools that have larger
buttons. Some of the tools that have multiple-use options have a separate button for each use,
such as the Mirror, Split, and Trim/Extend tools. The tools for creating groups, assemblies, or
parts are located on the Create panel.

9
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FIGURE 1.15 Moy
The Modify tab Koo 9 &M e=? .0 = B
il C oy kA PRBOTHax 7SS

Select + Froperties | Clipboard Geometry Modify View | Measurs | Creats

The Modify button appears in the Select panel on every tab. This button allows you to exit
from any active command, giving you an alternative to using the Esc key multiple times or
selecting another tool. Another feature of this panel is the drop-down that contains options for
selection in the drawing area. These options also appear as icons on the status bar. Figure 1.16
shows the various selection options available. Notice that you can select elements by clicking
anywhere on the element by using the Select Elements By Face option. However, this option
does not work when a view is set to Wireframe.

Ficure 1.16 5 g

Select - | Properties | Clipbol
| Select links
Select underlay elements
+*| Select pinned elements
Select elements by face

+| Drag elements on selection

o] Select

You may need to experiment with combinations of these settings to achieve the results that
suit your workflow. Note that if you deselect the Select Underlay Elements check box, you cannot
select non-MEP components such as doors, walls, or windows that may exist in your model.

Add-Ins The Add-Ins tab appears on your ribbon as the next-to-last tab by default. This tab
contains a BIM 360 panel with tools for use in the Autodesk® 360 environment and requires
you to sign into an Autodesk account. If you have installed any external applications, the
buttons or other features provided appear on the tab as configured. Some third-party applica-
tions create an additional tab on the ribbon.

Using Contextual Tabs

In addition to the tabs provided by default on the ribbon, other tabs appear when you select
objects in your project. These are known as contextual tabs, which contain tools specific to
modifying the selected object. Contextual tabs appear in the location of the Modify tab and are
identified by their green color and a name that applies to the selected object. A contextual tab
for a selected object is an extension of the Modify tab, which is why the base Modify tab is so
compact compared to the other tabs. This allows for the selection-specific tools to appear on the
right side of the Modify tab. Figure 1.17 shows the contextual tab (labeled Modify | Electrical
Equipment) for an electrical distribution board selected in the model of a project. The rest of the
Modify tab is still available to the left but is not shown in this figure for clarity.
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FIGURE 1.17 ModiFy | Electrical Equipment | Electrical Circuits |

-3
Contextual t.ab [Eb] [C‘D ] 0, E @ ii,g
for an electrical 070 | e Create Edit Pick
. p s Family | panel Schedules Wiork Plane | Mew
distribution board =@
Create Made Electrical ttark Flane Flacement

In addition to this, if any object is also part of a system another contextual tab appears with
tools for editing the system. These tabs are completely separate from the standard Modify tab
and contain only tools for system editing. If you select an object on a system, the system tab
appears along with the contextual Modify tab, as shown in Figure 1.18. However, if you select an
entire system, only the system tab appears. The panels and buttons on contextual tabs cannot be
removed or rearranged on the ribbon. The buttons cannot be added to the Quick Access toolbar.

FIGURE 1.18 w
Contextual tab for [ @ ﬁ_ ﬁ

System Selector: = Panel:
Electrical Circuits Modify | |Properties| @ LP1-26 ~|  Edit Select Disconnect LPL -

Circuit - Panel Panel

Select | Properties
Modify | Lighting Fitures | Light Group:  <Nene> & [eer- ]

—
‘ - —

System Tools

The tabs in the Family Editor environment differ from those in the project file environment.
When you open a family file, the tabs on the ribbon contain some familiar tools, but the majority
of them are specific to the creation and modification of family components. The tabs available in
the Family Editor environment are as follows:

Create The Create tab in the Family Editor environment, shown in Figure 1.19, contains tools
for creating solid geometry and lines, adding system connectors, and creating and managing
references.
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FIGURE 1.19
The Family Editor—
Create tab

Insert Figure 1.20 shows the Insert tab in the Family Editor; it contains tools for importing
other files into your family file. The tools for linking are visible but disabled because importing
is the only available method for bringing external geometry into a Revit family file. The arrow
on the Import panel accesses the same dialog box as in the project environment and can be
seen earlier in Figure 1.4.

FIGURE 1.20 Tnsert
The Family Editor— o | % m [(\'j
by m cap O
Insert ta Modify Impork Manage  Import Load Load as
CAD T Images Family Types | Family Group
Select | Link. ‘ Impart N | Load from Library

Annotate On the Annotate tab, seen here in Figure 1.21 within the Family Editor environ-
ment, you will find the types of annotation tools that can be used in a family file. Text and
Dimension styles, as indicated previously in Figure 1.6, can be accessed from the appropriate
access points shown.

FIGURE 1.21 Annatats
. . 9 ABC :—E'AI:
The Family Editor— A A S 7 Al Ay B
Annotate tab Modify| | Aligned Angular Radial Diameter  Arc Detail Text Check Find/ | Loadinto  Loadints
Lenath Group Speling Replace | Frajsct  Projsck and Close
Select - ‘ Dimension - | Detail ‘ Text § | Fanmily Editor
\ Dimension Styles Text Styles /

View The View tab in the Family Editor environment, as shown in Figure 1.22, is limited to
tools for managing the family views. Section views can be created and camera positions can
also be established for 3D views.

FIGURE 1.22
: : r—1 == I+ E=n
— - Replicat
Tl'}e Family Editor | :/: @ (? & ﬁ T repicate ] @Q
View tab Modify| | Visiilty, Thin | Default Camera Section Switch _ Close B cascade Lssr | Loadints  Loadinto
Graphics Lines | 3D - Windows ™ Hidden 3 7 Interface ™| Project  Project and Close
Soect + Graphis | Create | Windows | Family Edftor

Manage Inthe Family Editor environment, the Manage tab, shown in Figure 1.23, is popu-
lated with tools for establishing settings within the family file. The MEP Settings button allows
you to establish load classifications and demand factors, whereas the Additional Settings
button drops down for access to general settings.

FIGURE 1.23
The Family Editor—
Manage tab
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Modify TheModify tab in the Family Editor environment, as shown in Figure 1.24, is nearly
the same as the one found in the project file environment. The main difference is that there is
no View panel and the Geometry and Create panels have fewer tools. This tab is also compact,
allowing for a contextual tab when objects within the family are selected.

FIGURE 1.24

e FamiyBator— ([ B EL ) g o Bl DGz 3= (6 B ER
Modify tab it WL g OB B ) T | T ot

Clipboard

Select ~ | Properties Geometry Modify | Measure | create | Family Editor

Add-Ins The Add-Ins tab also appears in the Family Editor environment, with the same BIM
360 panel as in the project file environment.

Finally, the Load Into Project buttons are available on each tab in the Family Editor environ-
ment. These allow you to either load and leave the family open, or save and load the family
into other open files at any time.

Customizing the Ribbon
You can customize the ribbon interface to better suit your workflow. For example, you can
rearrange the order of the tabs by holding down the Ctrl key and clicking a tab name to drag
it to a new location.

You can move panels on a tab to different locations on the tab by clicking a panel name and
dragging it to a new location. Figure 1.25 shows the Mechanical panel being dragged from
its location on the Systems tab. The panels to the right slide over to fill in the space left by the
moved panel.

FIGURE 1.25 Systems

Moving a tab panel L@ _m K;J éﬁ é; [—
7 (1]
% @ L I:' =0 |Mechanical l =
Madify| | Duct Duck Duct  Duct  Comverbbo | Flex Air Fabricati{Fqupment |  pipe Fipe  FParalel
Flaceholder Fitting Accessory  Flex Duck Duct  Terminal Part Flacsholder Pipes  Fil
Mechanical «
Select « | HaC ¥ Fabrication « Fl

You cannot move a panel from one tab to another, however. If you attempt to drop a panel
onto another tab, it returns to its original location on its original tab.

You can remove panels from a tab and place them in another location on your screen. You
can dock floating panels together by dragging one panel over the other, and you can move the
docked panels as a group by clicking and dragging the gray grip that appears when you hover
your mouse pointer over a floating panel. If you use dual monitors, you can even drag a panel
to the second monitor. The panel’s new position is maintained when you restart the software,
but the panel does not appear until a file is opened. Keep in mind that moving tools to another
screen may actually hinder your workflow, your efficiency, and possibly the stability of the
program itself.
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BACK TO NORMAL

You can return a floating panel to its default location by clicking the small icon in the upper-right
corner of the panel.

. Return Panels ko Ribbon
Mechanical

Equiprment

Mechanical

If you want to return the entire ribbon interface to its default settings, you can do so by browsing
to %USERPROFILE%\AppData\Roaming\Autodesk\Revit\Autodesk Revit 2016, deleting
the UIState.dat file, and then reopening the application. Deleting this file also removes any
customization done to the Quick Access toolbar.

FIGURE 1.27 JEHG- G- =2 A OA 6-0E 5 R~
Quick Access toolbar

You can control the visibility of the ribbon tabs by clicking the small button to the right of
the tabs. This button cycles through the different display options. You can also click the small
arrow next to the button to display and select a specific option, as shown in Figure 1.26. Double-
clicking a ribbon tab will also cycle through the various ribbon configurations.

FIGURE 1.26 Modfy (=]
Ribbon visibility Minimize to Tabs
) % Minimize ko Panel Titles m
Plumbing| ~ Minimize to Panel Buttons nd
Fixture
v Cycle through Al
El

You can establish the switching behavior of the tabs on the ribbon to determine which tab is
displayed when you exit a tool or command. When you click a tool, the contextual Modify tab
for that tool appears. The interface stays on the Modify tab when you exit the tool, or you can
set it to return to the previous tab. These settings are located on the User Interface tab of the
Options dialog box, which is discussed later in this chapter.

Quick Access Toolbar

As you are working, you may find yourself taking extra steps to switch tabs in order to access
the desired tools. Figure 1.27 shows the Quick Access toolbar (QAT) as a place where you can
put frequently used tools for instant access.

Systems Architecture Skructure Inserk Annotate Analyze Massing & Site

You can add tools from any of the standard tabs to the QAT simply by right-clicking that
tool’s button or drop-down and selecting the Add To Quick Access Toolbar option. The tool will
be placed at the end of the QAT. To manage the tools available on the QAT, you can click the
small arrow button to access the customization menu, shown in Figure 1.28. Each button on the
QAT is listed, and removing the check mark next to it turns off its visibility in the QAT.
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The option at the bottom of the list allows you to set the location of the QAT either above
or below the ribbon. Setting it below the ribbon moves it closer to the drawing area for easier
access. If you add several buttons to the QAT, you may want to move it below the ribbon so that
it does not crowd out the filename on the title bar.

Clicking the Customize Quick Access Toolbar option in the drop-down menu opens the
dialog box shown in Figure 1.29. In this dialog box, you can change the order of the buttons as
they appear from left to right, create separator lines, or delete buttons.

You can also right-click a button on the QAT for quick options such as removing the button,
adding a separator line, or accessing the customization dialog box.

FIGURE 1.28 ] So——
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Additional User Interface Features

The Revit MEP 2016 user interface is full of features designed to help you design and model
efficiently. Some items are new, some have been modified, and some are the same as they have
always been. The title bar at the top of the screen informs you of what file you are in and what
view is currently active in the drawing area.

Options Bar

Complementing the ribbon and its contextual tabs is the Options Bar, shown in Figure 1.30,
which is an important part of the user interface. This should be the first place you look when

a tool or object in the project is selected. Although the number of options that appear may be
limited for each command you use, they are important to the task in which you are engaging.
When placing round duct, for example, pay close attention to the Diameter and Offset options to
ensure proper location.

FIGURE 1.30
Options Bar

Modify | Place Duct D\ameter:IS" =l ‘ Offset:[ 10" 0" =] |EF|| Apply ‘ l= Horizontal 7] | Tags.. |7 Leader |~—-1| 12 ‘

You can dock the Options Bar at the top of the screen, below the ribbon (which is the default
location), or at the bottom of the screen, just above the status bar. Right-click the Options Bar to
change its docked position.

Properties Palette

The Properties palette is a dialog box that can stay open all the time and allows you to access
the properties of items in your project. This feature reduces the number of mouse clicks
necessary to access the properties of a model object or project component. You can dock the
Properties palette to the sides of the screen or at the top of the drawing area just below the
Options Bar, or it can float. If you dock the Properties palette to the same side of the screen

as the Project Browser, there are two options for how they can be displayed. You can either
show both, split in the docked space as seen in Figure 1.31, or have them both occupy the same
docked space, depending on how you drag them to the docked space. A gray box appears to
indicate whether they will split or share the space.

When the Properties palette and Project Browser are sharing the same docked space, you can
access either one by the tabs that appear at the bottom. To remove either one from the shared
docked space, click and drag its tab away from the dock.

If you do not have the Properties palette turned on, you can access it by clicking the
Properties button located on the Modify tab or the contextual Modify tab of a selected object,
or you can right-click anywhere in the drawing area. The Properties palette remains on until
you close it.

When no object is selected in the model or in a drafting view, the Properties palette displays
the properties of the current view in the drawing area. You can select a view in the Project
Browser to view its properties in the Properties palette.

The top section of the Properties palette contains the Type Selector when an object is selected
or a tool is chosen for placing an object. When an object is selected, you can switch to the prop-
erties of the current view by using the drop-down list located just below the Type Selector, as
shown in Figure 1.32.



FIGURE 1.31
Project Browser
and Properties
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FIGURE 1.32

Properties palette

The properties shown in the Properties palette are instance properties. You can click the
Edit Type button to display the Type Properties dialog box for a selected item or view. When
you're viewing the instance properties of an object or view, the scroll bar on the right side of the
palette holds its position when you move your mouse pointer away from the palette. The scroll
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bar remains in position even when other items are selected in the model.

When you make a change to a parameter in the Properties palette, you can click the Apply
button at the bottom-right corner of the palette to set the change. Alternatively, you can simply

move your mouse pointer away from the palette and the change will be applied.
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View Control Bar

The View Control Bar is often overlooked, but it contains tools that are important to the display
of the contents in the drawing area.

The Visual Styles button provides access to the Graphic Display Options dialog box, shown
in Figure 1.33. This dialog box has settings that control the visual display of the view. These
include Model Display, Shadows, Sketchy Lines, Lighting, Photographic Exposure, and the
ability to save these settings as a view template. If you are working in a 3D view, the dialog box
also has a Background setting.

FIGURE 1.33
GraPhlc DlSplaY Model Display
Options dialog box
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The View Control Bar, shown in Figure 1.34, has options for scale, level of detail, visual style,
sun path, shadows, rendering, view crop, and crop region visible. You have the ability to save
and lock the orientation of a 3D view. When a 3D view is locked, you can tag items in the view.
You can zoom and pan in a locked view, but you cannot orbit the model.



FIGURE 1.34
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T— Reveal Constraints

Highlight Displacement Sets
Hide Analytical Model
Temporary View Properties
Worksharing Display
Reveal Hidden Elements
Temporary Hide/Isolate

3D View Lock

Show/Hide Crop Region
Crop View Toggle

Show Rendering Dialog
Shadows Toggle

Sun Path Toggle

Visual Styles

Detail Level

View Scale

When you unlock a view, any tags applied in the view are not displayed until it is returned to
its saved orientation.
Temporary Hide/Isolate, Reveal Hidden Elements, and Worksharing Display tools are next in
line. The Temporary View Properties button allows you to temporarily override the properties
of a view or temporarily apply a view template to the view. This enables you to change visibility
settings without having to duplicate the view. Figure 1.35 shows the options available with
this setting. When the setting is activated, a border appears around the drawing area.

FIGURE 1.35
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Properties setting
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The Show Analytical Model button allows you to toggle the visibility of the analytical model
(a Structural feature) on and off. Displacement sets can be highlighted, as shown in Figure 1.36.
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FIGURE 1.36 Highlight Displacement Sets = @ %
Displacement sets
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Finally, there is a new button for Revit MEP 2016 (see Figure 1.37) that allows you to reveal
constraints. This can be especially useful when joining a project to learn where elements have
existing constraints, or as a memory jogger.

FIGURE 1.37 _

Reveal Constraints

= @ I

1100 L ko o o o P 6 Gk T e @ 18




ADDITIONAL USER INTERFACE FEATURES

If you have activated worksharing, then displaying the status of elements can be helpful for
collaboration on a project and can save you time by helping you avoid trying to make changes to
objects that are not editable. The Worksharing Display Settings option on the View Control Bar
provides a menu from which you can access the Worksharing Display Settings dialog box, where
you can establish the colors used for the various options of worksharing display. You can apply
colors to worksets based on who owns them, whether they are up to date, or simply by their name.
Figure 1.38 shows the dialog box and settings for worksets colored by their name. Notice that,
in the Show Color column, you can choose to show a workset’s color in the view by selecting its
check box.

FIGURE 1.38
Wor?csharl'ng DISplay Checkout Status | Owniers I Model Updates  Worksets |
Settings dialog box
Show Calar Workset Calar
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d Lighting
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When you choose an option for worksharing display, a box appears in the upper-left corner
of the drawing area, indicating the option being displayed, as shown in Figure 1.39 (the colors
are labeled for the black-and-white image). These settings take precedence over any view filters
that may be applied to the view. If you override the graphics of a category in the view, only the
changes to line weight are applied (color overrides are not displayed).

FIGURE 1.39 [Worksets|
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To turn the sun path on or off in a view, you use the Sun Path toggle on the View Control Bar,
as shown in Figure 1.40. The Sun Settings option takes you to a dialog box where you can define
the type of solar study performed, the project location, and the time of day:.

FIGURE 1.40
. Sun Settings. .
Sun path visual . un 2ettings
display options 3 5un Path OFf
payop % 5un Path On
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In the Visual Styles button menu shown in Figure 1.41, the Ray Trace option provides you
with an interactive rendered view. In both this option and Realistic mode, any rich photorealis-
tic content (RPC) objects display correctly.

FIGURE 1.41
Visual styles

@ Graphic Display Options. ..

(Fwireframe

(THidden Line

shaded

() Consistent Colors

Erealistic

EﬂRay Trace
10100 FA[F Tk Ge T 5 Fy g 2 0 c

Take some time to explore the visual styles by completing the following exercise. If you do
not have Hardware Acceleration turned on, you can do so by clicking the Options button on the
application menu and choosing the Graphics tab. You must do this prior to opening the file. If
activating Hardware Acceleration causes problems because of your video driver, you can choose
not to activate it and skip step 5:

1.

Open the RMEP2016_Ch01_Dataset.rvt file found at www.sybex.com/go
/masteringrevitmep2016.

Click the Visual Styles button on the View Control Bar, and select Shaded. Zoom, pan, and
orbit the view, and make note of the variations in color based on the model orientation.

Click the Visual Styles button and select Graphic Display Options. In the dialog box that
appears, deselect the Show Edges radio button and set Transparency to 50%; then click
Apply. Notice the change to the view. Change Transparency back to 0% and click OK.

Click the Visual Styles button and change the style to Consistent Colors. Notice that the
colors remain a consistent shade when you zoom, pan, and orbit the view.

Click the Visual Styles button and change the style to Realistic. Notice that the render
material defined for the objects is now displayed.

Click the Visual Styles button and change the style to Ray Trace. Notice that the perfor-
mance considerably slows, but the image should be more like a rendered image.
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7. Click any object in the model. If you do not already have the Properties palette active,
click the Properties button on the Properties panel of the contextual tab. Take some time
to become familiar with the behavior of the Properties palette.

Status Bar

The status bar for Revit MEP 2016 reports information about a selected item and shows prompts
with instructions for multilevel commands. It also has an active workset indicator and design
options indicator. The selection options that are available on the Selection panel of the ribbon
also show up on the status bar as icons, as shown in Figure 1.42.

FIGURE 1.42 Status bar Worksets Design options Selection options Filter options
Status bar l l l l
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You can access the Worksets dialog box by clicking the Worksets button next to the active
workset window. You can switch between active worksets by clicking the window and selecting
the desired workset, and you can view editing requests. These are the same tools as found on the
Collaborate tab, but having them on the status bar eliminates the need to switch tabs on the
ribbon to access them. This also eliminates the need to add the tools to the Quick Access toolbar.
The Design Options window displays the active design option, and you can access the Design
Options dialog box by clicking the button.

The Editable Only check box is for filtering a selection by only those objects that are editable
in a worksharing environment. Similarly, you can choose to exclude options from the selection
process.

Info Center

The Info Center is the portion of the title bar that gives you quick access to the Help menu or
information about Revit MEP 2016. The search window allows you to search for information
about a topic, as indicated in Figure 1.43.

FIGURE 1.43 » | Tvpe & keyword or phrase |m Q. & % 0O smonwhitbread » 3 (7)) - @ X

Info Center

Search
Displays the search results,

You can easily access the Subscription Center by clicking the key icon. Any topics found in
the search window or listed in the Subscription Center panel can be added to your Favorites list
by clicking the star icon to the right of the topic. Clicking the star icon on the Info Center lists all
your favorite topics. The Help menu is displayed by clicking the question mark icon. Revit 2016
has a web-based Help menu. You can access additional information by clicking the arrow next
to the Help icon, as shown in Figure 1.44.
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FIGURE 1.44 £ sinin - %K S
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You can sign into an Autodesk account by clicking the Sign In icon next to the Favorites star icon.
The Communication Center button is the one with the satellite dish on it. The
Communication Center provides information about product updates and announcements.

Exchange Apps

Figure 1.45 shows the button for the Autodesk Exchange Apps store. This takes the user to a
website where applications written for the Revit platform are listed. These are applications,
either free or available for purchase, that can be loaded into Revit to provide enhanced perfor-
mance and additional functionality.

FIGURE 1.45 0 sgnin %] @- _—=x
Accessing Exchange
Apps Exchange Apps

Launches the Exchange Apps website,

Press F1 for more help

User Interface Control

Many components of the Revit MEP 2016 user interface can be turned on or off for workflow effi-
ciency or to maximize screen real estate. The User Interface button, located at the far right of the
View tab, allows you to select which user interface components are visible, as shown in Figure 1.46.
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The User Interface button is also a way to access the Recent Files screen—which cannot be
accessed from the Switch Windows drop-down button until it has been activated by using the
User Interface button—and the buttons to access and edit Browser organization and Keyboard
Shortcuts.

Menus and Settings

The menus within Revit MEP 2016 offer access to many tools for user interface settings.
Context menus, available by right-clicking an item, also contain various tools based on the
selected item.

The Application menu includes options for exporting, printing, opening, and saving files.
This menu also has an Options button for accessing settings that establish the behavior of
the interface as well as the location of directories and files used for working on projects. You
access the Application menu by clicking the Revit logo button in the upper-left corner of the
user interface. The Options button is located in the lower-right corner of the menu, as shown
in Figure 1.47.
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The Options dialog box has several sections for different settings within Revit MEP 2016.
The General section, as shown in Figure 1.48, contains a slider that allows you to control how
frequently your file updates when youre working in a worksharing environment and using the
Model Updates option of the worksharing display features.
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FIGURE 1.48

General section
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The General section is also where you define your username for Revit MEP 2016. This is
important for worksharing because Revit uses this name to identify you for editing requests,
workset ownership, and element borrowing. Notice that in this section, the author’s name is
grayed out, as he is signed into Autodesk 360. Revit will automatically establish the username
when you are signed in, so if your company has a different method of creating usernames,
such as company login or staff number, you would need to sign out of Autodesk 360 in order to
change this.

This is also where you establish your default view discipline. This is important because it
assigns this discipline to each new view that you create, unless the view is defined by a view
template that has a different discipline setting.

The User Interface section, shown in Figure 1.49, is where you can set some general behavior
for the interface. For example, you can choose between a light gray or dark gray theme for the
interface from the Active Theme drop-down list. This tab is also where you determine which
ribbon tabs and tools are available.

The Tab Switching Behavior section in this screen is where you define how the ribbon tabs
behave after an action is completed. There are settings for the behavior in both the project envi-
ronment and the Family Editor. The check box for displaying a contextual tab on a selection allows
you to have the ribbon tab switch immediately to the contextual tab when an object is selected.



If that check box is not selected, the contextual tab still appears on the ribbon, but it does not auto-

matically become the active tab.

In addition, you can define the level of information provided by tooltips from the Tooltip
Assistance drop-down menu, shown in Figure 1.50. If you are still learning the functions of
different tools within Revit MEP 2016, you may want to set this option to High so that you
receive detailed descriptions of how tools work when you hover over them with your mouse
pointer. If you find that the tooltips interfere with your workflow, you can set this option to

Minimal or None.

FIGURE 1.49 Options
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FIGURE 1.50
Tooltip assistance

Toolkip assistance: |Mormal

[¥ Enable Recent Files page at startffone

Miniimal

|—Tab Switching Behavior

Keyboard Shortcuts

On the User Interface tab of the Options dialog box is a button that enables you to customize
your keyboard shortcuts. Clicking this button activates the Keyboard Shortcuts dialog box. In
this dialog box, you can filter the commands to make the list easier to manage and edit. You can

even filter by specific tabs or menus, as shown in Figure 1.51.

27
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You can access the Keyboard Shortcuts dialog box by clicking the User Interface button on the
View tab. There is even a keyboard shortcut for the Keyboard Shortcuts dialog box: KS.

You can sort the list in ascending or descending alphabetical order by clicking the desired
column. Once you have located a command for which you want to create a keyboard shortcut,
you can select the command to activate the Press New Keys text box at the bottom of the dialog
box. Input the desired keys that will activate the command. You can input up to five characters
for a keyboard shortcut. Reserved keys cannot be used for keyboard shortcuts; you can find the
reserved keys by using the filter in the Keyboard Shortcuts dialog box. Click the Assign button
to apply the shortcut to the selected command.

You can create multiple shortcuts for a single tool, and you can use the same shortcut keys
for multiple tools. When you create a shortcut that is used for multiple tools, you must use the
status bar to determine which tool to use when working in your project. When you type the
shortcut, the first matching command is displayed on the status bar. You can use the arrow
keys on your keyboard to cycle through available commands for the shortcut. Once the desired
command is displayed on the status bar, you can activate it by pressing the spacebar. You can
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remove a keyboard shortcut from a command by selecting the specific shortcut and clicking the
Remove button, as shown in Figure 1.52.

FIGURE 1.52 Copy co Modify>Modify
Removing a

keyboard shortcut ¢ /
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Import... | Export... | oK. I Cancel |

You can export your keyboard shortcut settings by clicking the Export button at the bot-
tom of the Keyboard Shortcuts dialog box. This saves your settings as an XML file that can be
edited in a spreadsheet program. Using a spreadsheet is another way to manage and share your
keyboard shortcuts. The XML file can then be imported into Revit by using the Import button,
allowing you to set a standard for keyboard shortcuts in a multiuser work environment.

WHAT DO I TYPE?

With Tooltip Assistance set to at least Minimal, you can see the keyboard shortcut for a tool by
hovering your mouse pointer over a tool on the ribbon. The keyboard shortcut is shown in paren-
theses next to the name of the tool.

@ Real World Scenario

COMMON SHORTCUTS

Clark is responsible for teaching a Revit MEP 2016 class. He has established keyboard shortcuts
that fit his workflow best and allow for efficient use of the software. Because he is so familiar with
these shortcuts, he wants to share them with his students so that they will all be using the same
ones during class.

Clark exports his shortcut settings to a file, which he imports into Revit MEP 2016 on the computers
in the classroom. Prior to importing the custom settings, he exported the default settings so that
they can be used later if necessary. During class he notes that the settings provided are preferred,
but each student can further customize them if doing so results in improved efficiency.

Graphics

The Graphics section of the Options dialog box allows you to set the Selection, Pre-Selection,
and Alert colors used in the drawing area, as shown in Figure 1.53. The drawing area’s back-
ground color can be changed to any other color you find comfortable working with. Settings
for temporary dimensions are also available to make them more readable. You can set the
background for temporary dimensions to Transparent or Opaque.
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FIGURE 1.53
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If you are experiencing graphics issues, you may need to change the Graphics Mode settings.
Hardware acceleration works best when you are using an Autodesk-certified video driver. Certified
and recommended drivers are available for download here:

http://usa.autodesk.com/adsk/servlet/syscert?id=18844534&siteID=123112

Settings for the appearance and behavior of the SteeringWheels® and ViewCube® features
can be found in their respective sections in the Options dialog box.

Context Menus

Although the ribbon interface is designed for efficient workflow, context menus can be the
easiest, most effective way to access settings or make changes to components of your Revit
projects. A context menu is one that appears when you right-click in open space in the drawing
area, on an item in the Project Browser, or on an object in the drawing area. Right-clicking in
open space in the drawing area activates a context menu that includes the Repeat and Recent
Commands tools. The last command used can be activated by pressing the Enter key or by
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MENUS AND SETTINGS | 31

clicking the Repeat option on the context menu. The Recent Commands option displays a list
of recently used commands for easy access during repetitive work. Figure 1.54 shows a context
menu and the recent commands used during a working session. The Recent Commands list

displays the last five commands used.

FIGURE 1.54
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The options displayed on a context menu depend on the object selected when the menu is
accessed. One nice feature of Revit MEP 2016 is the ability to define the selection set when the
Select All Instances option is chosen. Figure 1.55 shows that you have the option to select only
the objects in the active view or to select them throughout the entire project. This makes the
Select All Instances feature much more useful because you don’t have to worry about objects
that should not be selected being inadvertently included in the selection set.

FIGURE 1.55
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You can also right-click an element in the Project Browser to access a context menu. Right-
clicking a view activates a menu with options for applying or creating a view template from that
view. You can also save the view to a new file, as shown in Figure 1.56.
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When you right-click a family in the Project Browser, you get a context menu with options to
edit, rename (although the recommended workflow would be to open the family, edit, and then
choose Save As and load into the project), or reload the family. You can right-click a family type
in the Project Browser to access its type properties or to select the instances in the project with-
out having to locate one of the instances in the model, as shown in Figure 1.57.

FIGURE 1.57 Project Browser - Chl_Project-COMPLETE. vt
Context menu for a 7 0} H
selected famﬂy type Elevations (Building Elevation)

Legends
[ schedules/Quantities

[~ Annotation Sym Duplicate
[ Cable Trays Delete
. Copy ta Clipboard
. Rename...
[#-- Ceilings Select All Instances  » R ERRET
-~ Conduits Create Instance
[#-- Curtain Panels Match
[#-- Curtain Systems —
[ Curtain Wall Mu Type Properties. ..
[ Detail Ttems Search...
[#-- Duct Fittings

You can also use a context menu to manage linked files through the Project Browser.
Figure 1.58 shows the options available on a context menu when a linked Revit file is selected
in the Project Browser.
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FIGURE 1.58
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The Bottom Line

Navigate the ribbon interface. The ribbon is an efficient user interface style that works well
in Revit. The ability to house numerous tools in a single area of the interface allows for
maximum screen real estate for the drawing area.

Master It Along with the standard tabs available on the ribbon interface, contextual
tabs are available while you're working on a project. Explain what a contextual tab is and
how it may differ throughout your workflow.

Utilize user interface features. Many features are available in the Revit MEP 2016 user
interface that allow for quick access to tools and settings. The use of keyboard shortcuts can
also improve workflow efficiency.

Master It To enhance workflow efficiency, it is important to know how to access
features of the user interface. What tool can be used to activate or remove user interface
features?

Use settings and menus. Establishing settings for your user interface is another way to
create a working environment that is the most efficient and effective for your use of Revit
MEP 2016.

Master It The use of keyboard shortcuts has been part of design and drafting software
for a long time. The ability to customize the shortcuts to best suit your workflow is critical
to improved efficiency. How can the settings for keyboard shortcuts be accessed? How
can modified keyboard settings be reset?






Chapter 2

View Filters and View Templates

View filters and view templates are without a doubt the best way of organizing and presenting
the views you create in your model. Starting with view filters you can build on the default object
styles so that systems and groups of elements can have their visibility controlled independently
from their category. View templates take this a step further. The settings for any given view,
including filter overrides, can be saved as a view template. These templates can then be assigned
to any number of similar views. So for example, in a project with over 100 HVAC plan views,
a single view template ensures the consistency of the visible data, which also means those
checking drawings have to check on only technical content, not the look and feel.

In this chapter, you will learn to do the following;:

¢ Setup view filters
& Establish filter standards

¢ Control multiple views

Understanding View Filters

View filters let you document your project and separate, say, a domestic hot water system from
a hydronic supply system. In terms of elements, they could be identical, composed of pipes,
pipe fittings and accessories, mechanical equipment, and so on. But when you place views on
a sheet, you want an efficient method of controlling the visibility of each type of system so
that you can control the color, line weight, or even whether any particular system is actually
displayed in the same view. Without filters, the only way to achieve this would be to hide or
override the graphic representation of a selection set. Although you can still do this for some
particular groups of elements, the process becomes inefficient when working on a project that
has more than two sheets.

Creating View Filters

To set up view filters, you can go to the View tab and click Filters. Another way to access filters
is to type VG in any floor plan to access Visibility/Graphic Overrides. Next, select the Filters tab
and click Edit/New to open the Filters dialog box, shown in Figure 2.1. This dialog box lists the
names of several filters that are in Revit by default depending on the template you start with.
Think of accessing filters through Visibility/Graphic Overrides as a back door. Both paths get
you to the same place; however, remember that Visibility/Graphic Overrides changes are per
view, and because changes to Filters can be project-wide, accessing Filters through Visibility/
Graphic Overrides may be confusing.
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FIGURE 2.1
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When creating a new filter, notice that until you select items from the list of categories, you
cannot proceed, nor can you select another filter. As with the Visibility/Graphic Overrides
dialog box, you can filter the list of categories so that only the relevant categories are displayed,
as shown in Figure 2.2.

FIGURE 2.2
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Select the categories you want to be part of the filter set, and you are ready to apply the
filter rules. Let’s say we are creating a Sprinklers filter set. We would choose Pipe Accessories
and Fittings, Pipe Placeholders, and Pipes. Under Filter Rules, we could then filter by System
Classification, which contains the case-sensitive words Fire Protection, as you can see in

Figure 2.3.

In the previous paragraph, I mentioned System Classification, which for many filters is the
default setting. Due to the large number of filters that you may well end up using in your project
template, I advise you to change this so you filter by System Abbreviation instead. This helps
to identify and separate your systems in a way that is clearer to your end users, and it is more
flexible than the default System Classification setting.
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Here’s an example. The default Mechanical - Supply filter rule is set to Filter By “> System
Classification” with the rule “contains” and the value “supply.” This may not be a problem for
small projects, but for larger ones with multiple supply systems, it just won’t work. This limi-
tation is especially obvious for piping systems, where distinguishing between all the supply
and return systems is critical. System Abbreviation has the necessary flexibility to allow for
distinguishing among hundreds of systems. To create new system filters, the easiest method
is to select an existing system filter and then click the Duplicate icon. Once the system filter is
duplicated, make sure the proper category elements are selected and then rename the filter rule
to the name by which you want to filter.

To apply these filters to your views, you can go to the View tab on the ribbon and then select
Visibility/Graphic Overrides. Next, select the Filters tab (see Figure 2.4).

FIGURE 2.4
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On the Filters tab, click Add. This brings up the filters that you have created, so select the
filters that apply to your project. Once the filters are loaded, you can turn the filters on and
off and adjust line weights, colors, and patterns. It might be a good idea to test whether your
filters are working properly by turning them off one at a time and ensuring that the appropriate
elements are turned off in the view.

Mastering filter options will give you the ability to create your models with the standards
that your office has developed over years of producing CAD drawings.

Prior to the introduction of duct and piping systems as system families in Autodesk® Revit®
MEP 2012, filters were also used to control the color and the linetype of pipes and ducts. Some
companies may still choose to do it this way, but the main benefit of using the duct and piping
systems is that the color and linetype are set globally instead of per view. This benefit is most
obvious when you start creating additional views such as sections and callouts and you need
to keep adding the filters to get the colors of the systems. Since Revit MEP 2012, the proposed
workflow is to control color and linetype with duct and piping systems, and use filters to control
the visibilities of elements. Keep in mind, if you are using linked MEP models, you will have to
use a view filter to change the colors and other overrides in the linked file. Or, using an option
new to Revit 2016, you can override the graphics of the linked file and specify the linked view
you want to see and its associated view filter(s).

Another type of filter is the selection filter. Selection filters allow you to create and save
a filter set for selected items only instead of an entire object category. To do this, select your
objects, and from the ribbon, choose Save Selection, as shown in Figure 2.5. Give the selection
set an appropriate name.
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tions Type  Type OpenEnds | Insulation Lining Sizing B Edit

out Edit Duct Insulation Duct Lining ‘ Analysis ’ Selection

/

zl

Name: IMEChanim\ - Supply_Tamper Proof

oK I Cancel I

Once created, access the Filters dialog box again and notice that the filters are shown slightly
differently: there is now a section labeled Rule-based Filters and another labeled Selection Filters.
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With your new selection filter highlighted, you can see that the Categories and Filter Rules
panels are deactivated because you are applying the rules to the selection only, as indicated

in Figure 2.6.
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Discipline Example: Filter for Wire Types

To create a filter for wires, do the following.

1.
2.
3.

First, click the Filters button located on the Graphics panel of the View tab.
In the Filters dialog box, click the New button in the upper-left corner.

Give the filter a name that clearly identifies its purpose or the types of elements to which
it applies. You can use the Select option and select a wire in the view to create a filter for
the selected items only.

Use the Define Criteria option to create a filter for all of the instances of the desired type
that you want to display.

In the Categories section of the dialog box, select the Wires check box to apply the filter
to wires.

. In the Filter Rules section of the dialog box, choose the Type Name parameter from the

Filter By drop-down list.

Set the condition to Equals in the second drop-down list, and choose the name of the
wire type to which you want to apply the filter in the third drop-down list.

This creates a filter that affects only wires with the type name chosen, as shown in
Figure 2.7.
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To apply the filter to your view:
1. Access the Visibility/Graphic Overrides settings for the view and select the Filters tab.

2. Click the Add button in the lower-left corner, and choose the filter you created for the
wires from the Add Filters dialog box.

3. Click the Override button in the Lines column for the filter. Set the Weight, Color, or Pattern
overrides for the filter to display the wire as desired. Figure 2.8 shows floor boxes with
underground wire in the same view as receptacles with wire as it is normally displayed.

FIGURE 2.8
Using a filter to
display different
wire types in the
same view
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VISIBILITY SETTINGS SHORTCUT: VIEW TEMPLATES

Visibility Settings Shortcut: View Templates

View templates are a great way to maintain the visual fidelity of many views for the same disci-
pline in a few short steps, and it is best practice to have a default set of these predefined within
your project template(s). View templates enable you to preset properties of view types that can
be applied to any view in one simple step. These are not just visibility properties; you can also
set many of the main properties of a view.

You can create a view template by clicking the View Templates button on the View tab of
the ribbon and then selecting the Manage View Templates option. On the left side of the dialog
box is a list of view templates that exist. You can sort the list by view type by using the drop-
down list in the upper-left corner. The right side of the dialog box lists the commonly used view
parameters that the view template can control or affect. Set the default values for these param-
eters to establish the scope of the view template.

There are also Edit buttons for the various tabs within the Visibility/Graphic Overrides
dialog box. The Graphic Display Options have been separated into Model Display, Shadows, and
Lighting settings. Any project parameters you create that apply to views will also be available
within each view template.

The buttons in the lower-left corner of the dialog box are for duplicating, renaming, or delet-
ing a view template. There is no button to create a new template; this option in this dialog is to
duplicate an existing one. If there are no view templates existing in your file, you cannot access the
View Templates dialog box from the ribbon. The way to create your very first view template in a
project is either to click the Create Template From Current View button, or to right-click the view in
the Project Browser and select Create View Template From View. You can also use Transfer Project
Standards to acquire view templates (or any other settings) from another project. Either way, Revit
will prompt you for a view template name and then open the View Templates dialog box.

A more common method for creating a view template is first to create a view and carefully
configure how it looks. Once you are satisfied with how everything looks in the view, it is the
perfect candidate for the Create View Template From View tool (right-click option). This is a
preferable method because you can see what the view will look like as you make adjustments to
the properties. Creating a view template this way in your project template requires you to load a
model temporarily to be used as the visual reference. You can also use the View Templates button
on the View tab and select the Create Template From Current View option, as shown in Figure 2.9.
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In the View Templates dialog box, there is a check box next to each property that you can use
to determine whether the settings of the template for that property will be applied to the view.
This enables you to apply only the desired portions of a view template if necessary. By applying
a view template to a view, if the Visibility/Graphics check box is selected, you will no longer be
able to control Visibility/Graphic Overrides from the Visibility/Graphic Overrides dialog box;
instead, you will be controlling multiple view settings at once from Manage View Templates.
This applies to all settings that are controlled by the view template, as seen in Figure 2.10.
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Not only can you manage these view templates, but you can also see just how many views
are controlled by any one view template, also seen in Figure 2.10.

View templates can be made while creating your project template, but it is often easier when
working on an actual project, so if you are in the early stages of implementing Revit, you can
use the Transfer Project Standards tool to take view templates from a project file to your tem-
plate. Revit gives us the ability to assign a view template to any given set of views, and those
views update if the view template is changed. You can also apply any view template to any view,
especially newly created ones, and quickly have the desired settings. When you work on a large
project that has many levels or many dependent views, having view templates can save a signifi-
cant amount of time.

The Bottom Line

Setup view filters. The settings for views are crucial to being able to visualize the design
and model being created and edited in a project. Establishing the default behavior for views
and visibility of objects can increase not only the efficiency of working on a project but also the
accuracy of design.



THE BOTTOM LINE

Master It The properties of a view determine how objects and the model will appear in
the view. Along with Visibility/Graphic Overrides, what other view property determines
whether items are visible in that view?

Establish filter standards. For consistency and ease of use, maintain a set of view filters and
view templates as an aid to boost efficiency in your documentation.

Master It What is the importance of using view filters?

Control multiple views. With view templates, you have the ability to maintain a consistent
appearance to your documentation.

Master It True or false: A view template can control only one view at a time.
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Chapter 3

Worksets and Worksharing

The Autodesk® Revit® MEP 2016 platform enables users to design and model complex buildings
and engineering systems. Usually this is a team effort, so it is important to fully understand
how a Revit MEP project file can be set up in a way that allows for multiple designers and
engineers to work on these systems at the same time. Unlike traditional CAD solutions that
require many files to represent the design intent, the entire mechanical, electrical, plumbing,
and fire-protection systems can be modeled in one Revit MEP file. Doing so requires careful
setup of the project file in the early stages of the design.

Harnessing the power of Revit MEP to create a single model containing all the MEP systems
can result in quick and easy collaboration and coordination. The same is true for any Revit
project file that requires more than one person working on the same model at the same time.
Activating worksharing allows the user to create central and local files in which all users’
changes are accounted for and ensures that these changes can be coordinated as they occur.
This empowers the team to make design decisions early in the design process. It also enables
you to control how entire systems are displayed in views and ultimately in construction
documents.

To take advantage of the functionality created by enabling worksharing, you need to know
how the features work and how to manage them to best suit your company workflow and
standards.

In this chapter, you will learn to do the following;:

¢ Create a central file by activating worksharing and dividing the model into worksets
Allow multiple users to work on the same dataset utilizing local files
Work with and manage worksets

Control the visibility of worksets

* & o o

Optimize performance with a Revit Server Accelerator

Understanding Central Files

It can be difficult to grasp the idea that several users can work in the same file at the same time.
When worksharing has been enabled in a Revit MEP file, the file is “transformed” into a central
file. This file is the repository for the model and all of its associated components. In truth, each
user will not be working in this specific file but rather in a copy of this file that communicates
the actions and model changes of the user back to the central file. A copy of a central file is
referred to as a local file. These local files can be created in two ways.
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¢ By opening the central file from the Open dialog box (ensuring that the Create Local File
check box is selected).

¢ By copying and pasting the central file to a folder that is connected to the location of the
central file via a networked solution. When the copied file is opened for the first time, Revit
warns the user that saving the file will make it into a local-file copy of the central file.

A typical practice for working with a central file is to store it in a job folder on a network,
with the local copies residing on the hard drives of the users” workstations. This prevents the
users from having to work across the network while designing and modifying the model. This
workflow reduces network traffic because the data transfer occurs only when the local file is
synchronized with the central file.

DANGERS OF OPENING A CENTRAL FILE

Once multiple users have begun work on the Revit project, the central file should not be opened by
any user. If the central file is open, edits made by users working in local files will prevent the per-
son working in the central file from saving their work, unless they use Save As to create a local file
first and then sync with central like everyone else. Avoid opening the central file unless absolutely
necessary—in other words, for situations such as relocation and regular auditing. Whenever this is
done, however, all other users must have relinquished control of any worksets that they are using.

This workflow can be achieved regardless of the number of users. Each user works in their
respective local file, saving changes to the design and periodically synchronizing those changes
with the central file. So the big question is, how do several users all work in one file at the same
time? One analogy to explain the workflow is a jigsaw puzzle (albeit a puzzle to which you can
add and remove pieces while still retaining a whole). You could dump the pieces onto a table,
gather your friends or family, and begin work on the puzzle. Each person could scoop up a
handful of the pieces (local file) and work to put the puzzle (central file) together.

We could also use a library to explain the workflow. The central file is the library itself, the
sections/shelves could be worksets, and the books in the library would be the elements in a
workset. If a section of the library is closed because, say, the owners are taking inventory, then
only they have access. Everyone can see the books/elements, but they are not available for
borrowing.

The local file contains everything, like a filing system, and it is from here that users can
borrow books/elements or perform an inventory and check out a section/workset. The next
sections explain the workflow in more detail.

Creating a Central File
Like most data files on a computer, Revit project files can be accessed by only one user at a time.
To allow for multiple users, the project file must be made into a central file. This process starts
when worksharing is enabled for a project. Any user can enable worksharing, and it needs
to be done only once—by whoever is setting up the project. To enable worksharing, click the
Worksets button on the Collaborate tab as shown in Figure 3.1.

This can be done at any stage of a project, but it is best to do so as early as possible. The later
you do this, the more work is required because you have to assign elements to specific worksets
after they have already been placed.
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Worksets represent the division of a model into four groups:

¢ User-Created elements
¢ Families

¢ Project Standards

& Views

Each group contains a number of worksets, depending on the makeup of the Revit project.
Each view of the model, component, and project standard (things such as settings and types)
has its own unique workset. Every family that is loaded into the project is also assigned its own
unique workset. This partitioning is done by Revit automatically when worksharing is enabled,
to keep users from modifying or changing the properties of the same elements at the same time.
The User-Created category allows you to create your own set(s) of model components in order to
control access to those components as a group or to control their visibility.

For example, if you are working on a project that will contain the elements from multiple
disciplines, you may decide to create worksets that correspond to those disciplines. In other
words, there would be a workset for all the electrical components, one for the mechanical compo-
nents, one for plumbing, and so on. However, the real world often dictates that multiple designers
and drafters will be working on a project, so it may be necessary to divide the model into more
specific categories based on the roles of the people assigned to the project. Perhaps one person
will be working on the HVAC systems while another works on the mechanical piping. Likewise,

a designer may be doing the lighting as another develops the power systems. In this type of
scenario, it is wise to use worksets to divide the model into these categories to allow for control of
these specific systems.

Figure 3.2 shows the dialog box that appears the first time you click the Worksets button in a
project. This dialog box informs you that you are about to enable worksharing, and it contains
some important information.

FIGURE 3.2 £
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ENABLING WORKSHARING

The emphasis on this first dialog box cannot be stressed enough. It warns that you are in the
process of enabling worksharing. This does require careful planning and management. In other
words, once you have enabled worksharing for a project, it will always be enabled. Thus, the file
will always behave as a central file—that is, of course, unless you open the central file by using the
Detach option and follow it up with Discard Worksets. The significance of this warning is that if
you do not need multiple users working on the file at the same time, then enabling worksharing
is not strictly necessary. At this point, there are several points of view regarding how to proceed.
One is that all project files, regardless of how many people are working on the project, should be
enabled for worksharing. This method means that all projects can be accessed in the same way and
users always work on a local file. The benefits of this are as follows:

@ The user has a separate place to design prior to sharing the file with the project team.
There is less network traffic.
There is more than one location for backup files.

Users, especially those who are new to the software, have less to think about.

* & o o

There is less reliance on users renaming files.

This dialog box also indicates the worksets to which the components in the model will
be assigned (if any exist when you click the Worksets button). So if you have already begun
to build the model and later decide to enable worksharing, Revit will assign all the model
components to two default worksets. Revit assigns any levels and grids to a workset called
Shared Levels and Grids. This is done because these types of elements are generally used
by all disciplines and are typically visible in all model views. Everything else that exists
(model elements) in the model is assigned to a workset called Worksetl. You can rename
these default worksets to something more appropriate to meet your project needs. However,
I recommend that you don’t rename Worksetl because it can’t be deleted. You should,
however, create your own worksets and reassign the objects to the appropriate one. If you
enable worksharing in a file that contains no model, the default worksets will still be created;
they will just be empty.

When you click OK in this dialog box, Revit creates worksets for each view, project standard,
and family that are in the project file. If model elements exist, Revit assigns each component to
the default workset. Once worksharing has been enabled, the Worksets dialog box is opened, as
shown in Figure 3.3.

The first thing to notice is the drop-down list in the upper-left corner of the dialog box.
This indicates which workset is active. When a workset is active, any components that are
placed into the model are part of that workset. This is similar to more traditional CAD
systems; when lines are drawn, they are on the layer that is set as the current layer. The Name
column of the dialog box lists all the worksets in the project, depending on which category is
being shown. The check boxes below the columns allow you to switch between the categories
of worksets you are viewing. This keeps you from having to view the entire list of worksets at
one time.
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FIGURE 3.3 X
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The Editable column in the dialog box has two options: Yes or No. When a workset is set to
Editable (Yes), the user has what is known as ownership of that workset. This means that user is
the only person who can modify the model elements that belong to that workset. Ownership
can be taken only by the user; it cannot be assigned by someone else. If a workset is set to Non
Editable (No), it does not mean that the workset cannot be edited. It simply means that nobody
owns that particular workset, so anybody working in the model can modify elements that belong
to that workset—as long as no one else is trying to do the same thing!

You will notice that, by default, the user who first enables worksharing and creates a central
file is the owner of the default worksets. That user must save the file before being able to relin-
quish ownership of those worksets. This is a critical step when a central file is created, because
the goal is to allow multiple users to access the model.

Next is the Owner column. Notice in Figure 3.4 that there are several owners of worksets, yet
five are marked as Editable. These are worksets in a local file reflecting the changes made by
user simon.whitbread; the action of making a workset editable means the person who performed
the action is the owner. There cannot be two owners of a workset.

The next column in the Worksets dialog box is the Borrowers column. This displays the
username of anyone who has worked on elements in the model that belong to that particular
workset. As you can see in Figure 3.4, the username larry.lamb is listed in the Borrowers column
for the workset E-630 Lighting because that user modified a model element or elements in that
workset; in addition, you can also see that user JOHN.DOE is owner of workset A-314 Windows,
and larrylamb owns F-670 Fire Alarms, whereas user jane.doe has made the workset P-520
Drainage editable and is therefore the owner.

Also notice the three dots after larry.lamb in the Borrowers column (...) for the workset E-630
Lighting; this indicates that there are multiple borrowers in the same workset. You can see who
those borrowers are by left-clicking in the right side of the Borrowers column.
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FIGURE 3.4
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This is the core functionality of worksharing. At all times, Revit is keeping track of who
is manipulating the model and on what parts of the model they are working. The central file
is keeping track of the work done in the local files. Two users cannot borrow the same model
element at the same time; this is how multiple users can work on the same model simultane-
ously. If you select a model element such as a light fixture and another user has already selected
and modified that light fixture, Revit will warn you with a dialog box that you cannot modify
that model element until the other user relinquishes control of it. You will learn more about this
workflow later in the chapter. Going back to the (expanding) jigsaw puzzle analogy, if you were
to pick up a puzzle piece to place it somewhere, no other person at the table could do anything
with that piece until you let go of it. Revit lists all the usernames of anyone borrowing elements
on a workset.

The next column of the dialog box indicates whether a workset is open. If a workset is not
open, Revit will not display its elements in any view of the project. When you open a Revit
project that has worksharing enabled, you have the option in the Open dialog box to set which
worksets will be open with the file. This can save file-opening time and improve file perfor-
mance. For example, you could choose not to open the Lighting workset if you are working only
on the plumbing systems and have no need to coordinate with the lighting portion of the model
at that time. This may help with model regeneration time and improve your productivity.

The last column of the dialog box is the Visible In All Views column, which allows you to
control the visibility of the worksets. You will see that when you create a workset, you can
determine whether it is visible in all views. I'll explain this further in a moment.

Creating a New Workset

To create a new workset, click the New button in the upper-right corner of the Worksets dialog
box. This displays the New Workset dialog box, which allows you to name your new workset, as
indicated in Figure 3.5.
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This dialog box has a check box allowing you to set the default visibility of the workset in your
model views. When you give the new workset a name and click OK, it is added to the list of User-
Created worksets. Whoever creates a workset is the owner of that workset by default. Once you
have created the worksets necessary for your project and you click OK in the Worksets dialog box,
you must save the file to complete the creation of a central file. Revit will warn you with a dialog
box if you attempt to relinquish your control of the worksets prior to saving the file as a central file.

After enabling worksharing and establishing your worksets, click the Save button to create
the central file. Because this is the first time you have saved the file as a central file, the message
box shown in Figure 3.6 is displayed.

FIGURE 3.6 Save File as Central Model x|
Save File As
Central Model This is the first time that the project has been saved since

‘Worksharing was enabled. This project will therefore
become the central model. Do you want to save this project
as the central model?

If you want to save the file as the central model with a different name
andjfor different file location, dick No and use the Save As command.

e |

If, however, you want to change the name of the central file, use the Save As option. For
example, some companies use one naming convention for nonworkset projects and another
for those with worksets enabled. In the former, the project is named with a project number
(12345-HVAC. rvt) and then, after worksharing has been enabled, the name is changed via the
Save As process to contain the word Worksets or the letters WS (12345-HVAC-Worksets.rvt or
12345-HVAC-WS. rvt). Because this file has just had worksharing enabled, clicking the Options
button shows you that this file is being saved as a central file, and the Make This A Central
Model After Save check box is grayed out, as shown in Figure 3.7.

Once your file has been made into a central file, a backup folder is automatically created.
This folder contains data files that will allow you to restore a backup version of your project if
you should ever need to roll it back to an earlier date or time. Having several users on a project
who are saving frequently can limit how far back in time you can go to restore your project.
Therefore, I recommend that you archive your project file at intervals logical to the submittal of
the project. It is also worth pointing out the difference between the nonworkset backups, which
are copies of the old file before saving. If your project is 50 MB and you have 20 backups, you
now have a project taking up approximately 1 GB of storage. However, with a worksharing-
enabled project, this becomes less of an issue because the backups are recorded as the changes
to the original file, and although they can be more in number, less actual data is represented
because there is no need to have complete duplicates.
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The first thing you should do after the file is saved is click the Relinquish All Mine button
on the Collaborate tab. This releases ownership of all worksets and borrowed elements. The file
should then be saved again so the central file is in a state where no user has ownership of any
worksets. A more efficient way to achieve the same result is to use the Synchronize And Modify
Settings option; here Revit saves the local file, synchronizes, and saves the local file again—in one
action. However, if you have a central file open, you will notice that the Save button is inactive. To
save a central file when you have it open, you must click the Synchronize With Central button on
the Collaborate tab. This saves the file and creates a record of your actions in the backup folder of
the project. Once the central file has been saved, it should be closed before any more work is done
on the project file. From this point on, all work should be done in the local files of the project. In
summary, follow this basic procedure for projects that have been already started:

1. Save the file.

2. Enable worksets.

3. Save the file again to commit changes.

4. Synchronize to relinquish ownership of everything.
5. Close the file.

The project is now ready for users to create local files and begin work.

BEST PRACTICE FOR NAMING CENTRAL FILES

Regardless of your company file-naming standards, it is a good idea to put the word worksets—or
an equivalent designation—somewhere in the name of your central file. Because the central file
is so important, you want to identify it clearly in your project folder structure. Using this naming
convention will also help confirm that the correct file is being shared with consultants.
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To summarize, these are the steps to create a central file for a brand-new project (before any
work has begun):

1. Choose New > Project from the application menu.

2. Click OK in the New Project dialog box or click Browse to choose a different template.
3. Click the Worksets button on the Collaborate tab.
4

. Verify that the worksets Shared Levels and Grids and Worksetl appear in the
Worksharing dialog box, and then click OK.

bl

Create any additional worksets needed for your project in the Worksets dialog box.

6. Click OK. You will be asked whether you want to make one of your User-Created
worksets the current workset. You can choose to do so, but it has no effect on the file
creation.

7. Save your file to the desired location. Your file will be saved as a central file. You are the
owner of all of the worksets until you relinquish them.

8. After you have saved your file, click the Relinquish All Mine button on the Collaborate
tab. The Save button is no longer active, so you must use the Sync And Modify Settings
button to save your changes.

Working with Local Files

Now that the central file has been created, each person who will work on the project must cre-
ate a local-file copy of the project. This local file can reside on the users’ local workstations or
on the network, although local C: drives are generally the best location. The important thing is
that the local-file copies must be on a computer that is connected to the same network as the file
server hosting the central file so they can be synchronized and so Revit can keep track of who
borrows elements.

Creating a Local File

The Create New Local option in the Open dialog box shown in Figure 3.8 is selected by default
when you attempt to open a central file.

The Create New Local option can prevent users from accidentally opening the central file
by automatically creating a local file when they click Open. This is the easiest way to create a
local file. Using this method creates a local-file copy of the central file in the folder specified
in your Revit settings. Also of note in Figure 3.8 are the files and folder. There are four proj-
ect files: Project_12345.rvt is the original stand-alone project file, the ones with .0001 and
.0002 appended to the filename are its backup files, and Project_12345-WORKSETS. rvt is the
workset-enabled central file. The folder Project_12345-WORKSETS_backup is the backup store
for the worksharing file. The filename of the new local file will be the same as the central file,
with _username added to the end. Figure 3.9 shows the File Locations tab of the Options dialog
box indicating the destination folder for project files, and Figure 3.10 shows the local file saved to
the destination folder.
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Utilities are available that automate the creation of a local file, and some companies develop
their own routines that conform to their specific standards, such as file naming and project folder
structure. If you do not have such a utility, another way to create a local copy of a central file
is simply to browse to its location and copy/paste it to the desired location by using Windows
Explorer (see Figure 3.10). Once you have placed the local copy, it is important to rename the file,
removing the word central from the filename (if used) to avoid confusion. Having your username
in the filename helps to keep track of who owns the local files. If you use this method when you
open the copied file, you will receive a warning dialog box stating that the central file has moved
or has been copied and that saving the file will make it a local file—which is the intent. Click
Close on this warning, shown in Figure 3.11, and you will have a local file after you save.

One thing worth stressing is that users should not use Windows Explorer and double-clicking
to open a project file. Although this has almost become the de rigueur way of opening other CAD
files (or, for that matter, any format file), you can land in trouble if you use this method when open-
ing a Revit central file. This approach does not create a local file. Invariably users forget to use Save
As to create a local file, and when they select Synchronize With Central a few hours later, there is
the potential to overwrite any changes made when others have synchronized their local files.

Synchronizing a Local File with the Central File

The Revit software is in constant communication with the central file and all the local-file copies
in order to maintain coordination of the model elements. As you are working in the model, it is
aware of the elements over which you have control. You have two ways of saving your work.
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The first is to save your local file by simply clicking the Save button or selecting Save from the
Application menu. When these changes are saved, they are saved to your local file only. This
gives you the freedom to save at frequent intervals without accessing the central file, except for
any required communications in Revit. This also allows for a more efficient workflow, because
minor changes and reworking of the design can be finalized before pushing them out to the
entire design team.

The second method for saving changes is to synchronize with the central file. There are two
parts to the Synchronize With Central button:

¢ Synchronize Now synchronizes with the central file and relinquishes control of any
borrowed elements. User-Created worksets—and their objects—are not relinquished at
this point if the user is the current owner. This means the worksets and objects assigned to
them remain in your control.

¢ Synchronize And Modify Settings gives you additional options. Synchronizing occurs,
and the user also has the option to relinquish control of any type of workset element, save
the local file, and add a comment to the central file. This could be a note to other users or a
reminder that the project was issued at a particular date and time. Additionally, you have
the Compact Central Model option. This should be treated as a maintenance process and
used when you can work in the central file while no one else is accessing it.

The Synchronize commands are on the Collaborate tab and the Quick Access toolbar (QAT)
as shown in Figure 3.12.

Clicking either of these buttons saves any changes made in the local file to the central
file. The Synchronize command also updates the local file with any changes that have been
synchronized to the central file by other users. Thus, when you click Synchronize, you are
updating your local file to the most current status of the project. Another very important thing
happens when you synchronize with the central file: any items that you are borrowing in the
model are relinquished when you synchronize. If you need to relinquish your control over items
in the project but are not yet ready to save your changes, you can do so by saving your local
copy and then clicking the Relinquish All Mine button on the Collaborate tab. If, however, these
objects have been changed in any way, the only method for relinquishing control is using the
Synchronize With Central option.

Synchronizing and relinquishing will become a regular part of your daily workflow when
the project gets rolling. You should be aware of some important occurrences in this workflow.
If two or more users try to synchronize with the central file at the same time, Revit will syn-
chronize them in the order in which the synchronize actions occur. So whoever hits the but-
ton first will have their changes saved first. While the central file is being updated, other users
who have attempted to synchronize may see a dialog box with a message that the central file



FIGURE 3.13 T

New local-file
creation options
when alocal file FILES\Project_12345-WORKSETS_simon.whitbread....

already exists want to do?

WORKING WITH LOCALFILES | 57

is currently busy. They can cancel their attempt to synchronize or wait until the central file is
available. Clicking the Cancel button means that no synchronization will occur. If they wait, the
synchronization will happen as soon as the central file becomes available.

Accessing Model

= Model Project_12345-WORKSETS. rvt is being accessed by
someone else and is not available, Click Cancel to stop the
current operation and try again later or wait for the model to

become availshle.

Local files can be deleted and new ones created at any time. I recommend that you create a
new local file every day as you begin work. This limits the number of warning and error mes-
sages that are saved to the central file and ensures that you start your Revit session with an
updated copy of the central file. If you do not choose to make a new local file each day, it is
important to update your local file with any changes that other users may have made while you
were gone. You can do this by selecting Reload Latest from the Collaborate tab. When another
user synchronizes with the central file, keep in mind that your file will not update with those
changes automatically. You must either synchronize your file or reload the latest version of the
central file.

When you start working on a project and want to create a new local file, you can browse to
the location of the central file and open it with the Create New Local option selected. If you
already have a local file for the project, a dialog box will appear with options for creating the
new local file, as shown in Figure 3.13. As you can see, there are options for overwriting and
appending. If you choose the append method, it is a good idea to check your folder from time
to time, just to make sure you are not running out of disk space. Refer to the section “Computer
Maintenance” in the Introduction.

Depending on the changes made since the last time you worked on the file, your local file
could become irreconcilable with the central file. Therefore, it is a good practice to create a new
local file each day.

When the time comes to end your session of Revit MEP, it is best to synchronize your local
file with the central file. If you forget or you choose not to by closing the program, you will see a
dialog box with options for closing your session of Revit MEP. Figure 3.14 shows the options for
closing a local file that has not been saved or synchronized with the central file.

L You are trying to create a new local file G\LOCAL
REVIT

but a file with this name already exists. What do you

| =» Overwrite existing file |

<» Append timestamp to existing filename

Cancel |
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Clicking the Cancel button in this dialog box will return you to your session of Revit MEP.
Clicking the Synchronize With Central option will open a dialog box with settings for your syn-
chronization, as shown in Figure 3.15.

Notice in Figure 3.14 that you have the option to save your local file before and after it is syn-
chronized with the central file. There is also a setting to control whether you will relinquish any
worksets or borrowed elements.

If you click the Save Locally option in the dialog box shown in Figure 3.14, another dialog box
appears with your options for relinquishing any borrowed elements or owned worksets, as seen
in Figure 3.15.

You can choose to relinquish any items even though your changes are saved only to your
local file and not the central file, or you can choose to keep ownership of the items. Keeping
ownership prevents others from editing those items even after you close your Revit session.

Selecting the third option, Do Not Save The Project, in the dialog box shown in Figure 3.14
will also open a dialog box, this time specifying that you are about to close a project without
saving and that any changes will be lost. The options provided are identical to those in Figure
3.16 for relinquishing control of worksets and borrowed elements. So, even if you open the file
to make changes that you don't intend to keep, be aware that you may affect others’ use of the
model by borrowing elements. It is important to relinquish worksets and borrowed elements
when you are closing your Revit MEP session to allow others to work without running into the
obstacle of not being able to edit an element because you have ownership.

FIGURE 3.15 A
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Managing and Using the Power of Worksets

Any work done in a local file transfers to the central file when synchronized. This is also
true for worksets. When the central file is created, you may not know what worksets will
be necessary, so they may be created in the local file and will appear in the central file after
synchronization.

To make a model element part of a workset, either that workset has to be set as the active
workset or you can change the element after placing it. (This is not necessarily the best work-
flow, because you then have to remember to make the change.) You do not need to be the owner
of a workset to assign a model element to it.

You do not have to access the Worksets dialog box to set a workset as active. The Workset
panel of the Collaborate tab contains a drop-down list of all the worksets in the project. The
workset visible in the drop-down window is the one that is set as the active workset. Remember
that the words Not Editable next to the workset do not mean that changes cannot be made to the
workset; they simply indicate that the workset is not owned by you.

With the ribbon-based user interface, it can be cumbersome to switch to the Collaborate tab
each time you want to set a workset as the active workset or check to confirm that the correct
workset is active before placing an element in the model. Therefore, the current workset drop-
down list is available on the status bar, so it is visible at all times. You can also add the Workset
drop-down to the QAT if you choose, as shown in Figure 3.17.

Taking Ownership of Worksets

There are two primary reasons for making a workset editable. When you make it editable, no
other user can edit any model elements that are assigned to that workset.

First, if you are concerned that someone else might inadvertently move or edit an element
that is part of your workset, you can take ownership of the workset. However, this scenario can
be detrimental to the efficiency of the team if other users need to make changes. You have other
alternatives for protecting elements in a model, such as pinning them in place.

A second reason for workset ownership is to protect a group of elements such as a system or
area of the model from changes while design decisions are being made. This most commonly
occurs when you have to work on the project offline, such as when meeting with a client.
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To take ownership of a workset, all you have to do is open the Worksets dialog box and change
the value to Yes in the Editable column. It is best to synchronize your local file with the central
file after taking ownership of a workset. Additionally, you can use the right-click context menu to
choose Make Workset Editable when you select the element. Taking ownership of a workset, how-
ever, does not guarantee that you own everything assigned to it. If someone has already borrowed
elements from it, they remain borrowed by that user. It is much safer to tell all users you are going
to take things “offline” and instruct them to sync and get out of the project before taking control.

@ Real World Scenario
USING WORKSET OWNERSHIP AWAY FROM THE OFFICE

Roberta is an electrical designer working for an engineering firm that is consulting with an architect
in another state. She is nearing her project deadline, and the client is ready to decide on some of
the proposed lighting options. While Roberta is meeting with the architect and client, she wants
to make sure that no unnecessary work is done to the lighting model because she will most likely
bring back a new design that would make those changes obsolete. So, she takes ownership of the
Lighting workset and then takes a copy of the project with her on her laptop.

During the next two days, Roberta makes several modifications to the lighting design while the
client and architect provide input. When Roberta returns to her office, she connects her laptop to
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her network, opens her local file, and synchronizes her changes with the central file. Because she
had ownership of that workset and has confined her design work to only that workset, no other work
could be done to the lighting design, and her changes made remotely are now part of the central file.

Although this workflow does work, all users in this project need to be aware of the process. None
of the views, annotations, or sheets associated with Roberta’s workset should be amended because
this would cause Roberta’s work to be irreconcilable. Unfortunately, this scenario is fairly common
and usually ends in heartache for everyone concerned.

A far better, and safer, workflow would be for Roberta to use remote desktop access and connect to
her workstation back in the office, or she could work on her laptop but use a VPN connection. This
way, she can stay connected to the rest of the project team and carry on with her design.

Working with Model Elements and Their Worksets

When a workset is set to be the active workset, any component placed into the model will be
part of that workset. Annotative elements such as text, tags, or dimensions do not become part
of a User-Created workset but rather the workset of the model view in which they are drawn.
Each project view, including sheet views, has its own workset. When you are working in a view,
adding annotation or detailing, you remain the borrower of those objects but do not become a
borrower of the actual view until you alter something already assigned to that view’s workset.
Other users can annotate objects in the same view, but the reality is that most workflows would
make this difficult unless the view was a multiservice one that had several engineers provid-
ing input to the design. They cannot, however, change the properties of that view until your
changes are synchronized.

OH No, I’m NoT!

Users often forget to select the Views, Project Standards, and Families check boxes when looking
at the Worksets dialog box to see whether they are borrowing an element. Approached by fellow
workers who cannot access items in the project, they insist that because the User-Created list of
worksets is clear, there must be a problem with the software!

The User-Created worksets are ours to manage. The Views, Families, and Project Standards
worksets are managed by Revit. They are created automatically for us and we cannot delete
them; we can only choose to make them editable. Deleting a family or view will remove its
workset from the project.

To delete a User-Created workset, you must first take ownership of it. You can do so only
if no other users are borrowing elements on that workset. You also have to close the Worksets
dialog box after taking ownership before you can delete the workset. You can then reopen the
Worksets dialog box, select the workset from the list, and click the Delete button on the right
side of the dialog box. If you are deleting a workset that contains elements, a dialog box presents
options for those elements. As shown in Figure 3.18, you can either delete the elements from the
model or move them to another workset.
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FIGURE 3.18 Y
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If another user owns the workset into which you are trying to move your elements, you will
need to have that user relinquish ownership of the workset before you can move your items to it.
When you place your cursor over an object in the model, a cursor tooltip lists information
about that object, as shown in Figure 3.19. When worksharing has been enabled in a project, the

first item in the tooltip is the name of the workset to which the object belongs (unless design
options are in use, in which case that information will be first).

FIGURE 3.19

Model object infor-
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[E-630 Lighting : Lighting Fixtures : M_Pendant Light - Linear -
2 Lamp : 2400mm - 277V
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This is the easiest way to determine the workset to which the object belongs. This informa-
tion can also be found in the properties of a model object or project component. The Workset
parameter of an object is an instance parameter listed under the Identity Data group. If you need
to change the workset of an object, you can edit the setting for the parameter in the Properties
palette. Turning on Worksharing Display will also give you more information if you are display-
ing tooltips.

SELECTING MODEL ELEMENTS

Clicking an element to select it does not mean that you are borrowing that element. You must
modify it in some way—by changing one of its properties, by moving it, or by making the element
editable—before you can borrow it.
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Apart from directly editing an object to make it editable, there are two other ways to make it
editable. Select an object and you will see the Make Element Editable symbol appear, as shown
in Figure 3.20; clicking this symbol gives you control of the object. Do this and you’ll find your
username listed in the Borrower column for the workset of that element of the Worksets dialog.

FIGURE 3.20
Make Element
Editable symbol

27184

“
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Make element editable

SE4E 7

The alternative is to select one or more objects and right-click. This gives you the option to
make either the object(s) or the entire workset(s) editable, as shown in Figure 3.21.

FIGURE 3.21
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You can change an object’s workset either by first borrowing the items in the model or by just
selecting those elements. In either case, the Workset parameter is available, and you can change
its value by selecting from the drop-down list of workset names, as shown in Figure 3.22.

FIGURE 3.22
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You can change the workset of multiple items by selecting them all and then accessing the
Workset parameter in the Properties palette. Keep in mind that nobody else will be able to
edit items on that workset that you own until you relinquish your ownership, even if they are
not items on which you are working. You may also have a conflict if one or more of the elements

you want to change have already been borrowed by someone else.

As mentioned earlier, each model component has its own workset. So say you select a family
item in the model and you then select the Edit Family option from the Modify tab. After you
load the family back into the project, a dialog box notifies you that the family is not editable and
asks whether you would like to make it editable. This will give you ownership of the workset
for that family. Because this does not occur until you load the family back in, it is possible that
two or more users could edit a family but only the first one to load it back into the project would
gain access to the workset; therefore, only that user’s changes would occur in the project. It is
important to discuss things like this far more than you may be used to doing prior to using

Revit.

If you are the owner of a workset and want to release your ownership, you can do so by
accessing the Worksets dialog box and changing the editable value from Yes to No. If itis a
User-Created workset that you are releasing, you will remain the borrower of any items that
you have modified on that workset until you synchronize with the central file. If you attempt to
use the Workset dialog box to release your ownership of a family workset, you will be notified
that the local file must be synchronized with the central file in order to release that workset.
This method, however, may not work efficiently in all cases, and the most thorough and reliable
way of reconciling these differences is to use Synchronize And Modify Settings.
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UNDO, UNDO,...UNDO!

We tend to rely on the good old Undo button to clean up our messes, but beware: the Undo func-
tion will have no effect on workset ownership or borrowing of elements. Once you own a workset
or borrow an element, it is yours until you release it. Additionally, should you delete objects such
as views or families from the Project Browser without first making their workset editable, the
Undo history is reset. Just as you would when opening and unloading a linked file, you should take
extreme care when deleting anything.

Controlling Visibility and Worksets

One of the key advantages to using Revit for project design is that it enables you to visualize the
model. You can also use visibility settings to define how your views will appear on construction
documents. With the model divided into worksets that denote the engineering systems, you can
harness this power to help you design more efficiently by using working views. A working view
is one that may show more or less model information than would be represented on a construc-
tion document.

The first feature of visibility control is simply turning items on or off. This applies not only
to model categories but also to worksets. When worksharing has been enabled in a project, an
additional tab, Worksets, appears in the Visibility/Graphic Overrides dialog box, as shown in
Figure 3.23.

FIGURE 3.23 visibility /Graphic Overrides for Floor Plan: Level 1 - Lighting Plan x|
Visibﬂity/ Graphic Model Categaries | Annatation Categories | Analytical Model Categaries | Imported Categories | Fiters Worksets |
Overrides dialog These visibiity settings contral the display of worksets in the current view.
b Select Use Global Setting to use the workset’s Visble in all views” setting defined in the Worksets dialog.
ox Select Show or Hide to show or hide the workset, regardless ofits "Visible in all views” setting.
Worksets visibility Setting
A-220 Floors Use Global Setting (Visible)

A-314 Windows

Use Global Setting (Visible)

A-315 Doors

Use Global Setting (Visible)

E-520 Power

Use Global Setting (visible)

E-630 Lighting Use Global Setting (Visible)
F-670 Fire Alarms Use Global Setting (Visible)
F-676 Fire Protection Use Global Setting (Visble)
M-570 HVAC Use Global Setting (Visible)
P-520 Drainage Use Global Setting (visible)

Shared Levels and Grids

Use Global Setting (visible)

Workset 1

Use Global Setting (visible)

X-A000 Linked Architecture

Use Global Setting (visible)

X-5000 Linked Structure

Use Global Setting (Visible)

election

Al I None

Items in the checked worksets may be visible. All others are invisible.

*The workset wil not be visible because itis dosed. To open it, go to the Worksets dialog and select "Open’”,

oK

Cancel Aoply Help
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This tab of the dialog box provides a list of the User-Created worksets in the project and
enables you to set the visibility behavior of the worksets in the current view.

BB ~ 3150001

- E-6.20 Power

- E-630 Lighting
F-670 Fire Alarms

There are three options for workset visibility in a view:

¢ When you hide a workset, none of the items assigned to that workset are visible in the view,
even if the categories of the individual items are set to Visible. The visibility settings for the
workset take precedence over the settings for model categories.

¢ The Use Global Setting option means that the visibility of the workset is determined by the
Visible In All Views setting established when the workset was created or the status of that
setting in the Worksets dialog box. The status is shown in parentheses.

¢ The Show option is an override of Use Global Setting, which could be set to Not Visible.
Using Show displays the elements assigned to this workset regardless of what the global
setting requires. If an element does not appear, other factors (such as filters, design options,
or individual graphic overrides) may be determining visibility.

When setting up your project worksets, it is important to consider this functionality.
Thinking about what types of systems or groups of model components might need to be turned
on or off will help you determine what worksets to create. Doing so early will save time from
having to do it later, when the model contains many components that would have to be modi-
fied, and will make controlling visibility easier from the start.

Although this workflow is a valid one, consider that in any office you may have a mixture of
workset-enabled projects and others that just come in the standard file format. Some users may
even be using the Revit LT version of the platform, where worksharing cannot be enabled and
the MEP features, although visible, are not meant to be edited. While worksets can be added to
view templates, they cannot be added into your project-template file because worksets cannot
exist in a project template. This means that you cannot create a standard view template to carry
through all your projects. The alternative would be to use filters that can be applied in the tem-
plate file and can cover most, if not all, of your needs for view control.

Another way to control a workset’s visibility is to determine whether the workset will be
opened when the project is opened. In the Open dialog box, you can click the arrow button next
to the Open button to access options indicating which worksets to open with the file. Figure 3.24
shows the options.

Selecting the All option will open all the User-Created worksets when the file opens. This
does not mean that all the worksets will be visible in every view; it just means that the worksets
are open, or loaded into the project. Selecting the Editable option will open (load) all worksets
that are editable (owned) by you. If another user has ownership of a workset, it will not be
opened with this option. The Last Viewed option is the default.
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FIGURE 3.24 £
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FILE LINKS ON THE RECENT FILES SCREEN

Whatever option you choose from the Open dialog box will be applied to the thumbnail link of the
file on the Recent Files screen. Using the link opens your file with the Last Viewed workset settings
applied. However, as with using Windows Explorer to open a file, using the Recent Files screen is
not a recommended workflow with workset projects; it is a best practice to always use the Open
dialog box. You could be opening an old local file or even the central file itself—both of which can
cause problems, not just for yourself, but also for everyone else on your project team.

The final option for opening (loading) worksets in a file is the Specify option. This option
allows you to choose which worksets will be open when the file is opened. Selecting Specify
opens the dialog box shown in Figure 3.25, where you can choose the worksets to open.

Specify is a powerful option because it can greatly improve the file-opening time and overall
performance of your model. If you need to work on a system in the model and do not need to
see other systems, you can choose not to open their respective worksets, decreasing the amount
of time for view regeneration and limiting the number of behind-the-scenes calculations that
are occurring when you work on your design. If you decide later that you want to see the items
on a workset that you did not open when you opened the file, you can open the workset via the
Worksets dialog box. When you open the Visibility/Graphic Overrides dialog box for a view,
unopened worksets will appear in the list with an asterisk next to them, as shown in Figure 3.26.
So if you are not seeing a workset that is set to be visible, you can quickly see that it is not visible
because it is not open.
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FIGURE 3.25 Opening Worksets x|
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One way to use this functionality for improved performance is to create a workset for each
Revit file that you will link into your project. This gives you the option of not opening the work-
set of a linked file without having to unload the linked file.
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Enhancing Communication

In previous versions of Revit MEP, users actually had to talk to each other when someone wanted
control of a workset or borrowed object—well, really! Seriously, though, this can and did lead to
some strange work practices. Picture this: 10 people on a project team sitting at small desks in a
small office, working on the same model ... and the only mode of communication was email!
Users can stay in their comfort bubbles, and Revit now provides a “heads up” notification
when an editing request has been made. In Figure 3.27, user simon.whitbread wants ownership
of a selection of objects but cannot have it until users JOHN.DOE and larry.lamb relinquish con-

trol, so simon.whitbread places a request.

FIGURE 3.27
Workset place
request

After the request has been made, a notification message, shown in Figure 3.28, pops up at
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FIGURE 3.28
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If the user ignores the notification, the status bar will show a highlighted request and indi-

L—V:I;_L Model: Ch03_Exercise01-Worksets
Element: Multiple elements
Requested by: simon.whitbread

Message: Another user requests your
permission fo edit these elements.

cate the number of requests (Figure 3.29).
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FIGURE 3.29 Number of editing
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When the user clicks this message, the Editing Requests dialog box is displayed, as shown
in Figure 3.30. This shows all the pending requests between you and other users, the objects
involved, and, if necessary, whether synchronizing with the central file is required. This
requirement may be due to objects being changed, edited, or deleted rather than only that the
workset is owned.

FIGURE 3.30 X
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And, of course, depending on the users” workflow, they can either grant or deny access to
these objects. The varying results can be seen in Figure 3.31.

FIGURE 3.31 iti i HES Editing Request Granted HES
Results of request Model: Ch03_Exercise0l-Worksets Model: Ch03_Fxercisedl-Worksets
actions Element: Workset 1 : Spaces : Space : MZR 20 Element: Multiple elements

- N“C“b” 20 Granted by: larry.lamb

Denied by: JOHN.DOE Message: You have been granted permission to

Message: You have been denied permission to edit these elements.

edit these elements.

Show
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Editing request denied by Editing request granted by

user JOHN.DOE user larry.lamb
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As described in Chapter 1, “Exploring the User Interface,” you can turn on the worksharing
display that allows you to see the owners and/or worksets of all the objects in the view in
which you are working. This can be useful for general modeling or as an overview of the whole
building model. Figure 3.32 shows the display.

FIGURE 3.32 zl
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Using Revit Server

It would be possible to devote an entire chapter to configuring Revit Server, but this book is pri-
marily aimed at the user, rather than the installation side of things. So, with that said, what does
the user need to know about Revit Server?

In essence, the experience should be very similar to the file type of worksharing—you open a
central file from the Revit Server and Revit creates a local file that you work on and synchronize
your changes.

However, before you even get to opening a file, you should check that you are using an
accelerator. The main purpose of using Revit Server is so that geographically dispersed teams
can effectively work on the same project file. Now, given that Revit project files can be on the
large side (200-300 MB is not unusual), you don’t want Revit to upload and download all that
data every time you create a new local file—it just isn’t efficient. This is where the accelera-
tor comes in. The accelerator creates a cached copy of the central file, which is then accessed
by the other users who are connected to that accelerator. Even though you browse to the host
server—let’s say a Revit Server in Oklahoma—the majority of the data comes from your nearest
accelerator that has been configured to be London, giving you a better user experience. You can
find out more about your accelerator, if any exists, by clicking Manage Connection To A Revit
Accelerator, which you’ll find on the Collaborate tab, as shown in Figure 3.33.
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FIGURE 3.33 T O
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If an accelerator is not set, you can type in its name or an IP address and your Revit Server
Accelerator is displayed, as you can see in Figure 3.34.

FIGURE 3.34 x
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When it comes to the creation of a local file, this is slightly different from the file type of
worksharing. You have to use the Open dialog box to browse to the Revit Server Network, as
shown in Figure 3.35.

FIGURE 3.35
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In Figure 3.35, we can see two Revit Servers; they are both host servers and accelerators,
meaning that teams from either location can work on each other’s files with relative ease. The
first time a file is opened from a server, the data is cached to the appropriate accelerator. For the
user, the experience should be almost identical to the file-based worksharing method.

In reality, this can sometimes make the performance seem a bit slower, as in some cases you
may be moving and synchronizing data across entire countries or continents.

Your BIM/Revit manager can track file usage and lock central files for periodic maintenance,
backing up, and transmittal from a web-based interface. Knowing the address of the server, you
can view your Revit Server Network, as shown in Figure 3.36. Expanding the folders, you are
able to view and perform administrative tasks to your central file, as shown in Figure 3.37.

& Revit Server Administrator %
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FIGURE 3.37
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The Bottom Line

Create a central file by activating worksharing and dividing the model into worksets. Set-
ting up your Revit project file correctly helps users easily visualize and coordinate their systems.

Master It You are working on a project with a mechanical engineer, a plumbing design-
er, and an electrical engineer. Describe the types of worksets into which the model can be
divided to accommodate the various systems for each discipline.

Allow multiple users to work on the same dataset utilizing local files. Revit MEP provides
functionality to set up your project in a manner that allows users to edit and manage their
systems without conflicting with other systems in the model.

Master It Describe how to create a local file copy of a central file and how to coordinate
changes in the local file with other users who are accessing the central file.

Work with and manage worksets. Working in a project with multiple users means that you
likely will need to coordinate the availability of worksets.

Master It Describe how you would isolate a system in the model so that no other user
could make changes to that system. What is the best way to release a system so that oth-
ers can work on it?

Control the visibility of worksets. Visualization is one of the most powerful features of a
BIM project. Worksets give you the power to control the visibility of entire systems or groups
of model components.

Master It You are facing a deadline and need to add some general notes to one of your
plumbing sheets. Because of the intricate design of the HVAC system, your project file
is very large and takes a long time to open. What can you do to quickly open the file to
make your changes?

Optimize performance with a Revit Server Accelerator. When using Revit Server technol-
ogy, best practice dictates that a Revit Server Accelerator be set up to cache data from the Revit
Server for optimal performance.

Master It When using Revit Server technology, why is it best practice to set an accelerator?



Chapter 4

Project Collaboration

Since engineers and architects started working together on building projects, an integrated
project delivery has been the ultimate goal. The goal of consultants working together as
seamlessly as possible is made more achievable by using a building information modeling (BIM)
solution such as the Autodesk® Revit® MEP 2016 platform. Many are quick to believe that using
a BIM solution automatically means coordination and integration, but the truth is that develop-
ing a building information model is only part of the process. You can build a 3D model and even
put information into it, but it is how this information is shared and coordinated that defines an
integrated project.

Revit MEP enables you to interact with the project model in a way that you can conceptual-
ize the design as a whole, even if you are working on only pieces or parts. You do not have to
work for a full-service design firm to participate in a project that results in a complete model.
Architectural, structural, and MEP engineering systems can all come together regardless of
company size, staff, or location. It is the sharing of computable data that makes for an inte-
grated project delivery. Owners and contractors can also participate in the process. In fact, any-
one who has any input into the design decisions should be included in and considered part of
the project team.

Zooming in from the big picture a bit, you need to focus on your role as a project team
member. You can be an effective player in the process by ensuring that the data you are shar-
ing is usable, accurate, and timely. With a firm understanding of how Revit manages your
information, you can develop some good practices and standards for collaborating with your
project team.

In this chapter, you will learn to do the following;:

Prepare your project file for sharing with consultants
Work with linked Revit files
Coordinate elements within shared models

Work with files from other applications

® & ¢ o

Set up a system for quality control

Preparing Your Files for Sharing

In Chapter 3, “Worksets and Worksharing,” you looked at ways to set up your project file to
allow members of your design team to work collaboratively within their specific design dis-
ciplines. Although one goal is to make yourself more efficient and accurate, you must also
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recognize the importance of setting up and developing the project file in a way that you can eas-
ily share the design with your consultants. It is a good idea to consider whether the workflow or
process you are setting up will have an adverse effect on other project team members.

CONSULTING IN-HOUSE

The process for sharing information among consultants can be applied to your Revit project even
if all the design team members work for the same company. Many full-service firms are finding
it effective to treat the differing disciplines within their organization as “consultants” in order to
achieve integrated coordination. Using this workflow helps reduce inaccurate assumptions that
may occur and provides an atmosphere that encourages increased communication.

A Revit project file does not have to be set up as a central file in order to share it with oth-
ers. If there is no need to establish worksets in your project, you can simply save your file as
the design develops and share it when necessary. This is the simplest type of Revit project file
to share, because there is no concern for receiving a local file by mistake or a file that is not
updated with the most current design changes. As with all files that will be shared among team
members, it is a good practice to name the Revit project file in a manner that clearly indicates
the systems that it contains, such as MEP Model.rvt or HVAC. rvt. This makes linked files easy
to manage and reload when updates occur.

If your Revit file has been set up with worksets, there are other considerations for sharing
the file with your consultants. You should take care to realize that the decisions you make when
setting up your worksets can affect those team members who need to visualize and coordinate
with your design elements.

The first decision comes when you create your worksets. In the New Workset dialog box, you
have the option of naming your workset, as shown in Figure 4.1. The name you choose should
be descriptive so that others will know the types of items included in the workset. Using a
descriptive name is also helpful to your consultants who have the ability to see what worksets
are in your file. The other part of this dialog box offers you the option to make the newly cre-
ated workset visible in all your model views. If you choose not to make the workset visible in
all views, you will have to make it visible in each view that you want to see it in via Visibility/
Graphic Overrides settings.

When you are creating your worksets, you may want to consider the Revit files that you will
be linking into your project. It can be very useful to create a workset for each linked Revit file
so that you can control not only each file’s visibility but also whether a file is loaded into the
project. Because you have the ability to choose which worksets to open when you open your
file, you can determine which linked files will be present and visible when your file is opened.
This can increase your productivity by improving file-opening and model-regeneration times.
It also helps by not having to load and unload the links, which can cause problems with hosted
elements. When you do not open a workset a linked file is a part of, the linked file is still part of
your file; it’s just not visible or “present” in your session.
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LOADED LINKS

When you do not open the workset of a linked file, the link will show as In Closed Workset in the
Manage Links dialog box and in the Project Browser.
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Sheets (Sheet Prefix) Revit [1Fc | CAD Formats | DWF Markups | Point Clouds |
Families
Groups T Reference
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If you open the workset for the linked file, the link will be reloaded. If you close the workset of
a linked file, the Project Browser will show it as unloaded, and the Manage Links dialog box will
indicate it is In Closed Workset.

The makeup of your Revit project template file has a lot to do with the preparation for shar-
ing your file with others. Consider carefully the content that you put into your template. It is
tempting to dump your whole family library into the template in order to have everything right
at your fingertips, but this makes for large files that are not as easily shared. Once you have
worked on a few projects, you will be able to determine what is really necessary to have in your
template file.
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There is no denying that Revit files can get to be very large. Purging any unused items from
your files prior to sharing them is helpful in keeping file sizes to a minimum, but you should
use this feature with caution.

PURGE WISELY!

Do not use the Purge Unused feature in Revit when you are working in a template file. After all,
nearly everything in a template file is “unused.”

Because of the size of the files, sharing them among consultants via email is not a recom-
mended practice. Most people do not have the capacity to receive large files via email. Using
FTP is one of the common practices for file sharing. Also, certain third-party applications are
designed specifically for project collaboration.

It is usually the primary design team that establishes the file sharing means and gives all
teams access to upload and download files. Each consultant should have at least one designated
person to manage the transfer of files for their team. This person should be responsible for
making sure that the most current files have been shared. The frequency of updated files being
posted to the site should be determined early on during a project kickoff meeting (you are hav-
ing those, right?) and can be changed depending on the needs of the project. At a minimum, you
should prepare to post your files once a week during active development. This will keep your
consultants up to date with the progress of your design.

If you have enabled worksharing on your project, it is important that you send your central
file to your consultants, not a local file. This ensures that they are receiving a file with updated
information from all your team members. Consider a workflow that includes having all team
members synchronize with the central file and then creating a new project file by using the
Detach From Central option.

You also have the option in Revit MEP to remove worksets. Your consultants will, of course,
be able to do this for themselves. But remember, if you have used worksets to control object vis-
ibility, the settings will be destroyed if worksets are removed. Of course, you gave the consul-
tants that information at the project kickoff meeting, didn’t you?

Working with Linked Revit Files

Revit MEP not only gives you the power to model and document your design but also enables
you to coordinate with the designs of your consultants directly in your project file. This concept
is not new to the world of digital documentation. It is the same workflow that occurs in 2D CAD:
you receive a file from your consultant, overlay it into your file, and watch as it updates during
the changes to the design.

The difference with Revit is in how much more you are able to coordinate by receiving a
model that is not only a graphical representation but also a database with computable informa-
tion. Some of the terminology is different when working with Revit. Instead of external refer-
ences (X-refs), we call the files that are loaded into our project linked files. The following sections
cover some best practices for loading, managing, and viewing links that are Revit RVT files.
Later in this chapter, and again in Chapter 5, “Multiplatform Interoperability: Working with 2D
and 3D Data,” you will learn about files of other CAD formats.
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Linking Revit Files
When you are ready to bring a Revit file from a consultant into your file, you may want to first
do some maintenance on that file. Copy the file you have received to your network. If the file

you are receiving is a central file, you should open the file by using the Detach From Central
option, as shown in Figure 4.2.
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As mentioned earlier, you have the ability to remove worksharing from a project file when
using the Detach From Central option. The dialog box shown in Figure 4.3 provides options for
preserving worksets or removing them from the file.

FIGURE 4.3 x

Detach Model From
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What do you want to do?

=» Detach and preserve worksets
You can later save the detached model as a new central model.

<» Detach and discard worksets
Discards the original workset information, induding workset visibility. You can later create new
worksets or save the detached model with no worksets.

Use caution when removing worksets from a file because this action can affect the visibility
and display of many types of elements. When you are using a consultant’s model, this may be
less important if you are concerned only with having that model linked into yours. Preserving
the worksets, however, may make it easier for you to control the visibility of systems or specific
components within the linked file. You may consider purging unused content and deleting
views from a linked file to reduce file size; however, you will have to repeat the process each
time you receive an updated version of the file.
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When you open a file with the Detach From Central option selected, the file becomes a tem-
porary project file stored in your computer’s RAM. You are the owner of all the worksets in the
file if you have chosen the option to preserve worksets. Once the file is open, you can save it to
the location from which you will load it by using the Save or Save As command. The project
isn’t an actual file yet, so Revit expects you to provide a location and filename. Using the same
location as your project file will make it easier to manage all your linked files. If the filename
does not suit your standards, you can give it any name you want. However, the location and the
filename that you choose should remain the same throughout the life of the project. It is best
to avoid overwriting a file with the same name by using Save As, so when you download the
file and put it on your network, you may want to rename it prior to opening it. You should also
avoid downloading it directly to the directory in which the working linked file resides, espe-
cially if you are not changing the filename. You do not want to overwrite the linked file before
you get a chance to clean it up.

You then need to relinquish your ownership of all the worksets and synchronize the file
again. This ensures that the file you have received from your consultant is not attempting to
coordinate with local files from another network. If the file you are linking is not a central file,
you do not need to open it because there will be no worksets or local files associated with it,
unless you are opening it to purge items and clean up views.

There is no need to keep an archive of all the files being sent to you. Revit files can be
very large, so keeping an archive will quickly use up storage space. When worksharing has
been enabled in a file, Revit keeps a backup log of the file. The Restore Backup button on the
Collaborate tab allows you to roll back changes to the file. So if you require a previous version
of your consultant’s model, you could ask that consultant to save a rolled-back version of the
file and send it to you. If you would like to keep archived versions of the project, you need to
explore such avenues as cloud storage, external hard drives, or DVD to save storage space on
your network or hard drive. The option you choose can be dependent on cost, length of time
required for storage, and future retrieval methods.

Once the maintenance has been done on your consultant’s file, you are ready to link it into
your file. The first thing to do when bringing any type of file into your project is to make sure
you have the appropriate workset active (if you have enabled worksharing). In a project file with
multiple MEP disciplines, every discipline will need to use the architectural model for back-
ground and coordination, so you should place it on a workset that is common to all users. The
Shared Levels and Grids workset is a good option if you have not created worksets specifically
for linked files. This workset can be visible in all views without causing too much extra work to
control the visibility of other elements within the workset. Let’s first take a look at linking in the
architectural model. Here are the steps:

1. With the appropriate workset active, click the Link Revit button on the Insert tab. Browse
to the location of the file you saved after receiving it from your consultant. The position
of the linked file is crucial to coordination, so before you click Open, you must determine
the positioning of the file by using the Positioning drop-down menu at the bottom of the
Import/Link RVT dialog box. Figure 4.4 shows the six options for placing the linked file
into your project.
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Manual - Base point
Manual - Center

Manual - Origin ‘

The three Manual options allow you to place the model into your file manually by using
an insertion point from the origin, the center, or a specified base point of the file you are
linking. These options are rarely used because they require you to locate the model man-
ually, which can be difficult without a common reference point in both files.

The automatic options are more commonly used, and each has a specific function:

Auto — Center To Center This option links the file from its center point to the center
point of your file. The center point is determined by the location of the model objects
within the file—the center of the overall extents that those objects define in each file. This
option should be avoided unless you and your consultants have a coordinated center
point and the makeup of the model will prevent that point from changing.

Auto - Origin To Origin This is the best option to use. The origin of the linked file will
not change if the model changes size or shape, or even if building geometry is moved or
rotated, so you will be able to stay coordinated with the building when major position
changes occur.

Auto - By Shared Coordinates This option is only valid when shared coordinates have
been established already. As a rule, Origin to Origin is much more likely and appropriate.
This is most commonly used on projects that have multiple buildings because it enables
you to keep the relationship between buildings coordinated. If you link in a file that is
using shared coordinates, you can use the same coordinates for your file. This is only rele-
vant when someone has taken extra steps to establish a shared coordinate system. Routine
linking of consultant models at this stage of the book is outside this chapter’s scope.

81
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Always take care when linking a Revit file and make sure you check the positioning set-
ting. Revit will remember the last setting you use in the current session. When Revit is
started, the default is Auto — Origin to Origin.

. Once you have chosen a positioning option, you can choose options for loading worksets,

similar to when you open a file that contains worksets. Just click the pull-down menu
next to the Open button. You can open all the worksets or specify which ones you want. If
you specify worksets to be open, they are the only ones whose components will be visible
when the file is loaded.

. Click the Open button to link the file into your project. The linked model file then

appears in your file at the location determined by your Positioning option. If you selected
a Manual option, you will need to click a position in the view window to place the linked
model.

. Once the linked model is in the correct position, you want it to stay there, so before you

do anything with the linked model, choose one of the following options to prevent users
from accidentally moving the whole building when clicking and dragging items during
design.

¢ Select the linked model, click the Pin button that appears on the Modify panel of the
Modify | RVT Links tab, and choose the Select Pinned Elements toggle (1) on the sta-
tus bar, as shown in Figure 4.5.

¢ Alternatively, click the Select Links toggle (2), as shown in Figure 4.5. Either way, you
are now unable to select and move the linked file.

. Repeat steps 1 through 4 for all the files you need to link into your project. Once you have

all your Revit links in place, synchronize your file with the central file, or if your file is
not using worksharing, simply save it.
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Using Shared Coordinates

Using shared coordinates is a useful way to keep several linked files in the correct location and
orientation within your project file. The key to using shared coordinates is establishing which file
will determine the coordinate system, and generally speaking, it is the architect’s responsibility
to do this. Every Revit project has two coordinate systems: one determines the project coordi-
nates, whereas the other defines the real-world coordinates.

The project base point of a project can be viewed by turning on its visibility, which is located
under Site in the Model Categories tab of the Visibility/Graphic Overrides dialog box (see
Figure 4.6). Site is an architectural category, so you must set the filter list to view Architectural
categories.
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When you select the project base point indicator in a view, you see the coordinates estab-
lished for the Revit project. The N/S, E/W, and Elevation coordinates can all be set by selecting
and editing the value along with the angle of the project relative to True North, as shown in
Figure 4.7.

The paper clip icon allows you to move the entire project or to move only the project base
point location. When the project base point is “clipped,” moving it is the same as using the
Relocate Project tool. This does not affect the model as it relates to the project coordinates,
but if you are using shared coordinates to align with linked files, it will cause you to be out of
alignment.

FIGURE 4.7 Project Base Point
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Moving the project base point when it is “unclipped” causes the project coordinate system
to move in relation to the model. This changes the shared coordinates of the project base point.
However, the shared coordinates of the model components do not change.
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So, although you can, it doesn’t mean you should, and it’s better to leave the project base
point alone.

You can acquire the coordinates of a linked file. Use the Coordinates tool on the Project
Location panel of the Manage tab, and select the Acquire Coordinates option. This allows you
to select a linked file in the drawing area and sets your project coordinates to match those of the
linked file. Figure 4.8 shows the settings for a project prior to acquiring coordinates (left) and
the settings after the coordinates of the linked model are acquired (right). This ensures that both
files are working off the same coordinate system and is of most use when collaborating in soft-
ware such as the Autodesk® Navisworks® program. Notice that the project base point is in the
same location in relation to the building geometry.
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FIGURE 4.9
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The survey point of a project can be used to create a relationship to survey data that is also
more often than not in a Revit format to begin with and is established by either the architect
or the civil engineer. The survey point can be made visible by using the Visibility/Graphic
Overrides dialog box, as shown in Figure 4.9. However, if the survey point has not been set up
yet by the architect or the civil engineer, there is no advantage to doing so until you have word
from them. Once the survey point has been established, using it allows the engineer or archi-
tect to export using shared coordinates later so their model can be coordinated in software like
Navisworks more easily.
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The survey point appears as a triangle in the view. Moving a “clipped” survey point changes
the position of the shared coordinate system in relation to the model and the project coordinate
system. So, for example, if you have your survey point set to 0,0,0 and you move it, you are
changing where 0,0,0 is located in your project. This will affect the location of your model com-
ponents in relation to a linked file with which you are sharing coordinates.
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Moving an “unclipped” survey point moves the point. The icon becomes a marker that no
longer indicates the shared coordinate origin; it indicates its position relative to the origin of the
shared coordinates system. The shared coordinate origin remains fixed. The survey point icon
starts reporting coordinates that indicate its X/Y offset from that origin in relation to the shared
coordinate and project coordinate systems. This does not change the shared or project coordi-
nates of the model—it simply changes the location of the survey point icon. This allows you to
move it to identify a specific location established by a linked file without changing the shared
coordinates.

Managing Revit Links

Throughout the design process, you will want to keep up with the many changes occurring in
the files you have linked into your project. Revit does not always automatically update your

file with changes made in the linked files. The only time updates occur automatically is when
you open your project file and the linked files have been updated by their source. If you are in a
working session of Revit and one of your linked files is updated, you will have to reload the link
manually to see the update.

Updating files from your consultants requires the same process you used when you first
received the files, except you do not have to insert them into your file again. Download the new
file from your consultant, and apply the maintenance procedures discussed in the previous sec-
tion. Be sure that you overwrite the existing file with the new one and avoid changing the name.

After you have updated the files in your project folder, you can open your project file. If you
are working in a local file, you should synchronize it with the central file as soon as it is finished
opening. This will ensure that the central file contains the updated linked file information.

Sometimes new versions of the files you are linking become available while you are working
in your project file. If another user has updated the linked files and synchronized them with the
central file, when you synchronize with the central file you will also get the reloaded, updated
link file (which is a workflow new to Revit 2016). This standardizes the workflow for loading
and unloading links for all users when they synchronize.

COMMUNICATION

Working with Revit should increase the amount of communication between design team members.
If you update a linked file, let your team members know. You can do this by creating a view in your
project that is used by everyone, placing notices in that view, and then setting that view as the
starting view for the project. This way, when someone opens the project, that person can immedi-
ately read what needs to happen next to be totally up-to-date.

To reload a linked Revit file, click the Manage Links button on the Manage tab (it’s also avail-
able on the Insert tab or by right-clicking on the link file in the Project Browser). This opens
the Manage Links dialog box, which enables you to manage the files you have loaded into your
project (see Figure 4.10).

The Revit tab of the Manage Links dialog box lists all the Revit files linked into your file.
Here, you can determine whether the file is an attachment or an overlay. This is the same behav-
ior found in external references in the Autodesk® AutoCAD® platform. An attachment will need
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to travel with the file, whereas an overlay is only for the file to which it is linked. If a file you are
linking in has other Revit files linked to it as overlays, you will see a dialog box indicating that
the overlaid files will not link into your file when you load or reload the link. This allows you

to have the architectural file linked into your file, and your file linked into the architectural file,
without duplicating either model. In other words, your file does not come back to you when you
link in the architectural file. The default setting for linking files is Overlay, because this is the
best choice.

FIGURE 4.10 a
Manage Links dialog Revit |IFc | cAD Formats | DWF Markups | Point Clouds |
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The Save Positions button in the lower-left corner of the dialog box is used when your
project is using shared coordinates. If you move a link within your project, you will receive a
warning dialog box with options for saving the new location, or you can use the Save Positions
button.

Other buttons allow you to unload, reload, and remove links from your file. Once a link
is removed, you cannot get it back by using the Undo feature; you will have to load the
link back into your project. The Reload From button allows you to reload a link that may
have moved to a new location on your network. You can even replace it with a different file
altogether.

You can also use the Project Browser to manage the files linked into your project. All linked
Revit files are listed at the bottom of the Project Browser. Right-clicking a link provides a menu
with quick access to link-management tools, as shown in Figure 4.11.

Notice that one option is Select All Instances. You can have multiple instances of a linked file
in your project by selecting the link in the drawing area and copying it.
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Controlling Visibility of Revit Links
When a Revit file is linked into your project, it is treated as one element—a linked model.

Linking in the architectural model does not mean that you now have walls, doors, and windows

in your project model. The model is seen as a single linked file. You do, however, have control
over the visibility of the individual components that make up the linked model as well as the
entire link itself.

When you link in a Revit file, a new tab appears in the Visibility/Graphic Overrides dia-
log box. This tab lists the linked Revit files and allows you to turn them on or off. If you have

multiple copies of a link, they are listed beneath the name of the link, as seen when you click the

+ next to the link name. Each copy can be given a unique name for easy management. There is

also a check box for setting the link to halftone. (This is not necessary for views set to mechani-
cal, plumbing, or electrical disciplines because Revit automatically applies halftone to the archi-

tectural and structural elements in these discipline views.) This tab is useful for turning links
on or off in views as needed during design, and the settings can even be applied to view tem-
plates. The Underlay column allows you to display the linked file as defined by the Halftone/
Underlay settings established for the project.

You can also control the visibility of components within the linked Revit file. By default, the
components in the Revit link will react to the settings for visibility that you apply to your view.
So, if you were to turn off the Doors category in your view, the doors in the Revit link will also
turn off in that view. The same is true for any overrides you may apply for line weight or color.
Figure 4.12 shows that this behavior is indicated in the Visibility/Graphic Overrides dialog box
as By Host View.

Clicking the By Host View button for a link opens the RVT Link Display Settings dialog box.

This is similar to the Visibility/Graphic Overrides dialog box, but it is specific to the selected
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Revit link. The first tab of this dialog box allows you to set the visibility of the link. You can set
the link to By Host View, By Linked View, or Custom.

FIGURE 4.12 zl
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Display Settings
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If you choose By Linked View, the option to select a view from the Revit link becomes active.
Choosing a view from the linked project will set the link to be displayed in your view with all
the settings from the view that resides in the linked file. You do not have access to the views
contained in a linked file, but you can set the link to display in your file the same way as it
appears in those views. This means that the link will display as set in that view despite any vis-
ibility settings in the host view. For example, in Figure 4.13 you see a view with the grids turned
off in the host view, yet they are displayed because the linked file is set to display from a linked
view where grids are displayed.
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It is not likely that your consultants will have set all their views in a manner that matches
your preferences for seeing the link, so you also have the Custom option for visibility. Selecting
Custom activates all the setting options on the Basics tab of the RVT Link Display Settings dia-
log box. With this option, not only can you choose a linked view, but you can also determine
other behaviors for the display of the link. You do not have to choose a linked view if you want
to control the visibility of only certain components. The Custom option is the same as access-
ing the Visibility/Graphic Overrides dialog box, but for the link only. Once you have selected
Custom, you can use the other tabs in the dialog box to set the visibility of the components
within the link. When you select a tab, the items are grayed out. You must set that specific cat-
egory to Custom as well by using the pull-down at the top of the tab, as shown in Figure 4.14.

FIGURE 4.14 Visibility/Graphic Overrides for Floor Plan: 0 - Mech e x|
Setting a model Model Categories | Annotation Categories | Analytical Model Categories | Imported Categories | Fiters RevitLinks |
category within a
hnked ﬁle to Visibility Halftone Underlay Display Settings
Custom E.1] Arch Link Model.rvE O m Custom |
X
Basics Model Categories |Amuﬁanun Categories | Analytical Model Categories | Import Categories |
Model categories:
¥ Show model categories in this view If a category is unchecked, it will nat be visible.
Filter list: | <show all> -
Projection/Surfa Cut -
Visiity ZCEEH one) | pettoval | =
] Air Terminals [ By View
- [ Areas O By View
[ ] Cable Tray Fittings O By View
(-] Cable Trays O By View
Ll ]l cle. [1 B

After setting a category to Custom, you can control the visibility of any Revit model cat-
egory within the linked file. You can control elements in the Model categories as well as the
Annotation categories and any Import items such as linked CAD files. Figure 4.15 (top) shows
that the Grids category is displayed because the linked structural file is set to display by a
linked view, even though the Grids category is turned off for the host view. A better solution
might be to set the structural link to a Custom display and turn off all Annotation categories
except for Grids, as shown in Figure 4.15 (bottom). Doing this will automatically keep the archi-
tectural link as a halftone and will display only the items you want to see in your view.

In this example, the Custom option allows for the display of grids without displaying other
architectural annotations, such as dimensions.

You can also control the visibility of worksets within a linked Revit file. If you choose not
to make your worksets visible in all views within your project, your consultants will have to
turn on the visibility of the workset when your file is linked into their project file. The visibility
of a workset can be turned on or off by accessing the linked Revit file in the Visibility/Graphic
Overrides dialog box. Clicking the button in the Display Settings column for the linked file
opens the RVT Link Display Settings dialog box. This dialog box has a tab for controlling the
visibility of worksets, as shown in Figure 4.16. Setting the display to Custom allows you to turn
on or off the visibility of any worksets within the linked file.

The output of Revit documents can vary depending on the type of printer you use. The most com-
mon issue is that the automatically halftone-linked files do not print darkly enough. Revit enables
you to control how dark the linked files appear and print. You can find the Halftone/Underlay set-
tings on the Additional Settings menu located on the Manage tab, as shown in Figure 4.17.



90

CHAPTER 4 PROJECT COLLABORATION

FIGURE 4.15
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@ Real World Scenario
LINKED FILES FOR PROJECT TEMPLATES

Mike has been tasked with creating his company project template. He works for an HVAC design
firm and has to link the architectural and structural models whenever the company does a project.
His various consultants do things differently, but there are some common settings he would like to
add to his template to improve efficiency. Because every project is different, he cannot have linked
models in his template file. Or can he?

Mike decides to link some dummy files into his template to act as placeholders for the actual models
he will receive from his consultants. He creates a file called Arch. rvt and one called Struct.rvt
and links them into his template. The files are empty, so they do not add alot of bulk to his template,
but they do give him the ability to create visibility settings for linked files in his view templates.

When Mike uses his template to start a project, he can overwrite his placeholder links with the
actual models received from his consultants by using the Reload From option in the Manage Links
dialog box, and all of his view settings will remain.

In the Halftone/Underlay dialog box, you can turn off the automatic halftone of linked archi-
tectural and structural files by deselecting the Apply Halftone check box. You can also override
the line weight of a background Revit link. If you are using an underlay in your view, you can

change the line pattern to any of the patterns you have loaded in your project. Figure 4.18 shows
the Halftone/Underlay dialog box with sample settings applied.

The Brightness slider on the bottom half of the dialog box lets you manually adjust the

percentage of halftone applied to all halftone items in the view, both linked items and those in

your model. Notice that only the elements within the link that are halftone are affected.
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The plumbing fixtures are part of the linked architectural model, but because they are not an
architectural or structural category, they are not affected by the adjustment. The settings that
you use apply to the entire project, so you need to set them only once. This is a helpful tool for
getting your documents to print properly.

FIGURE 4.18
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PRINTING OPTIONS FOR HALFTONE

You can use the Replace Halftone With Thin Lines option in the Print Settings dialog box if you
choose not to adjust the halftone settings in your model but still want darker backgrounds.

Coordinating Elements within Shared Models

One of the key benefits of using a BIM solution such as Revit MEP is that you can see changes in
the design more readily, because you see more of the other disciplines” work than you would in
a traditional workflow. The ease of cutting section views and inspecting the model in 3D allows
you to notice what is going on, not only with your design but also with the project as a whole.
You may not have time to look over the model inch by inch, though, so there are some items that
you can monitor to see whether the design changes in a way that affects your systems.

Monitoring Elements

Revit gives you the capability to monitor certain elements within a linked file in order to be
made aware of any changes. This functionality is limited to a few categories because, after all,
you wouldn’t want to know every time the architect moved a chair or changed the color of a
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door. The types of components that can be monitored are items that, if changed, could have a
major effect on your design, especially late in the game. The architectural categories that can be
monitored for coordination are Levels, Grids, Columns, Walls, and Floors. These items are often
hosts for components in your model, so being aware of changes to them provides you with a
higher level of coordination.

The Copy/Monitor function in Revit not only lets you monitor an element of a linked file but
also allows you to create a copy of that element within your file. The use of face-hosted elements
eliminates the need to copy items just so that you can have something as a host. There are items,
however, that are important to coordinate, such as levels and grids.

Your template file may contain levels in order to have preset views, but your levels will not
likely be the same on every project. After pinning a linked file in place, the next thing you
should get into the habit of doing is monitoring the levels. This mainly applies to the architec-
tural link, because architects are the ones who will determine floor-to-floor heights. If your file
has fewer levels than the linked file, you can copy the additional levels, and they will then be
monitored automatically.

To coordinate with the levels in the linked file, follow these steps:

1. Open an elevation or section view of the model to see the level locations.
2. Align your levels to the levels in the linked file.

3. Set your levels to monitor the levels in the link by clicking the Copy/Monitor button on
the Collaborate tab. Your two options for monitoring are selecting items in your file and
selecting a link.

4. Click the Select Link option, and click the link in your view. The Ribbon changes to dis-
play tools for Copy/Monitor.

5. There is no need to copy levels that already exist in your file, but you will want to modify
them to match the name and elevation of the levels in the linked file before actually start-
ing the monitor process.

If you are prompted to rename corresponding views when changing a level’s name, it is
best to choose not to. Otherwise, the names of your views may not be correct according
to your standards. If you do not change the level names, then your levels will monitor the
linked levels relative to their location. Figure 4.19 shows an example of project levels and
linked file levels.

6. Click the Monitor button on the Tools panel, and select the level you want to coordinate
with the linked level.

7. Select the linked level that you want to monitor.

8. Repeat steps 5 and 6 for each level that you have in your file. If there is a level in the link
that does not exist in your file, you can use the Copy button to create a monitored copy of
the level.

It is not necessary to monitor all levels because your consultant’s file may contain lev-
els for use as coordination points rather than for view creation. Only monitor levels for
which you need to create views or to which you need to associate your model compo-
nents, as shown in Figure 4.20.
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When you use the Copy button in the Copy/Monitor function, the copied element will
automatically monitor the object from which it was copied, so there is no need to repeat
the monitor process after copying an item.

9. After you have finished coordinating your levels to the levels within the linked file, click
the Finish button on the Copy/Monitor tab. You can now create views for any additional
levels you may have added.

You also have the ability to copy/monitor certain MEP elements within a linked file. Clicking
the Coordination Settings button on the Coordinate panel of the Collaborate tab opens the dia-
log box for establishing how MEP elements will be copied from a linked file into your project.
Figure 4.21 shows the dialog box. These settings are specific to the current project.

FIGURE 4.21 20
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You can apply the settings to any of the linked files within your project by using the drop-
down at the top of the dialog box, shown in Figure 4.22.
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There are three choices for the Copy Behavior setting of each category, as shown in
Figure 4.23. Items can be batch copied, which will allow for multiple elements of the category to
be copied. Items can be copied individually, or you can choose to ignore a category.

If you are applying settings for new links, the Mapping Behavior setting, shown in Figure 4.24,
is set to copy the original components by default. If you have selected a specific linked file, you
can set the mapping behavior for a category as long as the category is not set to be ignored.
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When you choose the Specify Type Mapping option, the Type Mapping settings appear
beneath the category in the list at the left of the dialog box. When you click the Type Mapping
option below the category, the dialog box changes to show the items in that category that are
in the linked file and a column for defining what family within your project to use, as shown
in Figure 4.25. Be sure to map to a family that has the same insertion point and hosting option.
Families with different insertion points will cause undesired results when mapped. You cannot
map a ceiling-hosted family to a face-hosted family.
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The Linked Type and Host Type buttons allow you to view the Type Properties dialog box for
the selected families. You cannot make changes to the properties, but you can see them in order
to determine the right families to use, as shown in Figure 4.26.
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The main purpose for monitoring items is to be alerted when a change has been made to
them. This is done by the Coordination Review feature within Revit. When you update your
linked files, if there is a change to an item that you are monitoring, a warning will appear
during the loading of the link, as shown in Figure 4.27. This warning lets you know that a
Coordination Review needs to be executed. You can ignore this message, but just because
you can, should you? Who will do the coordination review? This should be part of one team
member’s role in the project.

FIGURE 4.27
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Responding to Change Alerts

To perform a coordination review, you can click the Coordination Review button on the
Collaborate tab. The command is also on the Modify | RVT Links tab that appears when you
select a link that has monitored elements in the view window. The dialog box that appears con-

tains a list of the issues that require coordination, as shown in Figure 4.28. Expanding each issue

will reveal the specific elements involved.

El-- New/Unresolved

(= Levels
[=]- Maintain Name
+]-- Mame changed
- MName changed
aintain Position
wed by 0' - 6"
rch Link Model_Rev_A.rvt : Levels : Level :
Parapet : id 175457

- Levels : Level : Parapet : id 5890188 fccept dif-Felrence
love Level Parapet’

Postpone

e
=]

Show:
’]7 Postponed ¥ Rejected << Elements

How do T use Coordination Review?

Show | Create Report | OK | Apply | Cancel |

The Action column provides four options for dealing with the coordination issue:

Postpone If you choose to postpone the action, Revit will warn you of the issue each time
your file is opened or the linked file is reloaded, until another action is taken.

Reject This option should be accompanied by a description in the Comment column to the

right. If a change has been made that you must reject because of design constraints or for
some other reason, you can select this option. When you send your file to your consultants,
they will receive a notice that a coordination review is required and will see that you
rejected the change. Most likely, a change that is rejected will generate communication
between team members, but adding a comment is a good way to document the action
choice. Comments will be visible to other team members only when the Create Report
feature is used.

Accept Difference This choice can be used when the change does not affect your design and

when the effort to coordinate outweighs the benefit. For example, you may be monitoring a
wallin the architectural model to see whether it moves. On the day the project is due, you

receive an alert that the wall has moved 1/32”. You could decide that the change is insignificant

enough to allow for the difference.
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Modify Your Element To Match The Item It Is Monitoring In Figure 4.29, you can see the
result of using the Move Level option (shown earlier in Figure 4.28) so that the level is coordi-
nated with the linked Revit model. When this option is chosen, the change is made automati-
cally by Revit. Select the option, and click the Apply button to see the change occur. If you are
not in a view that shows the items requiring coordination, you can select one of the items in the
list and click the Show button in the lower-left corner. Revit will search for a view that shows
the selected item and open that view.

If the change made has too great an effect on your model, you can simply undo the action
and revisit the Coordination Review dialog box to select another action.

FIGURE 4.29 Parapet -

Level adjusted by P3a5;-a gt

coordination review o Roof "
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Level moved using
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24'T!I" 2W" 240" - 240" “

Reconciling Hosting
Face-hosted families allow you to attach your components to the 3D faces within a linked file.
When the host of one of these types of families is deleted, the family will remain in the model,
but it loses its host—it will no longer be associated with the linked file. This behavior can cause
objects within your model to be floating in space when they should be attached to a surface. A
common reason for an element losing its host is that the host was deleted and redrawn elsewhere
instead of just being moved. For example, if you have some air terminals hosted by the face of a
ceiling and the ceiling needs to move up, the architect may delete the ceiling and create a new one
at the new elevation. This would cause your air terminals to be floating below the new ceiling.
Reconcile Hosting allows you to identify and deal with any families that have lost their host.
Click the Reconcile Hosting button on the Coordinate panel of the Collaborate tab to access the
Reconcile Hosting palette, shown in Figure 4.30.

FIGURE 4.30
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You can dock this palette to the interface, have it float, or share the Properties palette/Project
Browser window as a tab. When the palette is active, any objects that are listed will be green in
the model view. You can click the Graphics button on the palette to change the visual display of
orphaned elements when the palette is active.

The Show button allows you to locate an item selected from the list if it is not readily visible
in the current view. The Sort button lets you sort the list either by the linked file and then the
categories or by the categories and then the linked file.

You can right-click an item listed in the palette and choose the option to delete it or choose
the Pick Host option, which allows you to place the element on a new host. However, if you pin
the elements in place first, you can pick a new host without altering their actual position.

Maintaining Project Coordination

Proper setup of your project file is essential for maintaining coordination throughout the life of
the project. You can find an example of how to do this on this book’s web page at www. sybex
.com/go/masteringrevitmep2016. Create a project file by following these steps:

1. Open the RMEP2016_Ch04_Dataset.rvt file, which can be downloaded from this book’s
web page. (Also download the RMEP2016_Sample_Architecture.rvt file)

2. Open the MH - Level 1 floor plan view and click the Link Revit button on the Insert tab.

3. Select the RMEP2016_Sample_Architecture.rvt file, and choose the Auto — Origin To
Origin positioning option. Click Open.

4. Select the linked model in the active view window, and click the Pin button on the
Modify | RVT Links tab.

5. Open the North elevation view.

6. Use the Align tool to align the Roof level in your model to the ROOF level in the
architects file.

7. Click the Copy/Monitor button on the Collaborate tab. Click Select Link.
8. Click the linked model in the view window.
9. Click the Monitor button on the Copy/Monitor tab.

10. Click the First Floor level at the right, and then select the First Floor level of the linked
model.

11. Repeat step 9 for the Roof level.
12. Use the Copy option for the floor levels Second Floor and Raised Second Floor.
13. Click the Finish button on the Copy/Monitor tab.

Working with Files from Other Applications

Revit files are not the only type of files that you can link into your project. The Revit platform
is compatible with many types of CAD formats as well. As you move into using a BIM solution
for your projects, try to use CAD files as little as possible. A large number of linked CAD files in
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your project can cause the project file to perform poorly. Choose the files that will save you time
overall on the project. The following CAD file formats can be linked into Revit:

¢ DWG

¢ DXF

¢ DGN

¢ ACISSAT
¢ SketchUp

You can also insert image files and link Design Web Format (DWF) markups. There are two
options for bringing non-Revit file types into your project: you can link them or import them.
Linking is the preferred method, because a linked file will update as the file changes without
you having to repeat the process of inserting the link. Linked CAD files will show up in the
Manage Links dialog box with options for the pathing of files, reloading, and unloading. If you

share your project that contains CAD links with a consultant and you do not give the consultant

the CAD files, Revit will display the CAD link as it last appeared in your file.

LINKING VS. IMPORTING

Be careful when choosing to import a file rather than link it. When you import a file, the graphics
are not the only thing brought into your project. All text styles, line styles, layers, dimensions,
and so on are brought in as well. This can really clog up your project file and impede performance.
Imported files will not update when changes are made. New versions of imported files must be put
into your project manually as well.

Linking CAD Files

Because there is no Revit version for civil engineering, it is likely that you will receive the files
from your civil engineering consultant in some type of CAD format. The process for linking
these types of files is similar to linking a Revit file:

1. On the Insert tab, click the Link CAD button. The dialog box for linking a CAD file,
shown in Figure 4.31, contains more options than the one for linking a Revit file.

The check box in the lower-left corner provides the option for linking the file to the
current view only. This will keep you from having to turn off the CAD link in any
other view.

The Colors drop-down list, shown in Figure 4.32, allows you to invert the colors of the
CAD file, preserve them as they exist, or turn all the linework to black and white.

2. Determine which layers of the CAD file you want to load. This is similar to loading spe-
cific worksets of a linked Revit file. You can load all the layers within the file, you can
load only those that are visible within the drawing (layers that are on and thawed), or
you can specify which layers you would like to load, as shown in Figure 4.33.
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Choosing the Specify option will open a dialog box from which you can select the desired
layers within the CAD file to load.

You can remove layers within the linked CAD file after the file is in your project by clicking
the link in the view window and clicking the Delete Layers button in the Import Instance

panel.
FIGURE 4.31 1%
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3. Define the units for the file to be linked in. The Auto-Detect option, shown in Figure 4.34,
causes Revit to use the unit setting that the CAD file is using. This can lead to inaccuracy
if the units in the CAD file are not defined. The units can be modified in the properties of
the linked CAD file after it is placed into the project.

FIGURE 4.34 ™ Current view only Colars: [Preserve - Pasitioning: [Auto - Origin to Origin
Import Units options Layerstevels: [ 7] Place at: [0 -Eniry Level
for a linked CAD file Import units: |Auto-Detect 1.000000 [V Crient to View
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4. Position the CAD file. The positioning options for a linked CAD file are the same as for a
linked Revit file. If you are using shared coordinates for your project, these coordinates
need to be communicated to the civil engineering consultant in order for the site plan to
align properly. If not, you can place the CAD file manually to line up the graphics.

Typically, the architect will provide a building outline to the civil engineering consultant
that will appear in the linked site plan and will handle the establishment of shared coor-
dinates. Whatever method is chosen, be sure to pin the link in place to prevent accidental
movement. The Orient To View check box in the lower-right corner will position the file
appropriately based on your view orientation, either Plan North or True North. When
creating sections or elevations in CAD, you are often doing so in the plan orientation of
the file. Revit will rotate the plan of the CAD file into alignment in a section or elevation
view if this option is selected. If only the current view is chosen, then this option is On by
default.

If you choose to use the Import option instead of linking, the options for placing the file
are the same except for the automatic orientation to your view. For the sake of good file
hygiene, it is best to link CAD files instead of importing them, especially if you are bring-
ing in the file only for temporary use.

The Correct Lines That Are Slightly Off Axis option helps reduce that pesky warning that
informs you that a line is not completely straight by altering it automatically. This may not be a
wise choice when linking a site plan due to the nature of the linework representing grading and
other site features.

You can link any other type of CAD file needed in your project, such as files that contain
details or diagrams. These types of drawings can be linked to a drafting view that can be placed
on a sheet, or they can be linked directly onto a sheet. To remove a linked CAD file, you can sim-
ply select it in the view window and press the Delete key. This will remove it from the project
completely.

You can view the properties of elements within a linked CAD file by selecting the link and
clicking the Query button in the Import Instance panel that appears when the link is selected.
When you click this, each element within the linked file can be selected, as shown in Figure 4.35.

Selected item within |4y, — & £Z
alinked CAD file w| 9P| - % o
P = f Delete Query
=4 T Layers -
| View | Measure | Create Import [p€tance
T T T
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Clicking an item will open the Import Instance Query dialog box, shown in Figure 4.36, with
information about the selected item. The Delete and Hide In View buttons in this dialog box
apply to the entire category of the selected item.

FIGURE 4.36 Import Instance Query ll
Import Instance
. Parameter Value
Query dialog box e e
Block Name M/A
Layer/Level S-GRIDIDM
Style By Object
rLayer/Level
Delete Hide in view

You can control the visibility of items in the linked CAD file from the Visibility/Graphic
Overrides dialog box. Its Imported Categories tab contains a list of all linked and imported
CAD graphics. The layers within the linked files are listed and can be turned on or off, and their
color, line weight, and line pattern can be overridden.

A NOTE ABOUT NOTES

When you link a CAD file that contains text using an SHX font, the text will take on the font that
your Revit project is using, as defined by the SHXfontmap. txt file (Arial by default). This may
affect the formatting of some notes and callouts within the linked CAD file.

Exporting Your Revit File to a CAD Format

Sharing your project file with consultants who are not using Revit is as important as receiving
their files. You can export your file to various CAD formats to be used by your consultants. The
most important task is to establish the translation of model elements to CAD layers or levels.
This is set up in the export options accessed by choosing Export > Options from the application
menu (see Figure 4.37).

When you select one of the file format export settings, the dialog box that appears contains a
list of all the Revit model categories and their subcategories. You can assign a CAD layer or level
and a color to each category and subcategory depending on whether the elements are displayed
as cut or in projection. Figure 4.38 shows an example.
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Once you have provided a layer and color for the elements that you need to translate to
CAD along with setting the other export options, you can save the settings for future use.

See Chapter 25, “Creating a Project Template,” for more information on establishing export
settings.

With your export settings established, choose the appropriate CAD format from the Export
tool on the Application menu. The Export CAD Formats dialog box provides you with options
for selecting multiple sheets or views to export and the properties of the exported files.

Click the Next button after you have chosen the views or sheets you want to export and a
dialog box appears that will let you browse to the file export location. At this point, you can
determine the software version to use for the export. If you are exporting a sheet view, you
have the option to turn each view on the sheet into an external reference. If you are exporting
a model view, selecting this option will cause any linked files in the view to be exported as
separate CAD files to be used as external references. This option is the default if you choose the
Manual option for file naming.

Figure 4.39 shows the resulting files from an export of a sheet that contains one model view
and a schedule. The highlighted file is the complete sheet. The other files are external references
that make up the sheet. The titleblock is a block entity in the DIWG, and the schedule is linework
and text in the sheet file.

FIGURE 4.39 Name “ |
Files created from
a Revit export
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Notice also that the logo in the titleblock was exported as an image file and an AutoCAD
plotter configuration file (PCP) file was created. This allows anyone you are sharing your files
with to print them the same way you would.

Linking IFC Files

The process for bringing in Industry Foundation Classes (IFC) files changed in the 2015 release
of Revit MEP. In the past you would open the IFC file and then save it as a Revit file in order to
link it into your project. The Link IFC button was also added to the Link panel of the Insert tab,
and it allows you to bring in an IFC file without having to open the file.

When you click the Link IFC button, the dialog box that appears allows you to browse to the
file location. The file types that can be linked are shown in Figure 4.40.

Once you select a file and click Open, Revit will read the file, convert it to a Revit file, and
link it into your project all in one step. The Revit file that it creates is saved in the same location
as your project file. The link to the IFC file can be managed via the Manage Links dialog box, as
shown in Figure 4.41.
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FIGURE 4.40 e
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The file will be a part of the workset that is currently active when the file is linked in, and the
visibility of the linked file can be managed the same way as any other linked Revit file.

When the IFC file is updated, the Revit file created by clicking the Link IFC button is
updated; however, you need to use the Reload From option on the IFC tab of the Manage Links
dialog box to update the link within your project. You cannot simply reload the linked Revit file.

New to Revit MEP 2016 is the ability for IFC files to support the following functionality:

¢ Room bounding—click on Edit Type in the Properties palette and the elements in a linked
IFC can become room-bounding elements in the same way as a linked Revit file.

Dimensions
Snapping

Alignment

* 6 o o

Host face based families
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Using Image Files in a Revit Project

Image files may be necessary for your Revit project to convey design information. They can also
be used for presentation documents to add a more realistic look to the model and for logos on
sheet borders. Sometimes, renovation projects require information from older documents that
are not in Revit or a CAD format. You can save the time required to re-create this information by
inserting scanned images of the documents. As with linking CAD files, be careful not to use too
many images in your project for the sake of model performance.

You can insert an image file directly into any type of view except for 3D views (unless you
are placing a decal). Click the Image button on the Insert tab, and browse to the location of the
image. Images are imported into your project, not linked, and they will travel within the file
when shared. Figure 4.42 shows placing an image into a sheet border. An outline of the image
appears at your cursor for placement.

FIGURE 4.42 u U
Placing an image N e
into a view - .

Once the image has been placed, you can resize it by clicking and dragging the grips at the
corners of the image. The aspect ratio of the image is maintained when dragging a corner point.
To access these grips after placement, just click the image. You can also use the Scale tool to
resize an image to be close to a specific dimension, assuming you know the length of something
in the image. You can place text and linework on top of the image as necessary.

If you need to show an image in a 3D view for rendering (like signage perhaps), you can
bring the image into your file by creating a decal. The Decal button is located on the Insert tab.
Clicking the bottom half of this button allows you to place a loaded decal or access the Decal
Types dialog box, shown in Figure 4.43. You will first need to create a decal type within your
project by clicking the Create New Decal icon in the lower-left corner.

After naming your decal type, you can browse to the location of an image you want to use.
If the image location changes, the decal will no longer display the image in the model. You will
have to choose a new path for the decal type. This means that if you share your file with an
owner or consultant, you need to also share any image files that are included.

The dialog box offers other settings for the rendering appearance of the image. Once the
decal type is created, you can use the Place Decal option on the Decal button to insert the image
into a 3D view. Settings for the decal size appear on the Options Bar during placement. You can
place the decal on any one-directional planar 3D face, such as a wall, curved or straight. It will
appear in the view as a box that defines the size of the image, as shown in Figure 4.44.

The decal will display its associated image only in rendered views. This allows you to show
things such as signs or logos without having to model them. Figure 4.45 shows an example.
Valid image file types for decals are BMP, JPG, JPEG, PNG, and TIF.
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Image files brought into your project will not appear in the Manage Links dialog box. You
can use the Manage Images button on the Insert tab to see what images are used in your project.
Decals will not appear in the Manage Images list. The Decal Types button also appears on the
Manage Project panel of the Manage tab.

If you are working with a client or consultant who is not using Revit, you can still share your
model by using the DWF export capabilities within Revit. You can export your model in either
2D or 3D format depending on your client’s needs. DWF files are similar to PDF files in that they
are meant to be viewed and commented on. The graphics and model geometry cannot be edited
in a way that modifies the actual design model, but they contain more than just graphical infor-
mation. This will help you include your clients or consultants in the BIM process of your project
by providing them with the I in BIM—information.

To create a DWF file for sharing, choose the Export tool from the application menu. There
you will see the DWF/DWEFx option (see Figure 4.46).
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In the DWF Export Settings dialog box, you will see a preview of the current view and
options for the output. If you want to create a 3D DWF, you need to have a 3D view open in the
drawing area when you select the Export function. If your view discipline is set to Coordination,
only the elements within your file will be exported; linked files will not be included in the DWF.
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Setting Options for Quality Control

The topics in this chapter address how you can work with all the files in your project to better
coordinate your design with your consultants. One of the best things you can do is to make sure
that the file you are sharing is as complete and accurate as possible.

You can use some of the core functionality of Revit MEP to set up a system for quality control
and project review. During visual inspection of the project, you may notice issues that require
coordination. Unless you are the person responsible for modeling, there needs to be a workflow
in place to document and manage the issues.

Consider creating an annotation family that acts as a comment tag for whoever may be
reviewing the project. This tag can contain as little or as much information as you want. The
sample shown in Figure 4.47 has parameters to assign a number, date, status, and owner of a
comment along with space for a brief description. The project reviewer can place these tags
throughout the project to point out areas that require modification or coordination. Comments
can be made regarding issues within your file or issues about your consultant’s files. When you
share your file, your consultant can view the comments without the need for you to send addi-
tional information or files.

FIGURE 4.47 Ir EI‘ Ir
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ELEC

Comments

Center all receptacles between windows

These tags can be scheduled, and the schedule can be used as a means of tracking the com-
ments. The schedule also allows users to easily locate the comment tags by using the Highlight
In Model button on the Element panel of the contextual tab that appears on the Ribbon. Figure
4.48 shows a sample schedule of a review comment tag used in a project.

As comments are addressed by users, the tags can be deleted from the views. An empty
schedule would indicate that all comments have been addressed. Another option would be to
add a parameter, such as a check box, to the comment tag to indicate when a comment has been
addressed. Using this workflow can be an efficient and productive method for dealing with
coordination issues during the design process.
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FIGURE 4.48 .
. <Review Comments=
Sample review
comment schedule A | 8 | c | D _ E
Service }lssue_Number: User C Date
ARCH 5 BOB Reswing door 152015
ARCH [+ BOB widen door for accessibility 152015
ARCH 7 BOB Check heights of all doors 152015
ELEC H 1 H SW iCenter all receptacles between windows 1212015 |
ELEC 2 SIMON crease number of lights 122015 |
FIRE 3 SAN iCoordinate spr head to miss terminal 1H2015 |
FIRE 4 SAN iBreak Glass move to suit door swing 1192015 |
HVAC 8 i MALCOLM ordinate terminal to miss spr head 1152015 |
HVAL g FMALCOLM ‘Check duck size [T
PLUMB 10 DAVE i{Reroute piping to miss pan 1/5/2015 |
PLUMB 11 DAVE sure fittings are suitable for accessible we 11542015 |

Another option to consider for quality control is using DWF markups in lieu of the tra-
ditional “red line on paper” method. The benefit of using DWFs is not only in the reduction
of printing but also that your markups, and how they are handled, can be documented and
archived. You can generate a DWF file of multiple sheets, which can be digitally marked up
using the free Autodesk Design Review software that can be installed with Revit or is available
for download from www. autodesk.com. The marked-up DWF sheets can then be brought into
Revit and overlaid on their corresponding sheet views by using the DWF Markup command on
the Insert tab, as shown in Figure 4.49.

FIGURE 4.49 DUCTWORK-SHEET METAL EQUIPMENT-DEVICES

Revit sheet with

DWF markup (YR A A
BT suercvover ue [ DRAWING REGUNRES COMPLETION BEFORE GENERAL ISSIE
ETov ] surrwvover ox | PLEASE ADD MECHANICAL EQUIPMENT LEGEND

(=) RETURN DUCT uF (

Import Symbol
Markup Object Rectangle Cloud 11

Jrme_advanced_sample_project.dwf[shee x| L Edit Type
Dimensions "

Identity Data A
. . Hotes
History uestion

or Review
one

As changes are made to your Revit file, you can edit the properties of the marks from the
DWE, categorizing them as complete. The Revit file can then be exported to DWF again, and the
new DWEF file will show the marks as complete by highlighting them in yellow. The username
and time of completion of the mark are also stored in the DWF file. This workflow enables you
to keep track of who made changes and when those changes were made.
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Using Cloud-based Solutions

When working in an environment where not all involved parties are in the same location, using
a cloud-based solution is an effective way to achieve coordination and collaboration.

Depending on what solution you use, a cloud-based project may allow access to project files
in real time. This eliminates the need to wait for files to be uploaded or shared and ensures that
all parties are using the same files. Users can access the files from anywhere with an Internet
connection. Many cloud solutions offer mobile applications for field use. This means you do
not need to have an installation of the software being used in order to work on the project files.
All of these attributes further enhance a design and construction team’s ability to coordinate
efficiently.

There are many considerations for choosing a cloud-based solution for your projects. What
type of hardware is required to run BIM software such as Revit MEP effectively? Will the hard-
ware be internal to your network, allowing access from outside users, or will it be hosted by
some third-party provider? What are the security risks? How is software licensing handled?
Cloud computing is becoming popular in business and technology, and BIM projects can benefit
greatly from it.

The Bottom Line

Prepare your project file for sharing with consultants. Taking care to provide a clean,
accurate model will aid in achieving an integrated project delivery.

Master It Describe the importance of making worksets visible in all views when your
file will be shared with consultants.

Work with linked Revit files. There are many advantages to using linked Revit files in your
project. Revit provides many options for the visibility of consultants’ files, allowing you to
easily coordinate your design.

Master It How would you turn off a model category within a Revit link while allowing
that category to remain visible in your model?

Coordinate elements within shared models. Revit can alert you to changes to certain model
elements within linked files. Managing these changes when they occur can reduce errors and
omissions later in the project and help keep the design team coordinated.

Master It MEP components within a linked file can be copied and/or monitored. True
or false: You must have the same family loaded into your file in order to monitor it from a
linked file.

Work with files from other applications. Not all of your consultants may use Revit. This
does not mean that you cannot use their files to develop and coordinate your design. You can
also share your design by exporting your file to a format they can use.

Master It Describe the difference between linking and importing a CAD file and why
the linking option is preferred.
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Set up a system for quality control. As a BIM solution, Revit provides functionality to keep
your design coordinated with your consultants.

Master It What functionality exists in Revit that could allow a design reviewer to com-
ment on coordination issues within a project?



Chapter 5

Multiplatform Interoperability:
Working with 2D and 3D Data

This chapter introduces you to the best-practice techniques for importing data into your
Autodesk® Revit® 2016 database, either directly into the project file or via a loadable family.
The chapter also covers which data to use and when in the project life cycle to use it. Selecting
a button that performs the import is easy—but, more important, why are you doing it? And for
that matter, should you be doing it?

Not only can you import 2D information, but 3D solids contained in an import can now be
exploded and manipulated within Revit. These two types of databases are different, so when
you have to start working with other consultants who use other data types, you may experience
issues such as the following:

Loss of Performance Typically, importing any other file format into Revit can be a bad idea.
Yes, it is possible—Dbut like eating too much candy, your file size can start to bloat and slow you
down. Keep your project file lean, and minimize its intake of sweets whenever you can! But,
keeping the food analogy going, cleaning that data—like washing your vegetables—can
produce some excellent results. It’s all in the preparation.

Difficulties Displaying and Printing Data Exactly the Same One of the most annoying

problems is issues with fonts either not being installed or, in the case of legacy DWG data, not

being fully supported and therefore never displaying in the same way as originally

intended.

DataLoss Many issues can cause data loss in your final documentation. Issues include

linked files being unloaded, workset visibility being incorrectly set, and printer driver

problems.

We must ask, is 2D really 2D? An Autodesk® AutoCAD® 2D DWG file can show up in a 3D
view. Do you want it to?

In this chapter, you will learn to do the following;:

¢ Decide which type of data you want to use on a project
¢ Link data consistently and in the correct location

¢ Prepare data prior to import
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2D Data Types

Revit works reasonably well with file types other than native RVT project files. Many of the
issues you will encounter are due to the differences between existing CAD technologies, which
for the most part rely on elements (lines, arcs, and circles), whereas the newer BIM technologies
are founded on object-based parametric databases.

The AutoCAD file format has differences even among drawings that are created in the same
AutoCAD version. For example, virgin AutoCAD can sometimes produce an error when open-
ing a DWG file that was created in any of the vertical products (AutoCAD® Civil 3D®, AutoCAD®
Architecture, AutoCAD® MEP, and so on). When you import this file into Revit, the error shown
in Figure 5.1 is displayed.

FIGURE 5.1 T

Elements Lost On

Import warning I_\ Some elements were lost during import. ActiveX®

~—*— and some proprietary components cannot be
imported.

Try exploding the file in AutoCAD®, or setting

PROXYGRAPHICS to 1.

An additional message is the one displayed in Figure 5.2. Although not exactly an error
message, it should make the user take notice—were you actually expecting objects to be in
AutoCAD model space? If so, then there may be some fidelity issues with the drawing file that
you are trying to link.

FIGURE 5.2 UM x
No Valid Elements

Import detected no valid el ts in the file's Model space.
message Do you want to import from the Paper space?

e |

The issue you face here is whether the “intelligent” data in the AutoCAD file is important or,
for the sake of the Revit project, can you explode (if possible) the objects to base elements that
can be read in Revit?

You have other options if the data has been created in one of the vertical products. You'll
learn about these options in the section “3D Data Types” later in this chapter.

MicroStation 2D DGN

Revit currently supports AutoCAD versions 2000 through 2016, and most MicroStation versions
can be imported. The possible alternatives here include asking originators to use their version
of the Save As command to create an AutoCAD file format that MicroStation can handle, use a
specially developed app to export to IFC, or export as a DXF file.

DXF

The Drawing Exchange Format (DXF) has been around as long as DWG and DGN. It is a well-
recognized and trusted translation medium between primarily 2D formats. The DXF file format
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also supports conversions to file formats 20002010, although care should be taken when using
this format because it is generally regarded as offering the most basic compatibility with the
likelihood of the worst fidelity.

@ Real World Scenario
MULTIPLE FILE FORMATS

From the first kickoff meeting Tony, the lead MEP contractor, knew he would need to take the lead
on project collaboration. Not only was his company responsible for coordinating the design, but
it had to be done digitally. To make things harder, the architectural, structural, and plant designs
were all being completed in software packages other than Revit.

A decision was made: initial building coordination between Architecture and MEP could be done in
Revit, the architecture being linked as an IFC. Although the two other disciplines are important in
their own right and could be linked for display purposes only, the best way forward for total project
coordination is Autodesk® Navisworks®, with each company exporting to an agreed format and a
consolidated model being used at regular team meetings.

2D Data for Standard Details

When importing 2D data for standard details, you may well be linking existing details from
your company library. If you are using the same drafting standards in AutoCAD and Revit, this
process is relatively easy. However, you might want to take a look at your existing company
standards if you are planning on running two systems.

One important consideration is the use of the legacy default AutoCAD SHX fonts, such as
romans.shx or isocp.shx. The great thing about these fonts for AutoCAD users is that you
can control the line weight of the text by using different colors. However, although Revit dis-
plays these fonts, their appearance is governed by the SHXFontMap file, which can substitute a
TrueType font; you cannot adequately control the line weight of text objects in Revit. In fact, the
only way to edit the weight of the text is to make it bold. Again, this process involves editing the
AutoCAD drawing. For example, Revit does not recognize all the codes CAD users have used
for years, such as the degrees symbol (%%d), underline (%%u), and so on. In this respect, the devel-
opers of Revit felt that focusing on more modern font technologies (TrueType fonts) was more
appropriate in the long run than using the much older SHX font approach. Therefore, instead of
using line weight, Revit favors a text output that is consistent with most other word processing
software.

Thus, in order to use Revit and AutoCAD and have your output identical, you need to change
your AutoCAD fonts to TrueType fonts. This has been a hot topic for many people implement-
ing Revit. Once you get past the shock that this is required and that drafting standards need
to change, the actual conversion process can be automated in AutoCAD. Of course, there will
become a time when all your standards have been thoroughly converted to Revit and there will
be no need to keep the two systems going.

When you import a file into Revit, you must ask yourself the following questions:

& Will this be used in more than one view?

¢ Isthefilelikely to be updated in other places (perhaps referenced by different projects,
Revit and otherwise)?

117
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¢ Canthe drawingbe exploded after it is imported? Note the term imported. If a drawing is
linked, it cannot be exploded or bound like an X-ref or a linked Revit file. However, using
the Import button in the Manage Links dialog box does create this bound condition avail-
able in AutoCAD.

Also worth noting is that when exploding an imported object, you have two options: Partial
and Full. A partial explosion turns the result into the highest level of lines, circles, arcs, and text
while respecting the existence of blocks, which can be partially exploded again. A full explosion
reduces the imported drawing into its simplest representation of lines, arcs, circles, and text.
Text becomes single lines of text rather than retaining any multiline settings, regardless of the
explosion type. Entities not recognized by Revit—points, for example—are not translated and
are lost in the explosion process.

When importing or linking into a plan, section, or elevation view, the drawing will show up
in multiple views unless you select the Current View Only check box in the Import dialog box.

See Figure 5.3.
FIGURE 5.3 21
Current View Only tookcin: [ | Everdses 5] @ B X El vew -
option L= = |-| Dotemocified [-|Tpe [~ sz [PV
EP.MEPZOlG_ChOE_Eevaﬁanast‘dwg 15/11/2010 23:48  AutoCAD Drawing
P.MEPZO].G_ChOE_EEvaﬁunNurmdwg 15/11/2010 23:47  AutoCAD Drawing

[EP2016_Ch05_ElevationSouth.dwg 15/11/2010 23:47  AutoCAD Draning
[EP2016_Ch05_ElevationiVest.dug 15/11/2010 23:47  AutoCAD Draning

2dwg 15,

orplan

EP2016_Ch05_FloorplanLevel03.dwg  15/11/2010 23:47  AutoCAD Drawing
FSirMEP2016_Ch0S_FloorplanRoof.dwa 15/11/2010 23:47  AutoCAD Drawing

istory

Documents.

¥ current view only

4| | |
File name: |RMEP2016_Ch05_Floorplant eveld 1.dwg =

My Network.
Fies of type: [DWG Fies (*.dwa) |

Colors: [Black and White ¥ Positioning: [Auto - Origin to Origin =l
LayersiLevels: [al - |

Place at: [Level |

Importunits: |Auto-Detect ~ || 1.000000 I | Brient b Yiew
Tooks v [V Correctlines that are slightly off axis Open Cancel |

If the view you are using is either a drafting or a legend view, the Current View Only check
box is grayed out, because these views are only 2D.

When importing a file for use as a detail, positioning generally is not as important as when
importing an overall plan. The Positioning options for importing are shown in Figure 5.4.

FIGURE 5.4

Positioning options Positioning: | Auto - Origin to Origin
Auto - Center to Center
Auto - Qrigin to Crigin
Auto - By Shared Coordinates
Manual - Origin

Manual - Base point

Manual - Center

Flace at:
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For details, you can generally use the manual options and place the details where required.
Trying these options in a blank project file before you bring any file into your live project is
always a good rule of thumb; it gives you a sense of where the objects are going to be and
whether the scale is correct.

Figure 5.5 indicates the options available for import units. Although Auto-Detect is the
default option and usually works, sometimes the originators of your imported data are not as
rigorous as they should be and their units don’t quite match their documentation. So specifying
the units is preferable to letting Revit apply a default. Also, the scale used in the view should
match the scale intended to display the detail in the original software used to make it. This
ensures that geometry, hatching, and fonts will be as close to the same as possible. If this isn’t
set before importing the detail, then the poor fidelity can compound the issue of units
being wrong.

FIGURE 5.5 Colors: IBIack and Whib&j
Import Units options Layers/Levels: | al |

Import unitg: I.-'-\uhD-DehEct 1.000000

e = are slightly off axis

inch

meter
dedmeter
centimeter
millimeter
Custom factor:

You have the option to correct lines that are slightly off axis, as shown in Figure 5.6.

FIGURE 5.6

B ) Colors: IBIackand White VI
Correcting lines that
are slightly off axis LEsleEs IA" :Iv

Importunits: [Auto-Detect || 1.000000

[~ Correctlines that are slightly off axis:

This feature should be used with care, however, because those “slightly off-axis lines” may be
part of the design intent!

2D Data for Plans, Sections, and Elevations

Let’s say that you are using Autodesk Revit MEP and want your staff members to keep using
that program, even though you have other projects in your office for which the architect is
using traditional CAD-based drafting methods. Should you do these projects in AutoCAD
or Revit? Once you have been using Revit for a while, using anything else feels like it takes
far too long, and there’s all that back-referencing and checking that sections tie up with the
plans!

I'll show you how to create a wireframe 3D model using the supporting 2D CAD files from
the architect. The following Revit workflow has been tried, rigorously tested, and used for
numerous real world projects. Your staff members retain their knowledge, and the project
design is still coordinated (albeit only with the other building services, not with the architec-
ture—although the architect can provide you with sections as well as plans).
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When going down this route, you need to consider how your project team generally
works: either in one multiservice file or in multiple project files with only one service. If all
services are in one model, linking the plans and sections into that file is probably the best way
forward.

However, experience shows that working with multiple project files—Architecture,
Structure, Electrical, HVAC, Fire, Plumbing, and Drainage is sometimes the better option.

This is sometimes born of necessity because the project teams are in different geographic loca-
tions. Although a company might have technology to support distributed file servers and proj-
ect teams on different continents, the reality is that managing this process can cause a lot of
extra work.

In this workflow, linking the 2D files into each project file is an option. The linked files
appear only as linked overlays, the same way they do in AutoCAD. Managing the location of
multiple linked files in multiple project files is a messy and time-consuming task. You have to
rely on users not moving or deleting anything accidentally. Of course, this applies in any proj-
ect, but the problem can become compounded under these circumstances. The best option here
is to have one “architectural” file—one place to update and manage—and keep all your services
files at the same stage for printing. This does require some setup at the start of the project, but
once it’s complete, it is almost as manageable as linking a model from the Revit Architecture
software.

FILE CLEANUP

Before you import anything into Revit, consider taking a few minutes to “sanitize” the file. This
could be a simple task such as running an AutoLISP® routine in AutoCAD to purge unnecessary
objects such as layers or blocks (named and unnamed). Change the Colors option to By Layer and
delete anything that isn’t necessary for your project, such as all those objects just outside the
viewport that the architect was saving for a rainy day. Sometimes these objects can affect the
positioning of an imported file: if an object is more than 20 miles (32.2 km) from the origin, inac-
curacies and position issues can occur. In this case, it is necessary to open the file and delete those
extraneous objects and resave.

If you do not have access to AutoCAD, an alternative is to start a new Revit project file, import
the drawing, and fully explode it. Then export that view back to AutoCAD and import it into your
Revit project. This approach is a bit circuitous, but it’s a great way to clean a drawing as long as the
fidelity of data such as line patterns, hatches, and text is maintained.

The following exercise will take you through linking plans and elevations into a new proj-
ect file, creating levels and default views that any of the project engineers can use to obtain
the prints they require for markup. Although this exercise uses a few of the more basic Revit
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commands, it is mainly designed to show a best-practice workflow, especially when linking this
file into your services project files. At the end on the exercise, you will end up with a 3D wire-
frame model, as shown in Figure 5.7.

FIGURE 5.7
3D wireframe model

Follow these steps:

1. Create a new Revit MEP 2016 project file using the template RMEP2016_Ch05_Project
TEMPLATE. rte. This file can be found at www.sybex.com/go/masteringrevitmep2016.

2. Open the Level 1 floor plan, and from the Insert tab, select Link CAD and select the
drawing file RMEP2016_Ch05_FloorplanLevel0l.dwg. Use the following settings,
shown in Figure 5.8:

Current View Only: Not selected

Colors: Black And White

Layers/Levels: All

Import Units: Auto-Detect

Correct Lines That Are Slightly Off Axis: Not selected
Positioning: Auto — Origin To Origin

Place At: Level 1

® & & O ¢ 0 0o o

Orient To View: Selected


http://www.sybex.com/go/masteringrevitmep2016
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FIGURE 5.8 " Link CAD Formats 2 x|
Import settings Lookin: [ ] Exercses ] e B % E] vews ~
Name = | +| Date modified | +| T3 ~| size [ Preview
TS RMEP2016_ChoS ElevationEast,dwa 15/11/2010 23:48  AUtoCAD Drawing
[SirMER2016_Ch0S_ElevationNorth.dwg 15/11/2010 23:47  AUtoCAD Drawing
FSiRMEP2016_Ch0S5_FlevationSouth.dwa 15/11/2010 23:47  AutoCAD Drawing
FSiRMEP2016_Ch0S_FlevationiVest.dwa 15/11/2010 23:47  AutoCAD Drawing
IEP2 15 wing
Fire Alarm RMEPZOlG_ChO5_F\aorp|anLeveI02.dwg 15/11/2010 17 AutoCAD Drawing
P.MEPZOlG_ChO5_F\uorp|anLEveI03.dwg 15/11/2010 23:47  AutoCAD Drawing
E. [ RMEP2016_Ch05_Floorplanfoof.dng 15/11/2010 23:47  AutoCAD Drawing
History
Documents
4| | |
File name: |RMEP2016_Ch05_FloorplanLeveld 1 dwg =l
My Network...
Fies of type: [DWG Fles (=.dwg) Bl
I~ Current view only Colars: | Black and Whits ¥ Pasitioning: [Auto - Origin to Origin =l
LayersfLevels: [al - Place at: [Level 1 =l
Importunits: [autoDetect = || 1.000000 [¥ Orient to View
Tools. - ™ Correct lines that are slightly off axis Open Cancel |

3. The next step is to create building grids based on the architectural floor plan. From the
Architect tab, select the Grid tool. With this active, use the Pick Lines option from the
Draw panel.

Although this is a quick method of creating grid lines, be sure to keep an eye on the grid
head location. If the lines have been drawn in different directions, the result is that the
grids are oriented differently. Clicking the grid head and selecting the adjacent check
mark to swap the orientation will work—but only in this view. As long as you create
these elements consistently, they will be displayed in a consistent manner through the
rest of the project.

Start with Grid 1 and select each subsequent grid, except the intermediate grids. You
can come back and do those after creating Grid 10. Once the vertical grids are complete,
do the horizontal ones. Starting at A, you will rename this first alphabetic grid and then
follow with B, C, and so on. Once all the major grids are created, go back and create the
intermediate ones. With this workflow, you have to rename only a few grids rather than
every single one.

Modify | Place Grid

&

Multi-Segment

Pick lines
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4. With the grids complete, open the North Elevation.

5. Navigate back to the Insert tab, select Link CAD, and select the file RMEP2016_Ch05_
ElevationNorth.dwg. Use the Auto — Center To Center positioning option, and ensure
that Orient To View is checked.

6. Notice that the elevation drawing, while oriented in the correct plane, is not in the correct
location with respect to the levels and grids. Use the Align tool to correct this, aligning
Level 1 with 01-Entry Level and Grids 1, as shown in Figure 5.9. Then align Level 2 with
02-Floor in the linked drawing.

FIGURE 5.9
Align the 11 @

linked DWG | |

] ‘EI
]

! !

02 - Floor

3800

= . ) r - -
| |
| | 01 - Enlry Level Level 1
! ! 0 o-0" 5

7. One other thing to notice is that the existing levels do not share the same name as the
linked DWG. Select the Level 1 line and click the blue highlighted name of the level.
Change this to match the DWG, and do the same for level 2. Revit then asks if you would
like to rename corresponding views. Click Yes, as shown in Figure 5.10.
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FIGURE 5.10
Renaming levels

-0, Views (Discipline)
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-2 Families
B-[@] Groups
&5 Revit Links
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NAMING NEW LEVELS

The newly created levels do not have the same names as the link file, so you need to edit them. When
you are editing level names, Revit prompts you with a message, as shown here:

x|

Would you like to rename corresponding views?

It is important to click Yes. At this point, you are trying to create a set of default views that match
the architecture. Having a building level and a floor plan with matching names will save you and

anyone else looking at the project file a lot of time.

8. Create additional levels for levels 03 - Floor, and Roof, renaming each level to match
the link file. You may find that the created levels do not show up in the Project
Browser where you expect. In Figure 5.11, the levels created have ended up filed under
Architectural/Power/Floor Plans. To place these views into Architectural/BASE
PLANS/Floor Plans, select both views in the Project Browser (A), right-click, and select
Apply View Template (B). In the Apply View Template dialog box, select Architectural
Plan (C) and click Apply Properties (D). You will see the views move in the Project
Browser (E).

9. Repeat step 2, opening each level (02 - Floor, 03 - Floor, and Roof) and linking the follow-

ing DWG files:

¢ RMEP2016_Ch05_FloorplanLevel02.dwg
¢ RMEP2016_Ch05_FloorplanLevel03.dwg
& RMEP2016_Ch05_FloorplanRoof.dwg
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Applying the view
template
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10. With all the floor plans linked, we can turn our attention to the rest of the elevations. You
already have the North elevation linked (step 5), and looking at the default 3D view, you
can see in Figure 5.12 that although the file is aligned correctly in relation to levels and
grid 1, it is in the middle of the building. (The upper floor DWGs have been hidden for
clarity.) Open 01 - Entry Level plan and use the Align tool to move the elevation to the
north “face” of the floor plan.

FIGURE 5.12
Aligning the
elevation to the plan

11. Repeat steps 5 and 6, opening each of the remaining elevations in turn and linking the
following files:

4
L 4

L 4

RMEP2016_Ch05_ElevationSouth.dwg
RMEP2016_ChO5_ElevationWest.dwg
RMEP2016_ChO5_ElevationEast.dwg
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12. Repeat step 10 for each elevation. It’s a good idea to do this straight after linking each one;
that way you don't end up aligning the incorrect one.

13. Open floor plan 01 - Entry Level and activate Visibility Graphics. Select the Imported
Categories tab and uncheck all the linked DWG files except RMEP2016_Ch05_
FloorplanLevelol.dwg.

Also, as indicated in Figure 5.13, click the plus sign to expand the layers in the link and
turn off anything unwanted—like grids (S-GRIDIDM), for example.

14. Repeat step 13 for all the other floor plans and elevations, leaving only the link file appro-
priate to each view visible.

When you have finished, open a 3D view. Your “building” should look similar to
Figure 5.7.

15. Save the file. This can now act as the architectural link file for your entire project.

16. Using the same template file you used in step 1, create a new project file. This can be your
HVAC documentation model.

17. Open the North elevation view and delete the two existing levels. The message that
appears, displayed in Figure 5.14, informs you that views are being deleted. This is nor-
mal, so click OK.
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FIGURE 5.14
Viewing deletions
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Autodesk Revit 2016

Warning - can be ignored

View Level 1 will be deleted. ;I
View Level 2 will be deleted.

=

Show IMore Info | Expand == |

Cancel

18. Link the file RMEP2016_Ch05_COMPLETE. rvt by using the Origin To Origin method.
Notice that none of the linked drawings are visible—you’ll adjust that in step 20.

19. Aswith a standard Revit project, copy/monitor the levels and grids, and then create your
plan views. Each of these views will display only the grids, not the linked drawing files.

20. In each of these views, adjust the visibility/graphics to override the view to the required
settings, as shown in Figure 5.15. (1) Click on By Host View, which displays the RVT Link
Display Settings; change this to Custom (2); and then select the Import Categories tab (3).
Also change the Import Categories to Custom (4); you are now able to override the layer
settings (5) in the nested, linked dwg file.

FIGURE 5.15
Visibility/Graphic
Overrides

Visibility/Graphic Overrides for Floor Plan: Level 1 x|

Model Categories | Annotation Categeries | Analytical Model Categaries | Imparted Categeries | Filters RevitLinks |

Visibilty Underlay Display Settings
MP By Host view 1
RVT Lin play Settings x|

Basics |Mode¢ Categories | Annotation Categories | Analytical Model Categories | Import Categories |

By host view © By linked view & custom(lpd ‘
RVT Link Display Settings x|

' Basics | Model Categories | Annotation Categories | Analytical Model Categories  Impart Categaries |o

Import categories: <Custom> hd o
[¥ show impart catagories in this view If a category is unchecked, it will not be visible.
Filter list: | <show all> -
Projection/Surface -
Visibilty DECTRIS Halftone B
Lines
-] RMEP2016_Ch05_F i dwg
- [] RMEP2016_ChOS _E th.dwg
- [] RMEP2016_ChO5_El i
e - [] RMEP2016_Ch05_Elevation\West.dwg
-| Fic 01.dwe

visibility

RMEP2016_Ch05_COMPLETE.rvt

Whether you're linking or importing CAD data from other formats, although you can use the
overrides to change what you see or how you see it, you can also, in fact, use the Import Line
Weights option, as shown in Figure 5.16. This enables you to specify a DWG color number and
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associate it with a pen weight in Revit. This can range from using a series of default standards

supplied with the software to loading your own (or partner’s) standard, so the weights of lines
are the same between CAD and Revit.

FIGURE 5.16 Tnsert
' %2 [3 & e
Import Line > = 3 &
Weights option Import Import  Ingert _ Image Mana
CAD gbXML  from File Images
| Import 02d from Library | Autodesk Seek |
= x|
DWG/DF Color Number Line Weight il Lo
; :
1z i
E] 1
I 1
5 1
6 1
7 1
|§ 1
Bl 1
10 1
11 1
12 1
13 1
14 1
15 1 LI
NOTE: These values only apply to lines and layers set to DEFAULT lineweight in source DWG/DXF file.
lines and layers with set neweight value are automaticslly mported at that width,
o« | el | i |

In addition, you have the ability to select and query the layers in a linked /imported CAD
file. Say, for example, you are unsure of the layering standard in the linked file; you can select
that file and then use the Query command, as indicated in Figure 5.17. You can select lines and
objects within the link file and choose the option to hide that selection in your current view.

FIGURE 5.17 P oo en P AT et [ 005 o @ |
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|

NON-REVIT LINKS

Although using linked AutoCAD DWG files in no way replaces a linked Revit architectural model,
it does represent an efficient way to work with 2D data. There is now one place where architectural
information is updated, including the building levels and grids. Because you created these as Revit
objects, you can now use the Copy/Monitor option to place them in subsequent services files.
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3D Data Types

This section is easy—well, it should be anyway. You are, after all, importing and manipulating
3D data in a 3D application. What could possibly go wrong?

Well, it all depends on the type of data you want to import or link into your project. Let’s
start with the easiest—a Revit project file. Surely there cannot be anything difficult with that?
What it boils down to, however, is the other users and how they have set up their projects. If you
are lucky, they have a lot of experience and, most important, have communicated how the model
is constructed to the entire project team.

Much also depends on what you, as an MEP user, want to get out of the project, so let’s see.

Revit Project File

You may also need to prep a consultant’s Revit file before you use it, and this is where you will
need to talk to that consultant. Which parts of the model are you using? If the consultant has
been using design options, phasing, or worksets to control visibility of objects, which ones do
you need for adequate project coordination? You can disable worksets when collaborating with
others. When you open a workset-enabled file and click Detach From Central, the resulting dia-
log box gives you the options shown in Figure 5.18.

FIGURE 5.18 Detach Model from Central x|
Detach Model From

: Detaching this model will create an independent model. You will be unable to synchronize your
Central dlalog box changes with the original central model.

What do you want to do?

-» Detach and preserve worksets
You can later save the detached model as a new central model.

=» Detach and discard worksets
Discards the original workset information, induding workset visibility. You can later create new
worksets or save the detached model with no worksets.

Cancel |

Disabling worksets can result in the loss of workset visibility. Unfortunately, some users use
worksharing as a type of extended layer or visibility control. The trouble with this workflow is
that the problem is exacerbated by the introduction of workset visibility control in view tem-
plates. There are several ways of turning off object(s) in a view in your project file:

¢ Visibility/Graphic Overrides

Filters—by category, individually, or by saved selection set

¢ Hide Element(s)—by category, individually, or by saved selection set
¢ Design options
¢ Phasing

Worksets

You can also control any linked file either in conjunction with your view settings
or separately.
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Project Phasing and Design Options

If an architect has an existing building and is developing new and future designs, that architect
may have phases set up in the project file. You'll definitely need instruction from the architect
on the particular phase of the project on which you are working, and which phase filters were
applied. Once you have a list of the phases in the architect’s project and understand which ones
apply to your contract, you can set up phase mapping.

Suppose the architect has Existing, Base Build, and New Construction phases. Your project
has the phases Existing, New Construction, First Fix, and Second Fix. Select the linked Revit file,
and in the Properties dialog box, select Edit Type. Then, in the Type Properties dialog box, select
Phase Mapping, as shown in Figure 5.19.

FIGURE 5.19 x|

Linked file type

properties Family: System Family: Linked Revit Model Load,, |
Type: IRMEPZOlG Ch05_COMPLETE ARCH Phaqu Duplicate, .. |
Rename... |

Type Parameters

| Parameter | Value |
Room Bounding !l !
Reference Type

Phase Mapping

<< Preview | OK I Cancel | Apply |

This is where you decide which phase in the architect’s file corresponds to a phase in your
project, as shown in Figure 5.20.

Once this mapping is finalized, any views set up in your project specifically for First Fix or
Second Fix will also display the architectural model correctly. (Notice the term model. This has
no effect on any linked DWG files because phasing applies only to model objects.)

Hopefully, by the time it comes to the MEP design, most major issues, such as whether the
building is square or rectangular, will have been sorted out. However, if the architect is still in
discussion with the client, you will need to be prepared to discuss the primary design option
with the architect and, if are you being paid to, design for that option plus the other options that
the architect thinks the client may like.
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FIGURE 5.20 O x
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But we've jumped ahead here! What about the MEP concept and preliminary designs? How
do we as modelers and designers fit in with what the architect is designing? What are our
responsibilities, and how much are we modeling and designing in Revit?

If we are relying on the architect to provide a model at the concept stage so that we can run
analysis calculations for a building’s heating and cooling loads, we need an airtight model.
Chapter 17, “Solid Modeling,” covers the merits of using the Mass Modeling tools in Revit to
generate a building form.

Revit Family File

Revit families are the elements that bring any design to life. They hold data that, when created
correctly, provides more than just a visible indication of an object’s placement. Thus, team mem-
bers should reach a consensus that Revit families are implemented to a certain standard:

¢ The appropriate family template file is used.
¢ Categories are set correctly.
¢ Subcategories are adequately and consistently named.

Within your company, you should have a standard for family creation. This standard could
specify any of the techniques and best practices used in creating families that can be placed into
your library.

Your standard should include items such as the following:

Common Orientation and Insertion Points If a family is exchanged with another, you don’t
want it to jump 2 feet to the left and rotate 22.5 degrees.

Naming Conventions for Subcategories and Reference Planes This helps make the families
perform as required in relation to visibility settings when loaded into the project. These
conventions also aid users when familiarizing themselves with how best to create a family
according to company standards.

A Standard, Company-wide Shared Parameter File This ensures that families, even from
different categories, can share the same type of data that can be reported, tagged, and sched-
uled in the project file. A great starting point for consistency is the Autodesk Revit Style Guide.
It can be found here:

http://seek.autodesk.com/en-us/marketing-solutions/resources.htm
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ADSK

The Autodesk Exchange File (ADSK) format covers multiple platforms. In its current format,
which is XML based, ADSK allows the user to export from, say, the Autodesk® Inventor® plat-
form to an ADSK file, which can then be imported into Revit. There is functionality in Revit
Architecture to export ADSK files for use with civil engineers, although this is not supported
in MEP. This is a static form, but it does have the benefit that, if connectors have been placed in
Inventor, their properties are taken through as Revit MEP connectors. You can open ADSK files
from the Open command, and after you save them, they become loadable Revit families.

IEC

The Industry Foundation Classes (IFC) file format was introduced as a solution to the problems
of multiple software vendors competing in 3D space. IFC is an XML file format that can be
edited in text editors such as Windows Notepad. Although the IFC format is somewhat limited
from within Revit itself, Autodesk has made the IFC import/export tools open source (freely
available to programmers) and the Revit API has been expanded with each release to offer
greater support for getting data to and from IFC.

INDUSTRY FOUNDATION CLASSES

The current format for IFC is IFC4, although, at the time of writing this book, Revit in its
default install supports IFC 2x3. The format was developed by buildingSMART, formerly
known as the International Alliance for Interoperability (IAI). More details can be found at www
.buildingsmartalliance.org.

Using IFC can increase the number of consultants with whom you can interact. There is a
potential downside, however. Unless you spend adequate time at the front end of the project dis-
cussing just how the data is to be transferred with all parties (what format you'll use), problems
can arise from data that, when opened, is so inefficient as to be almost worthless. In some cases,
it is preferable to use the import method as described in the previous exercise than it is to import
an IFC file. On an average-sized project, an IFC file can take hours to import, and then the objects
that are imported might turn out to be in-place families. Consider the use of one of the many use-
ful Revit add-ins that give you more control over the IFC export/import process. Many are avail-
able from the Autodesk App Exchange (https://apps.exchange.autodesk.com/RVT/en/Home/
Index?from=infocenter) or from other software vendor sources. These apps can give you better
functionality between differing packages or the ability to export to the current IFC4 format.

@ Real World Scenario
CHOOSING THE RIGHT FILE TYPE

With a new project coming into the office, a meeting was set up between the architects, structural
engineers, and MEP engineers. Both sets of engineers were using Revit as their base documenta-
tion software, whereas the architects were confirmed Bentley Architecture users. Although the
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architects had copies of Revit Architecture in the office, they continued to use the Bentley solution
and had supplied an add-in for their current version of Revit to the engineers that allowed the
export of i.dgn files. Although this was fine for the architects, they in turn exported to IFC (using
an appropriate plug-in). At around 50 MB, this file could routinely take 3 to 4 hours to process into
Revit. At the same time, the internal fit-out was being done in 2D AutoCAD.

The engineers decided to do away with the IFC import altogether and create a wireframe model
from the 2D drawings. This made the project much more efficient and manageable. Coordination
did not lose out, however, because all consultants agreed to use Navisworks. Each could discuss
their issues at weekly project meetings in front of a large-format display monitor.

The sidebar “Choosing the Right File Type” highlights some of the issues that users face
when using the IFC format. As of this writing, numerous companies are producing free as well
as fee-based IFC viewers, which allow the user to view the building model and any properties
that are attached to the building elements. Some of these software vendors also provide IFC
cleaners that allow for the optimization of an IFC file prior to opening it in any other suitable
software.

AutoCAD DWG

As described earlier in this chapter, native AutoCAD (and MicroStation) files are easily
imported or linked into Revit. The purpose of doing so in the 2D environment is that it can be a
good way of bringing together a project team with a wide range of skills.

The reasons for importing native 3D objects from AutoCAD can be a bit blurred. If you were
modeling 3D building objects in AutoCAD, why wouldn’t you do the same in Revit? It could
be argued that a company already has a wide range of 3D library components that may or may
not need to be parametric, so what would be the harm in importing those objects into a family
template of the correct category that is then saved as a loadable Revit family? There are mixed
opinions about this, especially when companies have to invest substantially in extra develop-
ment work. With the bottom line speaking louder than it has for many years, a lot of companies
are preserving or reusing as much as they can in the hope that doing so will save them money.
At the end of the day, it comes down to economics, but (and point this out to your employer)
invest wisely and spend the necessary time on developing or purchasing your Revit library. The
alternative is reusing the existing 3D data, but this often has detrimental effects on the project:
increased file size, excessive complexity, lack of connectivity to related Revit objects, and appear-
ance all play their part in slowing down your production.

DWGs from Verticals

AutoCAD verticals (such as Architecture, MEP, and Civil 3D) and Bentley Architecture are
object based, relying on additional object enablers to create more functionality. This can lead to
proxy objects, discussed earlier in this chapter.

The way AutoCAD or MicroStation handles this intelligent information is to give the user the
ability to export to IFC. Exporting DWG/1 . dgn elements to IFC does work. Sometimes you even
get real building elements when this data is opened in Revit. However, exporting isn't perfect.
Many times the data is all there but can end up as in-place elements, which can be inefficient.
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SketchUp

There! We said it!

Yes, you can.

Why?

OK. OK! Say that someone has modeled the entire city block and surrounding suburbs in
Trimble SketchUp. You can import that model, enabling you to perform sun studies. Later in the
book, you'll see how to do exactly the same thing in Revit and have something useful in your
project file.

Other File Formats

Revit 2015 introduced the ability to do more with imported 3D files. You can explode them and
retain the 3D elements, such as ACIS solids in the form of SAT (Standard ACIS Text) format
files. You can directly manipulate the 3D object because it is now a free-form object within Revit
that can be manipulated, stretched, and cut with voids just like any other Revit solid object.
This free-form object has the potential to greatly help in the transition from one file format to
another.

However, this solid does have some limitations. Rectilinear objects can be stretched and
manipulated using shape handles but any radii remain static, even though they can be dimen-
sioned. Figure 5.21 shows two examples. On the left, an ACIS solid created in AutoCAD and
imported into a Revit mass can be seen. Notice that there are grips on each face but no controls
on the arc. On the right, a similar model has been imported from SketchUp. The main difference
is the way SketchUp uses segmented surfaces to create arcs.

FIGURE 5.21 Shape handles
Imported ACIS
solids
Import from AutoCAD Import from SketchUp
Point Clouds

Point clouds are becoming quite common for studying existing conditions. Obtain a laser scan
of your building and it’s a simple job to check design data against the as-built model. Revit sup-
ports a wide variety of formats (including PCG, which was the default file format in previous
versions). In the 2014 release, the point cloud engine was changed to use RCP and RCS formats;
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the others must be processed on insertion into Revit. You can do this by selecting Raw Formats
from the Files Of Type drop-down list, as shown in Figure 5.22.

FIGURE 5.22 7Y Link Point Cloud 2=
Selecting Raw tokin: [ ]] Exercses <] @ Bd X EL vews v
Formats in the MName =~ | +| Date modified | ~| Type ~| size
. . " @ | AEC_Headquarters_Interior_Scan.fis 16/02/2011 20:58  FLS File 21
Link Point Cloud N @ | AEC_Headguarters_Interior_Scan.peg 16/02/2011 20:58  PCG File 21
Shortcul
dialog box E
History
Documents
(s
My Computer
< | |
File name: || =
Files of type: [Raw formats (=,3dd, *.asc, =.d3, *.cf, %.e57, =fis, *.fus, =ixf, a5, las, 7|
Positioning: IAuto - Origin to Crigin =l
Took - [y open cancel |

These raw files need to be indexed, as shown in the message box in Figure 5.23. This process
creates the native (RCP) files. Although the conversion may take a while, this indexing is per-
formed in the background, so you can continue to work on other things.

FIGURE 5.23 x4
File Not Indexed :

| The following files are not an indexed format. Would
message & you like Revit to create a new Index File?

AEC_Headquarters_Interior_Scan.pcg
Revit can create new indexed (.rcs) files. Creating an index

may take some tme. Once complete you can link this new
file.

% Yes Mo |

Once the RCP file is created, it can then be linked into your Revit project in the same way as
any other linked file. This new format is a great way to start an as-built project. This type of data
is going to take up resources, however, with files starting at around 200 MB. Nonetheless, the
indexed file performs well after it is linked. With the point cloud data linked, you can view it in
the same way as any other linked file. In Figure 5.24, you can see this cropped 3D view, which is
displaying a selection of services and walls.
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FIGURE 5.24
Cropped 3D view

Cable tray

Suspended
luminaires

Wall

The Bottom Line

Decide which type of data you want to use on a project. Revit 2016 allows the user to import
and reuse existing drawings from AutoCAD and other formats.

Master It Having a good command of the tools available for importing other file for-
mats will extend and enhance the integration of Revit with other CAD systems. When
importing a 2D file format into Revit, what are the two best ways of ensuring that the
data is shown in only one view?

Link data consistently and in the correctlocation. When bringing data into Revit, it is
important to be able to define where an object is positioned.

Master It An imported drawing has inaccurately placed or frozen layer objects that
make the extents of that file greater than 20 miles (32.2 km). What should you do prior to
the import?
Prepare data prior to import. Revit project files should be the easiest to link to your project.
However, at times this process can become complicated.

Master It  After receiving a Revit Architecture model, you can see that some worksets
are causing visibility issues when the file is linked to the Revit MEP model. How can this
be solved?



Chapter 6

Parameters

The Autodesk® Revit® platform is sometimes referred to as a parametric change engine. Parameters
are the very core of what makes Revit MEP such a powerful design and modeling tool. Para-
meters hold the computable data that defines the properties of not only model components but
also everything that makes up a Revit project. They are the characteristics of all elements of a
Revit project that ultimately determine behavior, appearance, performance, and information.

Parameters and properties are often considered synonymous, but it is the parameters that hold
the information we store in elements; they determine the properties of a component. Properties
may be static, but parameters allow for change to be propagated throughout the project.

When you realize the power of parameters in Revit and understand the types of things you
can achieve with them, you will have a better understanding of why Revit can improve your
workflow processes and the efficiency of your design projects.

In this chapter, you will learn to do the following:

¢ Manipulate the properties of parameters
¢ Work with type catalogs

¢ Work with shared parameters

*

Use parameters in project files

Understanding Parameter Basics

Before you can understand how to use parameters to drive the properties of your objects, you
need to understand the properties of parameters. When you create a parameter to hold some
form of computable data, you want to define the way in which it will do so. Figure 6.1 shows the
Parameter Properties dialog box accessed from within the Family Editor. Other versions of this
dialog box that contain additional settings are discussed later in the chapter. This dialog box is
the first place to go when you're adding a parameter to a family, a project, or a schedule.

There are four basic kinds of parameters in Revit MEP: system parameters, family param-
eters, project parameters, and shared parameters. Some parameters are hard-coded into the
software. The values of these parameters can be edited as needed, but the parameters themselves
cannot be removed or modified. In this chapter, these are referred to as system parameters.

Family parameters are used to build and define graphical structure and engineering data
within component families. These parameters can be customized as needed to enhance the
capabilities of component objects and to extract and analyze data.
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FIGURE 6.1
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Shared parameters are useful to help maintain consistency within families and to coordinate
information within a project. They are the most useful kind of parameter because they can be
used in component families, schedules, tags, and annotations to report the same data in which-
ever format the user chooses.

Project parameters exist only in the project environment, as the name suggests. They can
appear in schedules but not in tags. Their main advantage is that you can apply them to all
families of a particular category or even multiple categories in a project instead of having to
add the same parameter to every family. Project parameters can be created from the Project
Parameters tool under the Manage tab.

Choosing the Correct Parameter

The first decision to make is what type of parameter to create. Family parameters can be created
when working in the Family Editor, and they will be visible in a project when the family is
selected. However, the information that they hold cannot be used in schedules or reported

by a tag or annotation. Shared parameters can be used the same way that family parameters

are used, but they are unique in that they can also be used in schedules and tags. However,

this rule has its exceptions. For example, in a detail component family, you can’t create shared
parameters; you can create only family parameters. But family parameters created in a detail
component family can appear in schedules yet still not in tags. Parameter types are discussed in
further detail later in this chapter.

Naming Parameters

When you choose to add a parameter, it is likely that you have a specific purpose for it. That
may sound like an obvious statement, but it is important to consider when you decide what
to name the parameter. There is no harm in naming your parameters in a descriptive manner,
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especially when you are working with others who need to understand the purpose of a param-
eter. However, it is possible to be too verbose. Long parameter names can cause the annoyance
of having to resize columns within dialog boxes in order to read the name.

Consistency is the key to good parameter naming. It can be frustrating to go from one family to
another and see different names for parameters that provide the same information. Using descrip-
tive words is also helpful, especially when you have similar parameters within the same object,
such as a component that is made up of multiple shapes, each requiring a Width parameter. It can
be difficult to work with parameter names such as W1, W2, W3, and so on, whereas using names
such as Housing Width, Lens Width, and Bracket Width makes it easier to make adjustments or
changes when working in the Properties palette or Type Properties dialog box of the object.

If you intend to abbreviate measurements such as length, height, or radius, be sure to use a
consistent format. Will you use the abbreviation as a prefix or suffix to the descriptive portion of
the name? Will punctuation such as dashes or parentheses be used? These symbols can have an
effect on how those parameters perform in formulas.

Decide up front whether you will use height or depth to describe the third dimension of an
object. The way you orient the families can also create inconsistency in parameter usage. What
could be width for one family may be length for another. You can avoid this issue by consider-
ing the orientation of the family and where the parameters go.

There are two general systems for naming the parameters representing the three dimen-
sions—either keep the parameter name meaningful to the family or always keep it consistent.
So, if you were to use the first method (keep it meaningful), you would call the parameter’s
depth, height, or width based on what makes the most sense for the particular family. And if
you were to go with the second method (always consistent), you would always call the three
directions of the family the same—length, width, and height. In some cases, the length really
may be width, and in others the width really may be depth. But if you are consistent and every-
one at your company understands the concept, it all makes sense. In Figure 6.2, you can see a
family that uses a consistent naming convention for the three main dimensions. From plan view,
the horizontal parameter will always be called LENGTH, the vertical will always be called WIDTH,
and the third parameter will always be called HEIGHT.
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In addition, in this case all caps is used for the naming convention, which helps users to
quickly spot any custom parameters in the Properties palette, although there are other ways to
achieve this. For example, you can use an abbreviation of your company’s name before or after
the parameter name, such as MyCo_Length or Height_MyCo. Autodesk capitalizes the first letter
of each word when developing parameter names (this is called title case or headline style),
and this is the default for standards such as the Autodesk Revit Model Content Style Guide
(http://seek.autodesk.com/en-us/marketing-solutions/resources.htm), Australian and
New Zealand Revit Standards (www.anzrs.org), and the Bimstore Standards (https://www.bim-
store.co.uk/resource-centre). Whichever you choose for your own standard, the key is to be
consistent and stick to it.

Parameter naming is important because Revit is case sensitive and context sensitive when
you refer to a parameter in a formula, calculated value, or filter. Spelling and capitalization
accuracy are critical, so develop a naming convention that is as simple as possible while still
being easily understood.

Using Type Parameters
Type parameters are the reason you can have multiple variations of a family within one file.
Family types drive type parameters that are common to the host family but potentially unique
to each family variation, or “type.” When you are creating a parameter, it is important to decide
whether the parameter will be used to define a type within the family.

Type parameters can cause the most damage when misused because they pass changes
to every instance of the family type to which they belong. For this reason, you will receive a
warning when editing a type parameter in a schedule view, and accessing a type parameter
in a model view requires an extra mouse click. However, you can customize the double-click
function of the mouse to access the type properties. This can be done from Application >
Options > User Interface.

@ Real World Scenario
ALWAYS DOUBLE-CHECK

Ethan needs to replace an existing 180 VA receptacle with a 360 VA one. Unfortunately, the Type
Selector doesn’t have this type of receptacle. When he takes a closer look at the family types, he
notices the Volt type parameter but also realizes that if he is to change its value, the change will
affect the entire project and all 180 VA receptacles will be changed to 360 VA. Instead, Ethan dupli-
cates the existing 180 VA type to a new 360 VA type and then modifies the Volt type parameter.
When editing a type parameter of a family in a project, always double-check that you do not need to
create a new family type. It is a safer and better practice to create a new type if there is any doubt.

In some cases, you may choose to use instance parameters instead of type parameters, and
we’ll be discussing that shortly.

Type parameters do require that if you need to change just one or a few instances of an
object, you will have to create a new family type. This can lead to having several types within
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a family, which causes your Type Selector to be cluttered and confusing. If you are creating
a type parameter that will define a family type, it is best to name the family type as it relates
to the value of the type parameter(s). A light fixture family, defined by its width and length
parameters, would likely have family types with names such as 2" x 4’ (600 mm x 1,200 mm)
and 1" x 4" (300 mm X 1,200 mm), for example.

Type parameters also allow you to create type catalogs for families with extensive lists of
parameter configurations. We will address type catalogs a little later.

Using Instance Parameters

Instance parameters provide the most flexibility for editing an object. They are easily accessed
via the Properties palette when an object is selected. Create instance parameters for values that
you want to be able to change for just the selected object. To use the example of a finish color, if
the color is an instance parameter, then you could have one family type that could vary in color
without having to create a separate family type for each color option. Another example is the
Air Flow parameter for diffusers. You may use the same diffuser multiple times in your project,
but the airflow they supply from one room to another most likely will vary.

The drawback to instance parameters is that they apply only to the selected objects. Thus,
if you want to change an instance parameter value for all instances of an object, you will have
to select each object and change it individually. Alternatively, you can select objects by using
schedules or by right-clicking an object and choosing Select All Instances. Make sure you
understand the difference between the options Visible In View and In Entire Project. Figure 6.3
shows the difference between these two options.

FIGURE 6.3
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@ Real World Scenario
SELECTING ALL INSTANCES

Maria, an experienced Revit user in a hurry to issue drawings, is asked to remove circuit tags from
the view in which she is currently working. She uses Select All Instances and mistakenly chooses
the In Entire Project option. She doesn’t notice the filter number indicating more than 2,000
objects selected. Maria proceeds to delete all tags and gets ready to issue the drawings. An hour
later, she recognizes her error and wants to undo changes. Unfortunately, other people have been
synchronizing work back to the central file, which includes some additional work to the lighting
design in other parts of the building. Maria has no option but to go through the entire set to replace
all tags. There is an option to tag all objects not already tagged (Tag All Not Tagged), which greatly
reduces the amount of time required to re-annotate the output documentation (although she does
have to repeat this in every view).

This experience doesn’t put Maria off. She knows what happened and why, and the drawings go
out on time. Now, in training sessions, she is able to demonstrate a common mistake that users
are prone to make when they’re in a hurry (delete all tags in a project) and how to rectify the issue
by using the Tag All Not Tagged option.

An instance parameter can be set to be a reporting parameter. A reporting parameter will hold a
value that can be used in formulas for other parameters, or it can be used to drive the behavior of
another parameter. These are most useful in wall- or ceiling-hosted families because, for example,
you can use a reporting parameter to recognize the thickness of the host wall. Some portion of a
dimensional reporting parameter must be associated to the host in order to be used in a formula.
These parameters have a very narrow range of application, especially for the MEP disciplines. It
may take a while until you find a purpose for them. In most cases, beginner Revit users create
them by mistake and get even more confused about why the parameter doesn’t work as expected.

Once you have defined a parameter as either instance or type, you can change it if required
for the desired behavior. Just keep in mind that Revit will not let you change a type parameter
to an instance parameter if that parameter is used in a formula of a type parameter. The rule
of thumb is that instance parameters can’t “drive” type parameters. Thus, it is best to know up
front what kind of parameter to create.

Setting Parameter Discipline, Type, and Grouping

The Discipline drop-down list in the Parameter Properties dialog box contains the different dis-
ciplines that can be assigned to a parameter. Parameter discipline is important for defining the
measurement units that the parameter value will have. Figure 6.4 shows the drop-down list of
available disciplines.

The Type Of Parameter option in the Parameter Properties dialog box is directly related to
the chosen discipline. Each discipline has a unique set of parameter types that relate to the vari-
ous units of measurement for that discipline.

Figure 6.5 shows the Type Of Parameter options for the Common discipline. Notice that
many of the types are the same as in the Project Units settings for the Common discipline of a
project, such as Length, Area, and Volume.
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There are additional options for parameter values that are not a unit of measurement.

The Text option allows you to input anything for the value of the parameter. This is the most
versatile option, but from an engineering standpoint, it offers the least amount of “intelligence”
because a text string provides only information, not computable data. If the parameter value
doesn’t have specific units and will always be numbers, it is best to use Number instead of Text;
this will allow you to use it in formulas if you ever need it. If you are creating a parameter that
is scheduled and want the ability to input either numbers or text or a combination of characters,
then the Text option is best.

The <Family Type. . > option for a parameter is a useful tool when you have multiple nested
families within a family. You can create a Family Type parameter to toggle between all the
nested families. When the host family is loaded into a project, the parameter can be modified
to display any of the nested families by selecting from the list in the Family Type parameter.
Figure 6.6 shows an annotation family for graphic scales with several nested annotations
loaded. A Family Type instance parameter has been created to allow the use of any of the
nested families.
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You can use the Yes/No option if your parameter requires a simple yes or no value. The value
for this type of parameter appears as a check box in the Properties palette, and it can be used to
control the visibility of objects or to verify that a condition exists. In schedules, a Yes/No param-
eter appears as Yes, No, or a blank field. By default, Yes/No parameters are selected and grayed
out in the Properties palette, which means it’s in a limbo state that is neither yes nor no; this is
when it will appear as a blank field on a schedule.

Other disciplines have options for Type Of Parameter that relate to units of measurement.
When you select a specific Type Of Parameter setting, the value used for the parameter must be
consistent with the unit of measurement. For example, if you choose the Air Flow option for the
HVAC discipline, you could not input any value other than a number consistent with the unit of
measurement you are using for airflow. This can cause problems with schedules when an object
does not have a value for this parameter and you want to use something such as N/A or a dash
to indicate that the value is not actually 0.

By default, the Type Of Parameter option is set to Length. This was introduced in Revit MEP
2011, whereas in older versions the default was Text. In older versions, it was easy to overlook
this setting because of the versatility of the Text type. With Length as the default now, Revit
defaults to the most common parameter, but it is still important to set the proper type if Length
is not what you need.
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You can determine where the parameter will show up in the Properties palette or the Type
Properties dialog box of an object, as shown in Figure 6.7. However, Revit will make a best guess,
placing the HVAC/Airflow parameter into the Mechanical — Airflow group or the Electrical/
Luminous Flux parameter into the Photometrics group, for example. The user can override this
but should consider other users and content creators. If you are using shared parameters, it may
well be a best practice to accept the defaults, unless the company documentation is very good.
This will lead to less confusion because coworkers will know where to find similar data in fami-
lies and projects.
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The option for grouping parameters is sometimes confusing to people because they think
that it is related to the Type Of Parameter setting. The Group Parameter Under setting does not
have any bearing on the Type Of Parameter and Discipline settings, so you could have a Duct
Size parameter that is placed in the Identity Data group. Parameter grouping is another area in
which being consistent is important to improved workflow and efficiency. You want to be able
to find your parameters in the same location for each family while editing in your model. If
you are not going to use the default for Group Parameter Under all the time, it may be a good
idea to take it a step further and create a company-standard document that outlines what Type
Of Parameter setting goes in what Group Parameter Under setting. By finding the same param-
eters always in the same group, your users will be more efficient and comfortable with your
company families.

You also have the ability to either sort parameters alphabetically (Ascending or Descending)
or move them by using the additional buttons available in the Family Types dialog box, as
shown in Figure 6.8. When new parameters are added to a new family, they are automatically
sorted alphabetically. If a family is upgraded from a previous version, the user then has the
ability to sort the parameters with the Ascending or Descending button. Once the parameters
are sorted, you can move each parameter up or down within each group. This means impor-
tant parameters can be pushed to the top of a group, even though you may have sorted them
alphabetically.
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The current version of Revit does not allow users to customize any of these pull-downs. This
creates challenges with various units that may need to exist at the same time in the project. A
good example for that is the Power unit of measurement; it can be watts, BTU per second, horse-
power, and a few more choices. But in a real project, chances are you will want to use horse-
power for motors, watts or volt-amperes for electricity distribution, and maybe kilowatts for the
entire building or major blocks of the building. In reality, you can’t do that with Revit.

If you create a family that uses different units for certain parameters, the family units will
be changed after it is loaded into the project. This is a significant roadblock for achieving true
BIM because there are industry standards for the units (W, VA, KW, and so forth) that need to
be used for a specific parameter. In most cases, the information (the I in BIM) becomes second in
priority in order to complete the project in a biddable and readable fashion, which in many cases
would involve using either numbers or text parameters instead of actual units. As a result of
such workarounds, you may not be able to circuit certain devices or show their load on the panel
schedules unless the chosen units are the same for the entire project.

Using Parameters in Families

Parameters are created when working in the Family Editor. As content is planned, created, or
edited, it becomes clear which type of data is needed for either analysis or reporting or to drive
the geometry. When you're working with Revit families, you’ll come across the term flexing,
which essentially means changing dimensional parameter values to test whether a family is
parametric (flexible) and can take various parameter values without being broken. Flexing a



USING PARAMETERS IN FAMILIES | 147

family can be done through the Family Types dialog box, by modifying a series of parameters
and clicking OK. Another way to flex a family is to modify the parameter value directly in a
plan view or any other view. All you need is to select the parameter and enter a different value
for it. A third method of flexing a family is to select a reference plane and move it in order to flex
the parameter value indirectly. This last method is further explained in the next section.

Dimensional Parameters Lock Function

You have the ability to lock dimensional parameters in the Family Editor so that they cannot be
changed while working on the geometry of a family. There is a Lock column in the Family
Types dialog box with a check box for each dimensional parameter. What is nice about this
feature is that if you do not lock a parameter, you can change its value while working on the
geometry, eliminating the need to stop and access the parameter to change its value manually.
An object that is constrained by a dimension can be moved and the parameter’s dimension
value will adjust. This eliminates the pesky Constraints Are Not Satisfied warning dialog box
that appeared in versions earlier than Revit MEP 2012. However, this warning will appear if a
dimensional parameter is locked and an object is moved.

You can also edit the value of a dimensional parameter in the drawing area by clicking the
text, just as you would edit a dimension object. This can be done whether or not the parameter is
locked. Locking prevents only the accidental dragging of an object while you're working in the
drawing area.

Parameter Types

When creating type parameters in a family, you set a specific value for each family type. When
the family is inserted into a project, the values established in the family will remain until the
family type is edited. Changing a type dimension, or any other type parameter in a project,

has to be carefully considered. Do you want to change a standard object, which could affect
many instances of a family, or should you create a new family type? The answer to this may not
always be as simple as it first seems.

@ Real World Scenario
PARAMETER TYPES

While creating a lighting plan, Samir loads a family—Recessed Parabolic Luminaire, type 24—
and places it in multiple locations. During the design process, the engineer indicates that she wants
a different layout with 2’2’ fixtures. Samir could change the type parameter for length to 2" and
have an immediate result. However, he knows that by doing so, he is not changing many of the other
design criteria parameters, so he duplicates the family type, creates a new 2’x2” type, and enters
the design and dimensional parameters. He now needs to select and change the required existing
luminaires from their current type to that new one. Although this process may take slightly longer
than the first option, Samir is confident that any calculations will be correct and future changes
will take even less time to make.
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Instance parameters have a default value when created in a family. These parameters are
easily identified in the Family Types dialog box via a suffix of (default). This is the value the
parameter is meant to have initially when it’s placed into a project. The first attempt to place an
instance of a family does not always have the default value defined in the family for an instance
parameter. Subsequent placement of the same family uses the last input value. The value can be
modified prior to placement of the family.

If you edit a family that exists in your project and then load it back into the project, the
instance parameter values do not change from their existing states in the project. When you are
loading a family into a project and a type parameter value in the family is different from those
in the project, a dialog box that warns you that the object already exists in the project gives
you the option to “overwrite the family and its parameter values,” which will change any type
parameters to the value as it exists in the family. All instance parameter values will remain
unchanged even if they are different in the family.

As mentioned earlier, Yes/No parameters are great for controlling the visibility of objects.
After creating a Yes/No parameter, you can select the desired object and set its Visibility
parameter to the value of the Yes/No parameter by using the small button at the far right of
the Visibility parameter value in the Properties palette. Figure 6.9 shows the settings used to
associate the visibility of the diagonal line with a Yes/No parameter.

YES/NO PARAMETERS IN NESTED ANNOTATION FAMILIES

To control the number of annotation families that are nested into a family, Yes/No parameters
within an annotation are very useful. One example is for electrical receptacles. Many receptacles
look essentially the same in the model, but the symbol used for each type may vary. Instead of
creating a separate annotation symbol for each type of receptacle, consider using Yes/No parameters
within one annotation to account for each symbol. The image shown here is an annotation family
with all of the linework and regions required to represent each type of symbol used.
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The visibility of the lines and regions is associated with Yes/No parameters so that when this
annotation is nested into a family, the Yes/No parameters can be associated with parameters in
the family. The result is a single receptacle family that can represent multiple types of receptacles,
as shown here. Another way of accomplishing similar results is using the Family Type option men-
tioned previously.
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Type Catalogs

Families can sometimes become crowded with many types. The number of type parameters
used to define a family type potentially increases the number of family types. When these
families are loaded into a project, all of the family types are loaded. This can quickly cause your
project to be overloaded with unused family types. One way to remedy this scenario is to create
type catalogs for families that contain many types.

A type catalog is a TXT file that contains values for the type parameters of a family. Having a
type catalog associated with a family allows you to select only the family types you want to load
when you insert the family into a project. You can create a type catalog for a family by creating a
TXT file that has the same name as the family and is located in the same folder as the family file.
Because type catalogs are TXT files in comma-delimited format, it is easier to edit them using a
spreadsheet program such as Microsoft Excel.

To create a type catalog from scratch, start a new spreadsheet file. Enter all the family types
in the first column of the spreadsheet. Each column after that will be a type parameter within
the family. The type parameters must exist in the family file and have some value in order to be
used in the type catalog.

You can have both type and instance parameters in a type catalog. If you leave a parameter
value blank in the family, the type catalog will ignore the parameter when the family is loaded.
So, even though the parameters in the family are essentially placeholders for the type catalog,
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they need to have something input for their value. Figure 6.10 shows an example of a type cata-
log for a motor connection family.

10x10-5 10 10 2.5 10|
10x10-6 10 10 3 10|
10x10-8 10 10 4 10/
12x10-5 12 10 2.5 10|
12x10-6 12 10 3 10
12x10-8 12 10 4 10|

N e e e

It is easy to see why a type catalog for this family is used; otherwise, all 15 family types
would be loaded when this family is inserted into a project. Notice that the format for the type
parameters is

,parameter namef##fparameter type##units##

You can cheat with the parameter type a bit: instead of remembering the proper formatting
for all units, in most cases you can use Other.
Here are a few examples of proper formatting:

,Duct Width##HVAC_DUCT_SIZE##INCHES
,Power##ELECTRICAL_POWER##WATTS

,Air Flow##HVAC_AIR_FLOW##CUBIC_FEET_PER_MINUTE
,Width##LENGTH##FEET

A metric version of this could be
,Duct Width##HVAC_DUCT_SIZE##millimeters

At first the formatting can be confusing, and if you don’t have a cheat sheet, it will be hard to
remember it for the various parameters. However, if you look closely, you are probably noticing
a pattern; you can make sense out of all this instead of just trying to remember it. Let’s take a
look at the Duct Width parameter, for example. When you are creating this parameter, you need
to select options for Discipline (HVAC), Type Of Parameter (Duct Size), Group Parameter Under,
and whether it will be Instance or Type, as shown in Figure 6.11. Now look at the formatting for
the preceding Duct Width parameter again. You can see that the syntax is as follows: <param-
eter name>##<Discipline_Type of Parameter>##units. That’s a lot easier than remembering
several different configurations.

You can create a type catalog by exporting parameters from a family. Note that this method
is not available in versions of Revit from 2011 and earlier, so the previous method should be
used. In more complex families containing a lot of parameters that don’t need to be controlled
via a type catalog, the previous method would still be more efficient. To create a type catalog by
exporting parameters from a family, do the following:



FIGURE 6.11 Parameter Properties ﬂ
Parameter ~Parameter Type
settings ' Eamily parameter
(Cannot appear in schedules or tags)
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(Can be shared by multiple projects and families, exported to ODBC, and
appear in schedules and tags)
Select. ., Export. .,
~Parameter Data
MName:
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Type of Parameter: I Reporting Parammeter
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While editing the family you want to create a type catalog for, choose Application >
Export > Family Types. This exports the type parameters in a TXT file that you should
save in the folder in which the family is located. This is the fastest way to create a type
catalog; the downside is that it will contain all type parameters and in most cases you
will need to clean it up a bit.

Create the spreadsheet and save it as a comma-separated values (CSV) file. If you receive
a warning that some of the features of the file may not work when saved to CSV format,
you can click Yes to save the file.

Once the file is saved, you can browse to it and rename the file with a . txt extension to
convert it. If you receive a warning that the file might become unusable when the file-
name extension is changed and asks if you want to proceed, click Yes.

Eﬂ Supply Diffuser - Perforated - Rectangular MNeck - Ceiling Mounted.rfa
|| Supply Diffuser - Perforated - Rectangular Meck - Ceiling Mounted. txt
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When a family with an associated type catalog is inserted into a project, a dialog box will
appear that allows you to see the parameter values for each type and choose which fam-
ily types you would like to load.

3. Choose family types by selecting them from the list. You can select multiple types, as
shown in Figure 6.12. Or you can filter the Specify Types dialog box based on specific
parameter values by using the drop-down list under the heading of each column.

FIGURE 6.12
Specifying types p Tipes
Supply Diffuser - Perforated | - S -
f t | Type ‘ Diffuser Height | Diffuser Width ‘ Duct Height ‘ Duct Width | Flow Pressure Drop
romatype [E0) =i i 0] N @ = @) ,, @ = [0} ~]
catalog ) 15664 =

n Ne
(482912 Tn Nedk

= 21/256 :
121356 i33/358° 0.330

K LILI

Select ane or more types on the right for each family listed on the left ok Cancel Help

DRAG AND DROP FAMILIES WITH A TYPE CATALOG

The type catalog functionality of a family will work only if you use the Load Family option from
the Insert tab of the ribbon. Dragging and dropping a family file that has a type catalog into your
project will load only the default type. To access the type catalog after a family has been loaded
into your project, you can locate the family in the Project Browser, right-click, and select Reload.

Formulas

Not all parameters in a family are used to drive the geometry directly; many are used to hold
data that results from the creation of the geometry and that will be used for driving additional
geometry or spatial relationships. This is done by creating a formula for a parameter. Formulas
can vary in complexity and functionality, as shown in Figure 6.13. Pipe fittings are notori-

ous for their complexity and the number of formulas they need in order to create the desired
functionality.

One nice feature of formulas is that when you change a parameter name, it will be updated
in all formulas where this parameter is used. Mathematical operators and Boolean functions can
all be used. Placement of parentheses, proper units, case, parameter names, and context sensitiv-
ity are all important for your formulas to work properly. A warning will appear if the result of a
formula does not match the units for a parameter or if a parameter name is misspelled.

Formulas can even be used for parameter types such as a Yes/No parameter. Figure 6.14
shows a Boolean formula used to determine when a check box should be selected for a Yes/No
parameter. The formula indicates that the box is either deselected or selected when the condi-
tions of the formula are true.



FIGURE 6.13
Formulas in
fittings

FIGURE 6.14
Boolean formula
for a Yes/No
parameter

Formulas using if statements are powerful for providing exact conditions and variations in
parameter values based on other parameter values. The format for an if statement is as follows:

[N Family Types. =
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Name: [standard =
Value Formula Lock []
K Coefficient from Table

~Family Types
New...

Regular Flanged 30 and 180 Elbo

=size_lookup{Lookup Table Name, "WThk", 0.02 * Nominal Diameter + 3/16", W

Rename...
Delete

=Flange Outside Diameter * 0.4

e looHap(Lookup Tabie Nam:

. =size_lookup{Lookup Table Name, "RED’, 0.47 = Nominal Diameter +4 39/25 W_ eopessnsnecl
jominal Diameter + 126/25 [w

e lookup{Lockup Table Name, "RFD¥,

i

Hominal Diameter +1201/25 [~

size_lockup(Lookup Table Name, “FTRK’, 0.05 = Nominal Diameter + 145/25 [

.. ZFittng Tnsde Dameter +WalThness =2

[ Parameters.
Add...

Modify...
Remove

JaxTax

— Nominal Radius =2 Move Up |
: h 97 * Nominal Diameter + 35/; Nominal Diameter)
= ifland(Angle > 0°, (not{Angle > 45%)), F(Center to Contact Surface 2 > Fit [¢] Move Down |
=size_lookup{Lookup Table Name, "Ct8", 0,68 *Nominal Dismeter +215/16" [~~~ —_———
‘= size lockup(Lookup Table Name, “FOD", 1.2 = Nominal Diameter + 4 17/256 [ ~Sorting Order ———
- Jookup(Lookup Table Name, "BThk", 0,03 = Nominal Diameter + 129/25 [@
okiptoshp T2t Nome, B, 0.02 - Neri QRS RO reners
dBasef Flanged -C5 -Ci= I I =
= Center to Base + Center to Contact Surface - Length 4 - Flange and Raised [
. i=Center to Cantact Surface = sin(Angle) o Lookup Tables
= Center to Contact Surface + Center to Contact Surface * cos{Angle) ~ = Nerge
[»
ok | cnd | ooty | Help |
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size_lookup(Lookup Table Name, "FID", 0.97* Nominal Diameter + 35/256", Nominal Diameter)

I Parameter ‘ Value

Formula

Default Elevation 3 1131/128"

Materials and Finishes

Diffuser Material <By Category>

l1ec||amca| Fluw

ning (default) v

or{Flow > Max Flow, Flow < Min Flow)

F|O'N (default) 600,00 CFM =
Max Flow 500.00 CFM =
Min Flow 0.00 CFM =
Pressure Drup (default) 0.3938 in-wg =
Duct Width = |
Duct Height 5" = v
Diffuser Width 1 011287 = ¥
Diffuser Height 10" = m

Neck Half width

=Duct Width =1/2

=
Neck Half Height D‘ 3' =Duct Height * 1 /2 v
Diffuser Half Width 0 6 1/256" =Diffuser Width =1 /2 ~d
Diffuser Half Height g =Diffuser Height * 1 /2 v

Assembly Code

Identity Data

[Type Image

Keynote

Model

if(logical_test,value_if_true,value_if_false)

The value_if_falseresult is the value given to the parameter when the condition is not met.
You can use other parameters to define the condition. For example, if you want a Width param-
eter to equal the Length parameter under certain conditions, you could write this formula:

if(Length>2'

0", Length, 1' 0")

if(Length>600mm, Length, 300mm)
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This formula would cause the Width value to equal the Length value when the Length is
greater than 2”-0” (600 mm); otherwise, the Width value would be 1-0” (300 mm).

CROSSING PARAMETER TYPES IN FORMULAS

When referencing a parameter in a formula, it is important to know that you cannot use an instance
parameter in a formula for a type parameter. You would need to either change the type parameter
to an instance or change the instance parameter to a type parameter.

@ Real World Scenario
PARAMETER USE

Starting a new job in a consulting engineer’s office, Brian finds that the drafting standard is to
indicate duct type and construction by using textual information rather than doing so graphically.
This means having 18 duct types defined in the project template, each with an identical Type Mark
parameter. However, duplicate type marks produce an error message (which can be ignored). The
way around this is for Brian to create his own shared parameter type mark, MyCo Type Mark. This
method works well for Brian, allowing him to maintain his drafting standards and maximize his
efficiency.

Autodesk Revit 2016

[ Warning - can be ignored
Elements have duplicate Type Mark' values, d

=

Show | IMare Info | Expand >> |

System Parameters

When you create a family, certain parameters exist by default. These parameters are hard-coded
into the software and cannot be removed. You can use these parameters to avoid having to
create custom parameters.

These parameters vary depending on the category you choose for the family. The system
parameters under the Identity Data group are common to component families and are also
included in system families within a project.

| Parameter |

Identity Data

Assembly Code
Cost
Description
Keynote
Manufacturer
Model

Type Comments
Type Image
URL
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There are, however, a few that do not appear in the Family Types dialog box when you're
working in the Family Editor but do appear in the Type Properties dialog box or the Properties
palette after the family has been loaded into a project. The most notable of these are the Type
Mark, Offset, Level, Host, Mark, Phase Created, and Phase Demolished parameters. The Type
Mark parameter is often used to identify a component with a tag or in a schedule. Because
this parameter does not exist in the family file, you cannot use it in a type catalog. One way
to avoid creating a custom parameter that does essentially the same job as the Type Mark
parameter is to have your type catalog create family types named with the same value you
would use for the Type Mark. Then you can tag or schedule that type parameter instead of
the Type Mark parameter. To appear in a schedule or a tag, the parameter has to be a shared
parameter.

Lookup Tables

Lookup tables are designed to drive instance parameter values via an external CSV file. They
are similar to type catalogs in that they store parameter values. But type catalogs are meant for
type parameters (even though in recent versions of Revit MEP you can control instance param-
eters with them as well in order to set the default value when the family is placed). Perhaps the
main difference between type catalogs and lookup tables is that type catalogs are accessed by
Revit MEP when you are loading a family, whereas lookup tables are loaded when the software
launches and Revit MEP refers to their data when required. Lookup tables can be embed-

ded into each family, which is done using the manage button for lookup tables in the family
types dialog of the family editor. In addition, type catalogs must reside in the same folder as
the family; lookup tables are located in a different location than the family. Lookup tables are
mostly used for pipe, duct, conduit, and cable tray fittings. But they can be used for anything
else that requires constant referencing. When you install Revit MEP 2016, an extensive library of
lookup tables is installed that can be referenced by families.

Lookup tables are CSV files that work like a type catalog. They provide values for dimen-
sions based on other dimensions within the family. The data in lookup tables can be driven
by design codes or manufacturing standards to ensure the graphical accuracy of your com-
ponents. Pipe fittings, for example, have a nominal diameter that is used to identify the size,
but the actual outside diameter is slightly different, especially for different pipe materials.

A lookup table can provide the outside diameter dimension for each nominal diameter that
exists in the table.

Since Revit 2014, content creators have had the ability to embed lookup tables directly into
the family. In fact, the majority of families that are installed by default already have lookup
tables embedded. This greatly reduces the issue of having to ensure that the table travels with
the family (within a project) not only when being issued to external sources but also when your
IT department is reluctant to place additional files into your lookup table folders on a protected
network drive or into folders distributed to each computer on the network. With the lookup
table embedded into the family, you will always get a correctly sized family regardless of where
that family is loaded.

The Lookup Table Name parameter is used to identify which CSV file the family is referencing.
The location of your lookup tables is defined in your Revit.in1 file. When you type in the
name of a lookup table, you do not need to include the full path to the file, only the name and
filename extension. As with parameter names, referencing a lookup table name is case and
context sensitive.
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FIGURE 6.15 Parameter Value e =
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Once you have referenced the lookup table with the Lookup Table Name parameter, you can
access the data in the table by using a formula for the value of a parameter. The formula using
lookup table data is as follows:

text_file_lookup(Lookup Table Name, "Column Name", .
Value if not found 1in table, Value found in table)

The result of this formula will apply the value found in the table to the parameter, or it will
apply the defined value given in the formula if none is found in the table. Figure 6.15 shows
the formula used to determine the value of the Fitting Outside Diameter (FOD) parameter of a
pipe-fitting family. The FOD column is searched for a value that coincides with the value given
for the Nominal Diameter parameter, and that value is applied to the FOD parameter. If the
Nominal Diameter value given in the family does not match one in the table, then Nominal
Diameter + 4 17/256” is used for the FOD.

K Coefficent from Table
<guler Flanged 50 and 180

|K Coeffient Table
KCoeffident ...

= size_lokup(Lockup Table Name, "WTHK', 0.02 * Nominal Diameter + 3/16, Nominal Diameter) [
=Flange Outside Diameter 0.4 »
= size_lookup(Lockup Table fiame, “REDY, 0,47 * Nominal Diameter + 4 39/256°, Nominal Diameter

= size_lookup(Lookup Table Name, “RThk", 0.03 = Nominal Diameter + 129/256", Nominal Diameter
= 116"
= size_lookup(Lookup Table Name, “RFD", 1,1 * Nominal Diameter + 1 201/256°, Nominal Diameter
< size_lockup(Lookup Table Name, “FThK", 0.05 = Nominal Diameter + 145/256", Nominal Diameter
g = Fitting Inside Diameter +Wall Thickness * 2 3
Nominal Radius (default) 1" = ~
I = Nominal Radius =2 3
J

= size_lookup(Lookup Table Name, “FID", 0.97 * Nominal Diameter + 35/256°, Nominal Diameter) [v
=if{and(Angle > 0%, (not{Angle > 459)), if(Center to Contact Surface 2 > Fiting Outside Radius
= size_lookup(Lookup Table Name, “Ct", 0.68 * Nominal Diameter + 2 15/16, Nominal Diameter)

ookp Tabie Name, )
lockup (Lookup Table Name, “BThk", 0.03 * Nominal Diameter + lominal Dizmeter v

Angle (defauit)

Lookup Table Name

= Center to Base + Center to Contact Surface - Length 4-Flange and Raised Face Thickness %
/ 3 = Center to Contact Surface * sinfAngle) [

size_lookup(Lookup Table Name, "FOD", 1.2* Nominal Diameter + 4 17/256", Nominal Diameter)

For additional information on working with parameters in family files, another good refer-
ence point is the Autodesk Help site:

http://help.autodesk.com/view/RVT/2016/ENU

Browse to Customise Revit > Creating Loadable Families.

Using Shared Parameters

Shared parameters are the most versatile parameters you can use, but they also require the most
management. Used properly, shared parameters can help ensure that your schedules are coor-
dinated and that your construction documents are reporting the correct information. Shared
parameters can be type or instance parameters that are used in families or as project param-
eters. The main advantage to using shared parameters is that the data they hold can be exported
or reported in tags and schedules.

Shared parameters are parameters that are created with their settings stored in a TXT
file. It may help to think of this file as a library of parameters, similar to a library of model
components.


http://help.autodesk.com/view/RVT/2016/ENU
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SHARED PARAMETERS FILE

Do not attempt to edit your shared parameters’ TXT files with a text editor. They should be edited
through the Revit interface only.

When you need to add a parameter to a family or project, you can use one from your shared
parameters file. This helps with the management of your content and project standards because
you can be consistent in your use of parameters. It also helps with maintenance by allowing you
to avoid duplication of parameters, which can cause coordination issues. Multiple parameters
with the same name can show up as available for use in a schedule, and you will not be able to
tell which one is the correct one to use.

You can create a shared parameter by doing the following;:

1. Click the Shared Parameters button on the Manage tab. When you create a parameter in
the Family Editor or add a project parameter, you have the option for it to be a shared
parameter. Selecting this option activates the Select button in the Parameter Properties
dialog box.

2. In the Edit Shared Parameters dialog box, you must first create a shared parameters file.
Click the Create button to select a location for the file.

You can have multiple shared parameter files, so it is a good idea to create a folder in a
common location that you and others can access. But keep in mind that having multiple
shared parameter files may be asking for trouble because you have to manage each file,
ensuring that no duplicates exist.

You can access these files by clicking the Browse button in the Edit Shared Parameters
dialog box, which is shown in Figure 6.16.

FIGURE 6.16 ﬂ
Edit Shared

Shared parameter file:
Parameters
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X

Parameter group:

Parameters:
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Delete

Groups

[~ Parameters

New...

Rename...
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There are two components to a shared parameters file. The parameter group is a level of
organization that you can establish to group parameters together. This is not the same
group as shown in the Parameter Properties dialog box for defining where parameters
will be listed. These groups are available so that you can keep your shared parameters
organized. One common method of organization is to create groups based on family
categories. Figure 6.17 shows an example of parameter groups created for parameters
that apply to specific family categories. This method is intuitive and could help you find
the parameters you need for the family you are creating much faster. But there are many
parameters that will be used across multiple families (Length, Air Flow, and so forth),
and it could be confusing.

Shared parameter file:
I E:\BACKUPAuthoring \Wiley \Mastering Re Browse. .. | Create... |

Parameter group:

VAV Units N =l

Air Terminals i

Electrical Equipment —

Lighting Fixtures HEEIRER
Mechanical Equipment MNew...

Sprinkler Data

Properties.. .
[Mave..,
Delete

Groups

New...

Rename...
Delete

OK I Cancel | Help |

VA

Notice that a group has been created for variable air volume (VAV) units. Although it

is possible to create a group with any name, keep in mind that the parameters must be
assigned to a category. In the case of these parameters, they will be applied to all mechan-
ical equipment if they are used as project parameters, even though they are specifically
designed for VAV units. The parameters in this group could be added to a lighting fixture
family if chosen. Parameter groups can be renamed or deleted by using the buttons in the
lower-right corner of the dialog box. You cannot delete a group until all parameters have
been removed from it.

Another way to organize your shared parameter groups is to use the Group Parameter
Under pull-down in the Parameter Properties dialog box. When you use this method, the
position of the parameter grouping will be identical in both the shared parameters file
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and in the properties of the family, as shown in Figure 6.18. If you choose this method,
don’t hurry to create all of the groups exactly as they appear in the Parameter Properties
dialog box. You will find that half of those groups are unnecessary, and you may never
use them. So, create only what you need, and you can always add more as you find them

necessary.
FIGURE 6.18 Parameter Properties =
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3. After you have established a group in your shared parameters file, you can begin to
create parameters. Click the New button in the Parameters section of the Edit Shared
Parameters dialog box to open a Parameter Properties dialog box. This is not the same
dialog box that you get when you create a parameter in the Family Editor or in a project.
This is a simple dialog box, because all you need to define for a shared parameter are the
Name, Discipline, and Type Of Parameter settings, as shown in Figure 6.19. The param-
eter that you create will be added to whatever group you have active when you click the
New button. It is also worth considering a handy tooltip, so your users know exactly
what the parameter is for.

The Name, Discipline, and Type Of Parameter settings are the same options used for
creating a family parameter.
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FIGURE 6.19 £

Parameter Properties
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e
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4. Once a parameter has been created, you can select it and click the Properties button to
view its settings. The settings cannot be changed after a parameter has been created. If
you want to change a shared parameter, you have to delete it and re-create it with the
new settings. If you do so, you will have to add the parameter back to any object that had
the parameter you're replacing.

5. If you create the parameter in the wrong group, however, all is not lost. Simply select
the parameter and click the Move button, which allows you to move the parameter to
another group.

Choose and establish shared parameter settings very carefully. A parameter that is deleted
from your shared parameters file will remain in families or projects—you will not be able to add it
to anything new. There is a get-out-ofjail clause here if you have deleted a shared parameter that
you later wish to keep. Open any family or project where you know the parameter exists. Select
the parameter in the Type Properties dialog box and click Modify. Once you're in the Parameter
Properties dialog box, click the Export button. If Export is disabled, then either there is no shared
parameter assigned to the session of Revit or it already exists in the shared parameter file. Clicking
the Export button exports the shared parameter to a parameter group called Exported Parameters
in the shared parameters file, and the parameter can be moved if necessary, as described earlier.

You can add a shared parameter to a family by doing the following;:

1. Select the Shared Parameter option in the Parameter Properties dialog box. This activates
the Select button, which opens the Shared Parameters dialog box.

2. Choose the group that contains the desired parameter, and then select the parameter
from the list.

3. Once you click OK, you still need to define whether it will be a type or instance param-
eter and where it will be listed. These are the only two settings that can be modified after
the parameter is added to the family.
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4. Click the Edit button in the Shared Parameters dialog box to open the Edit Shared
Parameters dialog box, where you can browse to another shared parameters file or make
changes to the active file.

5. Once you exit this dialog box, you still need to select the parameter from the Shared
Parameters dialog box to add it to the family. Once a shared parameter is added to a family,
it can be used as a constraint or in formulas (just like any other parameter).

Managing shared parameters should be treated with the same importance as managing your
content library. Because these parameters provide intelligence that carries through from a family
all the way to your construction documents, it is important that they are maintained and used
correctly. Preventing users from having full access to this file is one way of managing this, much
in the same way as many libraries have restricted, read-only access.

One category for which shared parameters can become cumbersome is the Mechanical
Equipment category. Typically, many characteristics of a mechanical unit are required to be
scheduled, so shared parameters are necessary. Some of these characteristics are the same
unit of measurement, but for a different component of the unit. Since you cannot add the same
shared parameter to a family more than once, you may need to make multiple parameters of
the same type. It is best to try to keep your shared parameters as simple as possible for this cat-
egory. Naming parameters specifically for their use is helpful in keeping track of them. In addi-
tion, developing a standard for where these parameters are grouped in the families will help
you avoid confusion when editing the properties of a family.

Even though it may initially require a bit of work, adding these parameters directly to your
mechanical equipment families rather than as project parameters will go a long way in keeping
your families from becoming overcrowded with unused parameters. Consider keeping a docu-
ment such as a spreadsheet that lists all of your custom parameters and indicates whether they
are family or project parameters, what parameter groups they exist in if they are shared param-
eters, where they are grouped in the properties of a family, and whether they are used as type
or instance parameters. Having this document open will be helpful when creating new content,
because you will know what parameters already exist and how to use them. As new parameters
are created, the document can be updated. If you work in an environment with multiple users,
it is best to keep only one copy of this document in a common location. You can organize the
file and list the family in which the parameter is used or you can do it by schedule. Figure 6.20
demonstrates a sample Microsoft Excel file that manages the shared parameters by schedules
that they belong to.

FIGURE 6.20 ; 2 0 ! B
Sample Excel file : ey
organizing all shared
parameters

34 4270004 00384143 BO4- 111192
= ety ceamaie:
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Using Parameters in Projects

Parameters are typically handled at the component level for building objects, but there are also
parameters for noncomponent objects such as views, sheets, and annotations. You may need to
create custom parameters for system families that cannot be edited in the Family Editor. These
parameters can be added to designated categories within your project so you can assign them
to system families. Your projects themselves can have parameters that convey project-specific
information. Understanding how to use parameters in a project is the key to getting the most
benefit from constructing an intelligent model with computable data.

Project Parameters

The only way to add a parameter to a system family such as Ducts, Pipes, Conduits, and so forth
is to add it by creating a project parameter. This allows you to customize the information you
want from elements within the model. Space objects can be given a lot of useful data to help you
make design decisions and analyze the model performance. Project parameters make it possible
to add this data to spaces and other elements that cannot be physically edited.

You can add a project parameter by clicking the Project Parameters button on the Manage
tab. In the Project Parameters dialog box, you can see a list of any parameters that have been
added to the project. Clicking the Add button opens the Parameter Properties dialog box, shown
in Figure 6.21. This is the same dialog box as in the Family Editor but with additional settings to
assign the parameter to an object category. The object category list includes all the component
families, system families, in-place families, and even metadata that may not be physical geom-
etry, such as views, sheets, project information, and so on.

FIGURE 6.21 zl
Parameter Properties - Parameter Type - Categories ————————————————
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Discipline: " Instance -] Detail kems
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The settings for creating a parameter or adding a shared parameter are the same for project
parameters. The only difference is the Categories section of the dialog box. This is where you
can select the Revit category to which the project parameter you are creating or the shared
parameter you are loading is applied in the project.
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Project parameters are a great way to use shared parameters in families without having to
edit each family individually. The check box in the lower-left corner indicates that the param-
eter will be added to all elements in the project that belong to the selected category. So, if there
are parameters that you want to use on a particular category of elements, such as light fixtures,
you can create the parameters as shared parameters and then load them as project parameters
into your project template file. Then, whenever you load a family belonging to that category
into your project, it will have the desired parameters, which can be used for scheduling or
tagging.

Additionally in this dialog box are the radio buttons Values Are Aligned Per Group Type
and Values Can Vary By Group Instance. They appear uneditable when Type Of Parameter is set
to the default Length. If it is set to Text, Area, Volume, Currency, Mass Density, URL, Material,
Image, Multiline Text (a new addition to Revit 2016), or any one of the discipline-specific param-
eters, you will be able to switch between the two.

Values Are Aligned Per Group Type (Default) If an element with this instance parameter is
part of multiple groups, the parameter value will be the same for corresponding elements in all
group instances. While in Edit Group mode, you can select the element and modify the
parameter on the Properties palette. Changing the parameter value for the element in one
group will change the value for the corresponding element in all other instances of the same
group type.

Values Can Vary By Group Instance If the element with this instance parameter is part of
multiple groups, the parameter value can vary for corresponding elements in group instances.
While in Edit Group mode, you can select the element and modify the parameter on the
Properties palette. Changing the parameter value for the element in one group will not change
the value for the corresponding element in other instances of the same group type.

If you change an existing parameter from Varies to Aligned, an error message appears, list-
ing the elements with the parameter that will change. If you click Align Parameter Values, then
all group instances will update to have the same parameter value. The value applied is the value
that was assigned to the element in the first group instance.

DUPLICATE PARAMETERS

It is possible to create a project parameter with the same name and settings as a parameter that
already exists in the elements to which it is being applied. This may not pose a problem for objects
alreadyloaded into your project, but keep in mind that a component may be loaded that already has
a parameter equal to one of your project parameters. Managing project parameters is as essential
as managing shared parameters and content.

When you add a parameter to your project and it is applied to elements in the chosen cat-
egory, the parameter will not have a value. You can easily give the parameters values by creating
a schedule of the elements and including the project parameters in the schedule.

Yes/No type parameters will be set to Yes (selected) by default and appear to be uneditable
when they are viewed in a schedule or the properties of an element. You can click the grayed-
out check box once to make it editable.
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FIGURE 6.22 x|
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Parameters in Schedules

Family parameters and some system parameters cannot be used in schedules. If you do not
want to use shared parameters in your families, you can create project parameters for schedul-
ing information about components. In the Schedule Properties dialog box at the center of the
Fields tab is an Add Parameter button, as shown in Figure 6.22. Clicking this button opens the
Parameter Properties dialog box; this is the same dialog box that you get when you click Project
Parameters. Essentially, you can create project parameters from the Project Parameters dialog
box or from a schedule. All of them will appear in the Project Parameters list.

However, there is a difference depending on whether you create them from the dialog box or
from a schedule. When you create the parameters from a schedule, they will automatically be
applied to the category of the schedule. For example, if you are scheduling mechanical equip-
ment, creating a parameter in that schedule will automatically apply it to all mechanical equip-
ment. But what if you want the same parameter to apply to other object categories as well? You
can do this from the Project Parameters dialog box, where you will be given the opportunity
to select any additional categories. As we mentioned in the beginning of this chapter, project
parameters can appear in schedules but not in tags (see Figure 6.23).

Fields |Fi|her I Sorting/Grouping | Formatting I Appearanoel

oK | Cancel | Help |

FIGURE 6.23 S
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{Can be shared by multiple projects and families, exported to ODBC, and
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Select, ., Export...
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Using the Calculated Value feature of a Revit schedule will create a parameter to hold the
value, but this parameter is not added to the properties of elements or the Project Parameters
list. It appears only in the schedule where it was created and nowhere else.

Whether they are shared parameters or not, project parameters are required for scheduling
system families such as Duct, Pipe, or Cable Tray. It is easiest to create these parameters when
you are building the schedule for such elements. Once the parameter is created, you can access it
from the Project Parameters button on the Manage tab to add it to other categories or make any
necessary changes. Creating these parameters in schedules within your project template will
ensure that they are consistently used from project to project.

One useful type of project parameter to create is for the schedule type of an element. This
parameter can be applied to any category that is scheduled, and it is useful for filtering your
schedules. Some people may prefer to create this parameter as a project parameter, which is
easier and faster. We recommend creating it as a shared parameter and including it in all your
families with a predefined value. This way, as you load boilers, chillers, AHUs, and so on, they
will automatically be displayed on the appropriate schedules, assuming you have given them
the appropriate value for the parameter and the schedule is using that as a filter.

Creating and Using Parameters in Families and Schedules

Understanding how to use parameters to get the information you require is the key to success-
fully reaping the benefits of Revit. Knowing where and when to use certain types of parameters
will make it easy for you to manage the data within your Revit projects.

1. Download the RMEP2016_Ch06_Dataset.rvt and RMEP2016_Ch06_Shared Parameters
. txt files found at this book’s web page, www. sybex.com/go/masteringrevitmep2016.

2. Open the RMEP2016_Ch06_Dataset. rvt file. Open the VAV Schedule view. Access the
Fields tab of the Schedule Properties dialog box, and click the Add Parameter button.

3. Create a project parameter called Schedule Type with the following settings:
¢ Instance
¢ Discipline: Common
¢ Type Of Parameter: Text
¢ Group: Identity Data

4. Select the Edit Tooltip button and type in an appropriate tip, such as For filtering specific
equipment in schedules. Click OK.

5. Click OK to exit the Schedule Properties dialog box. For each VAV listed in the schedule,
enter a value of VAV for the Schedule Type parameter.

6. Access the Filter tab of the Schedule Properties dialog box.

Set Filter By to Schedule Type, Equals, and VAV, as shown in Figure 6.24.


http://www.sybex.com/go/masteringrevitmep2016
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FIGURE 6.24 x|
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Click OK to exit the Schedule Properties dialog box. Notice that now only the VAVs are
listed in the schedule. Click the Project Parameters button on the Manage tab of the
ribbon. Notice that the Schedule Type parameter is now a project parameter that will be
added to any mechanical equipment loaded into the project. Exit the Project Parameters
dialog box.

Open the 1 - Lighting ceiling plan view. Click one of the light fixtures in the view, and
click the Edit Type button in the Properties palette. Notice the Ballast Voltage parameter
in the Electrical group. Click OK to exit the Type Properties dialog box.

Open the Lighting Fixture Schedule view. Access the Fields tab of the Schedule
Properties dialog box. Notice that the Ballast Voltage parameter that exists in the lighting
fixture family is not listed in the Available Fields list because it is a family parameter.

Click the Add Parameter button on the Fields tab of the Schedule Properties dialog box.

In the Parameter Properties dialog box, select the Shared Parameter option and click the
Select button.

Click the Edit button in the Shared Parameters dialog box. Click the Browse button in

the Edit Shared Parameters dialog box, and browse to the downloaded RMEP2016_Ch06_
DatasetShared Parameters.txt file location. (Note that if you have never selected a shared
parameters file, you will be asked to select one. Browse to the location of the downloaded file.)

Set Parameter Group to Lighting Fixtures. Click the New button under Parameters on the
right side of the dialog box.

Create a new parameter named Fixture Voltage. Set Discipline to Electrical. Set Type Of
Parameter to Electrical Potential. Click OK to exit the Parameter Properties dialog box.
Click OK to exit the Edit Shared Parameters dialog box.
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15. In the Shared Parameters dialog box, set the parameter group to Lighting Fixtures. Select
the Fixture Voltage parameter from the list, and click OK to exit the Shared Parameters
dialog box.

16. In the Parameter Properties dialog box, select the check box in the lower-left corner to
add the parameter to all elements in the category. Set the parameter as a type parameter,
and click OK to exit the dialog box.

17. Notice that the Fixture Voltage parameter is now in the Lighting Fixture schedule. You
can now input values for voltage into the parameter.

VOLTAGE AND NUMBER OF POLE PARAMETERS—INSTANCE VS. TYPE

Revit MEP has a feature that allows you to specify circuit information when the Voltage and Number
Of Poles parameters are set to Instance when you create your circuits. The family lists the available
voltage definitions for the project. If those parameters are set to Type, you will not have this choice.
Refer to the following screenshot for an example.

Specify Circuit Information ll

Mumber of Poles:

Voltage:

Specify Gircuit Information x|
Number &
oo

5 =
=l
40V

av

—

Voltage:
OK I Cancel Help

View and Sheet Parameters

Views and sheets are system families, so you need to use project parameters to include addi-
tional information or functionality in them. This type of information may be necessary for
construction documentation or simply for organizing your project for more efficient workflow.
Depending on their use, these parameters may need to be shared parameters.

One of the more common parameters for views is the Sub-Discipline parameter. This param-
eter allows you to assign a subdiscipline value to the properties of any view to establish a sec-
ondary level of organization within the Project Browser. This parameter is already established
in the default template files provided with Revit MEP 2016. For more information on using this
parameter and other alternatives for Project Browser organization, refer to Chapter 25, “Creating
a Project Template.” Much of the information that appears on a sheet border is common to
every sheet. If the parameters that hold this information were unique to each sheet, it would
be time-consuming to make certain changes. Project parameters that are applied to the Project
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Information category can be included in your titleblock so that the value can be changed in one
location and globally updated to all sheets.
One example is for total sheet count. Including this information on a sheet as an editable
parameter would require creating a shared parameter. A label of this parameter could then
be placed within the titleblock family. The shared parameter could then be added as a project
parameter applied to the Project Information category, as shown in Figure 6.25.

FIGURE 6.25
Project parameter
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Notice that the parameter is an instance parameter. You cannot create type parameters for

FIGURE 6.26 Author ]
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the Project Information, Sheet, or View categories. However, since there is only one instance of
Project Information in a project, essentially those instance parameters behave like type param-
eters. For example, say you create an instance project parameter called Building No. and apply
it to Project Information. Even though it is an instance parameter, it is global for the project
because there is only one instance of it. Instance parameters for views and sheets behave like
normal instance parameters.

When the project information is edited, the value will be updated on every sheet in the project.
Figure 6.26 shows this example on a titleblock in a sample project.
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WORKING WITH FORMULAS

Combining the power of shared and project parameters can give you the ability to report,
tag, or schedule any data within your model or about your project in general. Once you under-
stand how to use parameters effectively, the real work becomes managing them for consistency
and accuracy within your projects.

Working with Formulas

Formulas let you create some truly intelligent families and in most cases can increase your
designers’ efficiency by automating certain tasks. Working with formulas in Revit has its own
challenges that you need to be aware of. They are case sensitive, they are “aware” of units, and
they won’t work properly if your parameters use mathematical symbols (/ * — +) in their naming
convention. Table 6.1 lists basic operators used in formulas. Table 6.2 gives a list of conditional
statements used in formulas.

TABLE 6.1:

log
sqrt

exp(x)

Basic operators

Add: Length + Width

Subtract: Length — Connector
Protrusion

Multiply: Width * Length
Divide: Height/Length
Exponent: Length”3
Logarithm:log (100)

Square root: sqrt (49)
eraised to an x power: exp (2)
Less than

Greater than

abs

pi

sin
cos
tan
asin
acos

atan

Absolute Value: abs (-5) will return 5

Pi: pi() * (Radius * 2)—the circumference
formula

Sine: sin (45)
Cosine: cos (45)
Tangent: tan (45)
Arcsine: asin (45)
Arccosine: acos (45)

Arctangent: atan (45)

TABLE 6.2:

If

And

Or

Not

Conditional statements

if statement

Both statements are true

One of the statements is true

The statement is false

169



170

CHAPTER 6 PARAMETERS

Sample Conditional Statements

Conditional statements are a very powerful way of controlling the behavior of your Revit fami-
lies. For the most part, conditional statements work exactly the same way they do in Excel or
any other program that supports them. Here are few examples for the most common conditional
statements:

Simple if Statements if(Neck Size<10",16",18")
if(Neck Size<250mm, 400mm, 450mm)

Formula That Returns Strings if(Neck Size>10","Neck Size is too Big "Neck Size
is Correct")

if(Neck Size>250mm,"Neck Size is too Big "Neck Size 1is Correct")

The next two types of statements (Logical and/or) are good for testing whether a diffuser has
been sized correctly. Either of the following formulas could be used:

Using Logicaland If(and(Air Flow>Minimum Air Flow, Air Flow<Maximum Air
Flow),"Correct", "Wrong Size")

Using Logical or If(or(Air Flow<Minimum Air Flow, Air Flow>Maximum Air
Flow),"Wrong Size", "Correct")

Both of the preceding statements give the result—a text string—stating whether a connection
is correctly sized . . . or not.

Using Logical not if(not(Top Alignment), 0", tan(15$) * b)
Using Logical not for Yes/No Parameters not(myCheckbox)
Using if with Yes/No Condition If (Length>10)

(Note that both the condition and the results are implied.)

Embedded if Statement with Logical and if(and(Maximum Air Flow < 391 CFM, Auto
Size), 8", if(and(Maximum Air Flow < 641 CFM, Auto Size), 10", 1if(and(Maximum
Air Flow < 1001 CFM, Auto Size), 12 1/2", if(and(Maximum Air Flow < 1651 CFM,
Auto Size), 15", if(and(Maximum Air Flow < 2201 CFM, Auto Size), 17 1/2",
if(and(Maximum Air Flow < 3001 CFM, Auto Size), 18", OVERRIDE HEIGHT)))))

if(and(Maximum Air Flow < 185 1/s, Auto Size), 200mm, if(and(Maximum Air Flow
< 300 1/s, Auto Size), 250mm, if(and(Maximum Air Flow < 470 1/s, Auto Size),
350mm, if(and(Maximum Air Flow < 780 1/s, Auto Size), 400mm, if(and(Maximum
Air Flow < 1000 1/s, Auto Size), 450mm, 1if(and(Maximum Air Flow < 1400 1/s,
Auto Size), 450mm", OVERRIDE HEIGHT)))))

Revit can be very picky about the units that you use in formulas. For example, you can’t use
the Number parameter in a CFM (I/s) parameter unless you do some sort of conversion. In most
but not all cases, simply multiplying or dividing by 1 does the trick.

Rounding

Prior to Revit 2012, there were two options for rounding numbers: running them through an
integer parameter (which automatically rounds them up) or adding 0.49 to the formula. In most
formulas, the rounding needs to be to the next higher whole number, even if the number isn't
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higher than 0.5, such as for the occupancy of people. If the number is 2.4, it really needs to be
3—for example, 2.4 + 0.49 = 2.89, which will be rounded to 3.

As of Revit 2012, we have three additional functions to use: Round(x), Roundup (x), and
Rounddown (x). Note that x is unitless (also known as a number, not CFM, not GPM, and so on).
The Round (x) function rounds to the nearest whole number:

round
round
round

round
round
round

(1.2)
(1.5)
(1.7)

(-1.2)
(-1.5)
(-1.7)

1
1
2

The Roundup (x) function rounds to the largest whole number greater than or equal to x,
such as in the following example:

round
round
round

round
round
round

(1.0)
(1.4)
(1.6)

(-1.0)
(-1.4)
(-1.6)

1

-1
-1
-1

The Rounddown (x) function rounds to the smallest whole number less than or equal to x, as
in this example:

round
round
round

round
round
round

(1.0)
(1.4)
(1.6)

(-1.0)
(-1.4)
(-1.6)

The Bottom Line

Manipulate the properties of parameters. The parameters used to define the properties of
elements have properties of their own that define their behavior and how they can be used.

Master It It is important to know when and where parameters can be used for extract-
ing data from a model or project. It is also important to understand how instance and
type parameters are used. Describe how the use of instance and type parameters affects
the way data is changed in a family.

Work with type catalogs. Type catalogs are powerful tools that allow you to load only what
you need for a specific project.
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Master It Certain families can have multiple family types. If a family has many types,
all of them will be loaded into a project when the family is loaded. What can be done to
limit the number of family types that are loaded when a family is inserted into a project?

Work with shared parameters. Shared parameters are useful because they can be used in
schedules and in annotation tags. Shared parameters can be applied directly to families or
added as project parameters.
Master It Managing shared parameters is as important as managing your component
libraries. Explain the importance of keeping a common shared parameters file for mul-
tiuser environments.

Use parameters in project files. The use of parameters is not limited to component families.
Parameters can be added to any element that makes up a Revit project.

Master It You can add parameters to system families only by creating project param-
eters. When you create a project parameter, it will be added to all the elements in the
chosen category. Explain why managing project parameters is important to using them in
schedules within a project.



Chapter 7

Schedules

Schedules of a parametric model provide the most immediate return of information from
the data inherent in the model. With the Autodesk® Revit® MEP 2016 platform, you can
create schedules that are useful not only for construction documentation but also for data
management, for object tracking, and even for making design decisions.

By building a model, you can look at it from many angles or viewpoints. Schedule views are
simply another view of the model. Instead of looking at the physical elements that represent
the design, a schedule allows you to view the data within the components in an organized and
easy-to-manage format. Using schedules for data management is one way to increase efficiency,
accuracy, and coordination within your Revit project. You can edit the properties of many
objects quickly without having to locate the objects in the model.

Revit schedules can provide you with an accurate account of the objects that are being used
in your project model. The ability to track and manage objects can help with cost estimation and
material takeoff. With this information readily available, you have the power to make decisions
that affect cost and constructability.

Harnessing the power of creating schedules in a Revit MEP 2016 project can help you reap
the benefits that come with easy access to any model or project information.

In this chapter, you will learn to do the following;:

Use the tools in Revit MEP 2016 for defining schedules and their behavior

¢ Schedule building components
¢ Create schedules for design and analysis
¢ Schedule views and sheets for project management

Defining Schedules

Mastering the scheduling tools in Revit MEP 2016 will enable you to easily extract informa-
tion from your projects. Schedules can be created and used on any of your Revit projects to
establish consistency on construction documents and ease of data management for specified
model objects.

Although there are different types of schedules, depending on their use and the items with
which they are associated, the tools for creating them in Revit MEP 2016 are similar for whatever
type of schedule you are creating. Because schedules are essentially a view of the model, the
scheduling tools are located on the View tab of the ribbon, as shown in Figure 7.1.
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Figure 7.2 shows the types of schedules that can be created by clicking the Schedules button.
Note the filter list that allows you to narrow down the number of categories available in the list

displayed.
FIGURE 7.1 | View [ :
View tab 187 2 - E Py
B o | h B &
Rerder I . sy, o ate - Schedules Fee!
pree - -1 - - . -
rate .rr1.
Schedule /Quantities
=
E_@ Material Takeoff
Sheet List
Note Block
e
|_ View List
FIGURE 7.2 [x]
Schedule types .
Category:] ;"‘\ MName:
Structure
;I‘:'Iu 9 Mechanical - I Mult-Category Schedule
...... Ana E!e.cmal % Schedule building components
Anal [IPiping
) Schedule keys
------ Areas (Gross Building) .
------ Areas (Rentable) Key/mame:
------ Assemblies I
------ Cable Tray Fittings Phase:
------ Cable Tray Runs a5
...... Cable Trays INew Construction j
------ Communication Devices
------ Conduit Fittings
------ Conduit Funs |
0K I Cancel | Help |
4

Clicking the View List or Sheet List option takes you directly to the View List or Sheet List
Properties dialog box, where you can begin creating your schedule. Clicking the Schedule/
Quantities or Material Takeoff option takes you first to a dialog box that allows you to select the
Revit object category that you want to schedule. The Note Block option takes you to a dialog box
where you can select the annotation family that you want to schedule.

In the New Schedule dialog box, you can define whether you are creating a schedule of
building components or a schedule key. You can also set the project phase of the schedule
view.

The project phase is an important property of schedules because only the objects in the model
that belong to the same phase as a schedule appear in that schedule. The name that you give your
schedule is what will appear in the main header of the schedule when it is placed on a draw-
ing. If your drafting standards dictate that the text should be in all capital letters, that is how
you need to type the name. From the Filter List pull-down, you can filter the object categories
you can schedule. The pull-down is the same as the one in the Visibility /Graphic Overrides
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dialog box. This allows you to select items that are not MEP objects and may not even exist in

your model. Figure 7.3 shows a sample of the New Schedule dialog box with settings to build a
Spaces schedule.

FIGURE 7.3 <CHT7 SPACE SCHEDULE>
Sample schedule
; A B | C | D | E F
settings Mumber Name | Wolume (CF) | Area(SF) | AreaperTotal [Average Ceilng Height
100 CONF RM 5420 877 43% a-0
101 OFFICE 1412 177 1% &-0
102 CORRIDOR 2755 344 22% g -0
103 LOBEY 2245 281 18% -0
104 RESTROOM 856 86 5% 10 -0
Grand total: 5 12688 1565
Schedule Properties x|
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Also note the angle brackets (< >) around the name of the schedule. This feature denotes a
parameter value rather than user-entered text. You will learn of this and other features of sched-
uling later in the chapter.

Another choice is to create a Multi-Category schedule. This type of schedule is for objects
that are in different categories but have common parameters. Figure 7.4 shows an example of a
Multi-Category schedule. Notice that the OmniClass Number parameter is used in the schedule
even though not all objects have that parameter.

FIGURE 7.4
R <Multi-Category Schedule=
Sample Multi-
A B | C ] E
Category SChedule Famity and Type Type Mark Description Count {0mniClass Number,
Exhaust Gril: 24 x 24 Face 12x 1 E12 LAY-IN LOUVER FACE 1 23.75.70.21.27.11
Flux Capacitor: 1.21GW D1 Lightning Generation 1
MyCo_Round Neck Diffusers - Fa AB LA&Y-IN LOUVER FACE 4 23.75.70.21.27.11
MyCo_Round Neck Diffusers - Fa AB LAY-IN LOUVER FACE 2 23.75.70.21.27.11
MyCo_Round Neck Diffusers - Fa A10 L&Y-IN PERFORATED FACE 1 23.75.70.21.27.11
Return Diffuser: 24 x 24 Face 12 R12 L&Y -IN PERFORATED FACE 4 23.75.70.21.27.11
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Once you have chosen a category and established the initial settings from the new sched-
ule dialog box, clicking OK opens the Schedule Properties dialog box. This dialog box has five
tabs across the top that have settings for defining the behavior and appearance of your sched-
ule. When you’re scheduling Space or Room objects as in Figure 7.3, there is an additional tab
for building an embedded schedule within the schedule you are creating. A typical use for an
embedded schedule might be a Space schedule that also references lighting fixture details, so
quantities of lighting fixtures per space or room can be created. An example of this is provided
later in this chapter. It is good to move through the tabs sequentially, establishing the settings in
each tab before moving to the next. The first two tabs let you determine what information will be
scheduled, whereas the last three enable you to control how the data will be displayed and the
graphical appearance of the schedule when placed on a drawing.

The Fields Tab

The Fields tab of the Schedule Properties dialog box contains many tools for choosing the
information that will appear in a schedule. Figure 7.5 shows the Fields tab of a newly created

Space schedule.
FIGURE 7.5 B
Fields tab of the :
Fields |Fi|ter | Sorting/Grouping I Formatting | Appearance | Embedded Schedule |
Schedule
Properties Available fields: Scheduled fields {in order):

. Actual Appliance - Dwelling Unit Ly Add —= | MNumber
dlalog box Actual Cooling Load MName
Actual Default Load

= |
Actual Electric Clothes Dryer Load SeE
Actual Electric Range - 3.5 kW to
Actual Electric Range - Less than

Actual Elevator Load
Actual Equipment Load

Actual Exhaust Airflow

Actual Existing Load - 30 Day Met Add Parameter... |
Actual Existing Load - Lighting Loz

Actual Existing Load Load Calculated Value... |
Actual Farm Load Load

Actual Heating Load =

Arpoal HUAS Laad _I—I

4 I | >

Edit;.. | Delete | Edit... | Delete |

Select available fields from:

% Mawve Up | [Mowe Down |

[T Indude elements inlinks

OK I Cancel | Help |

The check box in the lower-left corner allows you to schedule items that are in any files
that are linked into your project. The Available Fields list on the left side of the dialog box
contains all the parameters that can be scheduled for the chosen category. The Edit and
Delete buttons below the list become active only when you select a project or shared param-
eter that you have created. Only project parameters that are not shared parameters can be
deleted.

You can use the drop-down list in the lower-left corner to change the list of available fields to
parameters from another category. This is primarily for Space and Room schedules because the
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two objects are essentially the same thing. You cannot select fields from Mechanical Equipment
if you are creating a Lighting Fixture schedule, for example.

SCHEDULES AND PARAMETERS

Because of the relationship between objects, parameters, and schedules, the data within a Revit
schedule is the same as the data assigned to the objects. This is known in Revit terms as bidirec-
tional associativity. It is best to have a good understanding of how parameters work when you set
out to build a schedule. For more information on the creation and management of parameters, see
Chapter 6, “Parameters.”

To establish the columns in your schedule, you simply select the parameter from the
Available Fields list and click the Add button at the top center of the dialog box. This places the
chosen parameter in the space on the right side of the dialog box. Another way is to double-click
the parameter you want to add. Each parameter added to the schedule will be a new column,
and the order in which they appear in the list determines the order of the columns in the sched-
ule, from left to right. Once you have added a parameter to the schedule, you can use the Move
Up and Move Down buttons to set the order. These buttons become active only when you select
a parameter from the Scheduled Fields list on the right.

The Remove button at the top center allows you to remove a parameter from the schedule.
This is not the same thing as deleting a parameter. Using either of the Delete buttons removes
the selected parameter from your project and any objects in your project. This can only be done
with project or shared parameters, not the system parameters that are hard-coded into the
program.

If you want to schedule information about the chosen category and a parameter does not
exist that contains that information, you can click the Add Parameter button at the center of the
dialog box. Clicking this button activates the Parameter Properties dialog box, where you can
choose the type of parameter and its properties. The check box in the lower-left corner of the
Parameter Properties dialog box (Add To All Elements In The Category) is selected by default,
and it is grayed out to ensure that the parameter you create is added to all the objects in the cat-
egory you are scheduling. Once you have created a parameter using this button, it is automati-
cally added to the schedule.

Revit schedules have the ability to perform calculations on the data within the parameters
that are included in a schedule. This information then appears as a unique column in the
schedule. To create a calculated value column in your schedule, click the Calculated Value
button at the center of the Fields tab in the Schedule Properties dialog box. Give the value a
descriptive name so that when it is seen in the list or schedule, its purpose will be clear. You
can create a formula by including parameters in a mathematical equation, or you can calculate
a percentage.

The percentage calculation returns the percentage of a specific parameter as it relates to the
project as a whole. Figure 7.6 shows the settings for percentage calculation of the volume of
Space objects and the resulting column in the schedule.

When you're creating a calculated value based on a formula, it is important to use the proper
Discipline and Type settings that coincide with the result of the equation. You will receive a
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warning stating that the units are inconsistent if the result does not match. Revit is case sensi-
tive when it comes to typing in parameter names, so as you write your formula, it is crucial that
you type the parameter name exactly. The small button next to the Formula field allows you to
pick the parameter from a list and insert it into your formula to ensure proper spelling and capi-
talization. A good rule of thumb is to be consistent with all your parameter names.

FIGURE 7.6

<CH7 SPACE SCHEDULE=
Percentage
calculation in A B | c D | E
Number Name i Wolume (CF) Area (SF) i Area per Total
a schedule
100 CONF RM 5420 577 43%
101 OFFICE 1412 177 11%
102 CORRIDOR 2755 344 22%
103 LOBBY 2245 281 18%
104 RESTROOM 856 86 5%
Grand tofal: 5 12688 1565
[N calculated Value x|
MName:
 Formula [ Percentage:
of: IArea j
By: |<Grand total= j
oK I Cancel Help |
4

Once you have created a calculated value, it automatically appears in the Scheduled Fields
list. If you use the Remove button to remove a calculated value from the schedule, it is deleted

from the project. You can use multiple operators and multiple parameters to create complex for-
mulas if necessary. One example of a simple formula for Space objects is to divide the volume by
the area to determine the average ceiling height, as shown in Figure 7.7. This formula works only
because the Space objects have an upper limit set to the level above and the ceiling objects are
set to Room Bounding, thus defining the volume of the spaces.

CALCULATED VALUES LIMITATIONS

Calculated values appear only in the current schedule. They are not parameters that you would see
in the properties of objects, and therefore they cannot be tagged or displayed anywhere outside
the current schedule. In addition, calculated values can be somewhat hard to work with if you don’t
understand how to convert units in Revit. In most cases, conversion of units can be done by simply
multiplying or dividing a parameter by 1. For example, Revit could give you an error if you try to
divide volume by area. But if you “strip out the units” by multiplying both parameters by 1, you
will get the results you want: Ceiling Height=(Volume*1)/(Area*1).
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FIGURE 7.7
<CH7 SPACE SCHEDULE=
Space schedule
with a calculated £ B | £ | = L £
Number Name i Wolume (CF) Area (SF) i Area per Total :Average Ceiling Height
value for Average
Ceiling Height 100 CONF RM 5420 BT7 43% g0
101 CFFICE 1412 177 11% 8-10
102 CORRIDOR 2755 344 22% g -0
103 LOBBY 2245 281 18% g -0
104 RESTROOM 856 26 5% 10 -07
Grand total: 5 12688 1565
[N calculated Value x|
Mame:
& Formula ) Percentage:
Discipline: ICnmmnn j
Type: ILengﬁ1 j
Formula: I Volume [ Area |

0K I Cancel Help

VISIBILITY/GRAPHIC OVERRIDES FOR SCHEDULES

We have already seen that it is possible to schedule elements that are in linked files, but what
happens if you do not want to see all the linked files information? This can be achieved from the
Properties palette of the schedule by clicking Visibility/Graphic Overrides.

The Filter Tab

The next tab in the Schedule Properties dialog box is the Filter tab. The settings on this tab allow
you to filter out unwanted items in your schedule. You can set certain criteria for parameter
values that objects in the schedule category must meet in order to be included in the schedule.
This is very useful when scheduling a category that has many unique types of items, such as
the Mechanical Equipment category. For example, if you wanted to create a Pump schedule, you
would have to schedule the Mechanical Equipment category. Without applying a filter to your
schedule, all items categorized as Mechanical Equipment would show up in your schedule.

You can apply up to eight conditions that an object must meet to make it into the schedule. To
set a condition for a parameter, that parameter must be included in your schedule. If you want
to use a parameter for filtering but do not want it to show up in your schedule, you can use the
options on the Formatting tab to hide the column of the unwanted parameter. There are some
parameters (such as Cost, Family, and Type) to which you are not able to apply conditions.

Figure 7.8 shows a sample of a Mechanical Equipment schedule without any filter conditions
applied to it.

179



180 |CHAPTER 7 SCHEDULES

FIGURE 7.8 . <Mechanical Equipment Schedule=
Sample Mechanical
. A B | C | D E
Equlpment schedule Mark i Description Level Famity i Type Mark
PP-001 SMELLY PIPE GROUND FLOOR i Sanitary point of connection
VSA-001 ROOF STICKY OUT THING GROUND FLOOR {VENT THROUGH ROOF
[AC-101 CEILING RECESSED GROUND FLOOR  {WSHP - Horizontal
AC-102 CEILING RECESSED GROUND FLOOR  :WSHP - Horizontal
AC-103 CEILING RECESSED GROUND FLOOR  {WSHP - Horizontal
AC104 CEILING RECESSED GROUND FLOOR  :WSHP - Horizontal
AC-105 CEILING RECESSED GROUND FLOOR  {WSHP - Horizontal
AC-106 CEILING RECESSED GROUND FLOOR  :WSHP - Horizontal
AC-107 CEILING RECESSED GROUND FLOOR  {WSHP - Horizontal
AC-108 CEILING RECESSED GROUND FLOOR  :WSHP - Horizontal
AC-109 CEILING RECESSED GROUND FLOOR  {WSHP - Horizontal
AC-110 CEILING RECESSED GROUND FLOOR  :WSHP - Horizontal
AC-111 CEILING RECESSED GROUND FLOOR  {WSHP - Horizontal
HWB-01 HOT HOT HOT WATER GROUND FLOOR  :Boiler
CT-01 ENERGY RECOVERY GROUND FLOOR  iCooling Tower - Closed Circ
P-101 RECIRC PUMP GROUND FLOOR  iCentrifugal Pump - Horizont
CT-02 CEILING RECESSED GROUND FLOOR  {WSHP - Horizontal
P-102 RECIRC PUMP GROUND FLOOR  iCentrifugal Pump - Horizont
AC-Z01 CEILING RECESSED FIRST FLOOR WWEHP - Horizontal
AC-202 CEILING RECESSED FIRST FLOOR WSHP - Horizontal
AC-203 CEILING RECESSED FIRST FLOOR WWEHP - Horizontal
AC-204 CEILING RECESSED FIRST FLOOR WSHP - Horizontal
AC-205 CEILING RECESSED FIRST FLOOR WWEHP - Horizontal
AC-206 CEILING RECESSED FIRST FLOOR WSHP - Horizontal
AC-207 CEILING RECESSED FIRST FLOOR WWEHP - Horizontal
AC-208 CEILING RECESSED FIRST FLOOR WSHP - Horizontal
AC-209 CEILING RECESSED FIRST FLOOR WWEHP - Horizontal

To turn this into a Pump schedule, you would apply the Filter settings shown in Figure 7.9.
Notice the many options for filter rules that can be used to narrow down the qualifying objects.
Using these conditions in combination with certain parameters gives you a very powerful tool
for scheduling exactly the objects you want.

FIGURE 7.9
: ' <PUMP SCHEDULE>
Filter settings for
hedul A B | C | D E
a Pump schedule Mark Description H Level Family Type Mark
P-101 RECIRC PUMP {GROUND FLOOR  : Centrifugal Pump - Horizont

P-102 RECIRC PUMP ROUND FLOOR i Centrifugal Pump - Horizont

5 =

Fields ~Filter |Sortinngrouping I Faormatting | Appearance |

Schedule Prope

Fiter by: [contains =l e

And: [trone) =] | | | |
and; [trone) = = [
and) Jinone) N =] ] |
and; [trone) = = [
and) Jione) EI =] ] E|
and; [trone) = = [
and; Jione) EI | | I

oK I Cancel Help
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As items are brought into your model, they automatically appear in a schedule of their
category as long as they meet the filter criteria. Remember that if you filter by a parameter,
an object may not have a value assigned, so you should input data into the parameter when
the object is brought into your project. This ensures that your schedule is showing all that it
should. Additionally, you can use a working schedule, one that does not filter elements and is
never placed on a sheet.

As mentioned earlier, another option for filtering a schedule is to set the schedule phase. The
different options for the phase filter of a view can be applied to schedule views in the same way
that they are applied to model views. So if you were to set the phase of a schedule view to New
Construction and the phase filter to one that shows only New Construction, no items from any
previous phase would appear in the schedule. You can select the phase from the New Schedule
dialog box shown in Figure 7.2. There is no way to go back to that dialog box once you proceed,
but you can change the phase of the schedule at a later time from the Properties palette.

The Sorting/Grouping Tab
In the Sorting/Grouping tab of the Schedule Properties dialog box, you can determine the order
of the objects in a schedule and then group like items together. You can assign up to four group
conditions and provide a header or footer for each group. Sorting can be done based on param-
eters that are used in the schedule. When you sort by a particular parameter, all the objects in
the schedule that have the same value for that parameter are listed together.

Figure 7.10 shows a sample Lighting Fixture schedule that has been sorted by the Type Mark
parameter. Notice that each instance of the different fixture types is listed in the schedule and
that the Count column (QTY) on the far right of the schedule confirms this.

FIGURE ?‘10. <Lighting Fixture Schedule>
Sample Lighting T = T | 5 | 3 ‘ 3 =
Fixture schedule TYPE WANUFACTURER WODEL _ ; WOUNTING . VOLTAGE WATTS ary
A ACME AC-125684 RECESSED IN CEILING 230V 12w 1
A AEHHE AEi3854 RECESSED i CEILHG 255V 3w i
A ACME AC-12564 RECESSED IN CEILING 230V 12w 1
A ACME AC-125684 RECESSED IN CEILING 230V 12w 1
A AEHiE AC 15584 RECESESED i CEILING il 3w i
A AEHHE AC 13854 RECESSED i CEILiG 23V Bw i
A ACME AC-12564 RECESSED IN CEILING 230V 12w 1
A ACME AC-125684 RECESSED IN CEILING 230V 12w 1
i ACHiE AC-13E84 RECESSED i CEILING 50V 3w i
A ACME AC-12564 RECESSED IN CEILING 230V 12w 1
A ACME AL‘\k\?M RECESSED IN CEILING 230V 12w 1 %
[ REALLY €000 [¥TES ™ {REL-15-783 HAMIERED iNTO SURFACE 330V Ew i
[ REALLY COOL THTES " RELE782 HAMERED iWT0 SURFACE ™ 23V B i
C REALLY COOL LYTES RCL-15-792 HAMMERED INTO SURFACE 230V Bw 1
C REALLY COOL LYTES RCL-15-792 HAMMERED INTO SURFACE 230V Bw 1
[ REALLY €000 TWTES ™ {REL- 5783 HAMIMERED iNTO SURFACE ™ 230V Ew i
c REALLY COOL LYTES RCL-15-792 HAMMERED INTO SURFACE 230V Bw 1
C REALLY COOL LYTES RCL-15-792 HAMMERED INTO SURFACE 230V Bw 1
RCL-15-782 HAMMERED INTO SURFACE 230V Bw 1
...... S AC-i755 RECESSED M CEILING 50 B i
i 554 RECESSED IN CEILING 230V Bw 1
...................... = DECECSED 1 CELING 230V G 1
S i g 5555 v j
<] |Gsirma o i
............ bid e OO 2O | s " 1
G G5lPaaxz [FLOATING WILBLY T N 7
G GSLP28x2 {FLOATING WILDLY - e
G GSLP28x2 {FLOATING WILDLY EZB[I \ 8w "

A schedule lists each instance of the objects by default. To group items together that
have the same parameter values, you need to deselect the box in the lower-left corner of the
Sorting/Grouping tab of the Schedule Properties dialog box. Figure 7.11 shows settings for the
same Lighting Fixture schedule, where the Itemize Every Instance box has been deselected.
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Notice that each type of lighting fixture is listed only once; that’s because the schedule is set to
sort by fixture type. The Count column now indicates the total number of each type of fixture.

The Grand Totals check box has also been selected to give a total number of lighting fixtures at
the bottom of the schedule. You can also create a custom grand total title.

FIGURE 7.11
<Lighting Fixture Schedule=
Lighting Fixture = o 7 . I . = =
schedule sorted TVFE WANUFACTURER | MODEL WOUNTHNG i WOLTAGE |  WATTS QT
and grouped A ACME AC-12564 RECESSED IN CEILING 230V 12w 194
B BRIGHT EVES BEGCTY WALL 230V 48w 1
by type c REALLY COOL LYTES  TRCL-15.792 HAMMERED INTO SURFACE 230V Ew 19
B LOUIENS [CHEEZ FLOOH 230 dBw =)
El EXIT LITES R US EL-12-X SURFACE 12V 72w 2
F LIBHTER AN i H78 SURFACE i3V S6w [
G SPOTS GsLP28x2 FLOATING WILDLY 230 v 12w [
H LOUNENS [ SURFACE v 2w 1
Total Number of Luminaires: 410
Schedule Properties x|

Fields | Fiter  Sortng/Grouping |F%matﬁng | Appearance |

Sortby: ype Mark
™ Header I~ Footer: -| T Blankline

~| % Ascending " Descending

Then by: (none) | & ascending  Descending
I~ | Headzr I~/ Foster: 7| I Eenkine
Then by: (none) ¥| & ascending . Descending
I~ | Headzr I~ Foster: 7| I Eenkine
Then by: (none) ¥| & ascending . Descending

I~ Header I~ Foster: 7| I Eenkine
¥ Grand totals: Title, count, and totals =

Custom grand total title:

Total Number of Luminaires e
™ Itemize every instance

ok | canel | Heb

You can use the Sorting/Grouping settings with combinations of parameters to organize
your schedules so that you can read the data within them easily. Figure 7.12 shows the Lighting
Fixture schedule again, with settings to sort by the Type Mark parameter and a footer to indi-
cate the total number of fixtures. The Ascending or Descending radio button can be used to
determine the order of items within a sorted group. Notice that the fixture types are listed in
alphabetical order because the Ascending option is used.

The Formatting Tab

The Formatting tab of the Schedule Properties dialog box has tools for setting how the data
appears within a schedule. Each parameter used in the schedule is listed on the left side. When
you select a parameter from the list, you can apply the settings available on the right side. You
can also apply the settings to multiple parameters by holding down Ctrl or Shift.

The Heading setting establishes the name of the column in the schedule. The parameter
name is used by default. Changing the column heading has no effect on the parameter itself,
as shown in Figure 713, where the column headings have been changed to all caps. Even if the
parameter name is what you want for your schedule column heading, you have to retype it if
you want it in all capital letters. Figure 710, Figure 7.11, and Figure 7.12 are also good examples
of this practice, where all the headings are in all caps (TYPE, MANUFACTURER, etc.).



FIGURE 7.12
Lighting Fixture
schedule with two
sorting options

FIGURE 7.13
Column heading
settings
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<Lighting Fixture Schedule=

A B & | D | E F G
TYPE WANUFACTURER. MODEL MOUNTING VOLTAGE WATTS ary
A ACHE TAC-12564 RECESSED IN CEILING 230V 12w 194
[ACME: 194
B BRIGHT EVES. TBEGCTY WALL 220V 48w 1
BRIGHT EYES. 1
E1 EXIT LTES RUS TEL 12X SURFACE 1ZV 72w 2
EXIT LMES RUS: 2
F LIGHTER MAN ILM.HTS SURFACE 12V 96w 65
LIGHTER MAN: 65
D LOUMENS iLL-HsE21 FLOOR 230V 43w 63
H LOUNENS iLs SURFACE 230V 2w 1
LOUMENS: 64
C REALLY COOLLYTES  RCL-15-792 HAMMERED INTO SURFACE 230V 6w 19
REALLY COOL LYTES: 18
G SPOTS iGSLP28x2 FLOATING WILDLY 230V 12w 65
SPOTS: 65 -
Total Number of Luminaires: 410 EaMAs il =
Fields | Fiter  Serting/Grouping |Furmamng | Appearance |
Sort by: IManufacturer | & Ascending " Descending
™ Header IV Footer: Title, count, and totals ~| I Blankline
Then by: Type Mark ~| @ ascending ™ Descending
™ Header ™ Footer: -| I Blankline
Then by: (nane) =| & ascending | Descending
I~ Header ™| Footer: 7| [ Elankline
Then by: (nane) ¥| & ascending | Descending
I~ | Heardzr I~ | Fanter: 7| I ke

¥ Grand totals:

Title, count, and totals B

Custom grand total title:

Total Number of Luminaires

™ Itemize every instance

oK | Cancel Help
2
Schedule Properties x|

"Fields IFiIter | Sorting/Grouping Formatting |appearance|

Fields:

Type Mark :

T:Ee Heading:

Manufacturer I qry

Model

Type Comments Heading orientation:

VOLTAGE

WATTS IHorizontaI j
Alignment:
ICenher j
Pkt ormata: [ e
™ Hidden field Conditional Format... |
[V show conditional format on sheets
™ calculate totals

o ]

Cancel Help
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The Formatting tab also has settings for the orientation of the column headings and the
alignment of the data within a column. Headings can be either vertical or horizontal, and the
data can be aligned to the left, right, or center of a column.

Two additional types of formatting are available, depending on the type of parameter
selected. The Field Format button becomes active when you select a parameter that is a measure-
ment. In the Format dialog box that appears when you click the Field Format button, you can
change the units and rounding accuracy of the data. You can also choose whether to show the
unit symbol in the cell of the schedule. Whatever settings have been established for the project
are used by default. You can deselect the box at the top of the Format dialog box to overwrite the
settings within the schedule. Figure 7.14 shows format settings for the Area parameter used in
a Space schedule. Unit Symbol has been set to None because the schedule column heading indi-
cates the units.

FIGURE 7.14

. <CHT SPACE SCHEDULE=>
Field format
settings L— z | ¢ | b | S— I
Number Name i Wolume (CF) Area (SF) : Area per Total :Average Ceiling Height
TCONF RI 5420 677 43% -0 |
Schedule Properties x|

Fields I Filter I Sorting/Grouping  Formatting |Appearanoe| Embedded Schedule

104
Grandtota 5 Fields:

Heading:

Mumber
Mame

I Vaolume {CF)
x|

I~ Use project settings j

Units: ICuhic feet j

Rounding: Rounding increment:

|D decimal places ERE /l Field Format... I

Unit symbal: Conditional Format...

INona vl mat on sheets
CF

I | Shovs -+ for positive values

™ Use digit grouping

° T Suppress spaces

K | Cancel Help |

You can change the background color of a cell based on conditions that you apply by using the
Conditional Format button. Clicking this button opens a dialog box where you can set a test condi-
tion for the value of a parameter and the background color of the schedule cell when the condition
is met or not met. Additionally, you can display this conditional format on your output sheets. To
do this, simply select the check box Show Conditional Format On Sheets. Figure 715 shows the
Conditional Formatting dialog box for a calculated value in a schedule. The Background Color
is set to turn red when the result of the calculation does not meet the test condition. The types of
condition test options are shown in the Test drop-down list of the dialog box.
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FIGURE 7.15

.. <LEVEL 1 LIGHTING ANALYSIS=
Conditional
Formatting A | B | E | D | E
. HO iMAME i REQDLEWEL (LUX) : ACTUAL LEVEL (LUX) : LTG DELTA (LUX)
dialog box
100 CONF RM 500 b 475 Ix 25k
101 OFFICE 500 b 4538 Ix 2k
102 CORRIDOR 150 b 152 Ix -2k
103 LOBBY 150 b 215 Ix
104 RESTROOM 100 b 140 Ix 400
Schedule Properties x|
Fields I Filter I Sorting/Grouping Formatting | Appearance I Embedded Schedule I
Fields:
Level .
Mumber Heading:
Name | LTG DELTA {LUX)
Space Type

Design Lighting Level Heading orientation:

Average Estimated Illumination
[Cghinasoa [ — =]

Alignment:

[right =
Field formatting: Field Format... |
™ Hidden field Conditional Format... |

I ¥ Show conditional format on sheetsl
[™ Calculate totals

Conditional Formatting k |
r~ Condition
Field: Test: Value:
[Lighting Delts *| [rotBetween =[S0l and |50k L
b
Conditions to Use: Background Color: !

-50 Ix > Lighting Delta or Lighting Delta > 50 Ix ;I —
ear

E
oK I Cancel |

On the Sorting/Grouping tab is an option to display the totals for groups of objects. If you
want to show the totals for an individual column, you can select the Calculate Totals box when
you select a parameter on the Formatting tab. These totals will not appear if the Grand Totals
option is not selected on the Sorting/Grouping tab.

Sometimes you need to include a parameter in a schedule for sorting purposes or for calcula-
tions but you do not want to display the column in your schedule. If this is the case, you can use
the Hidden Field check box on the Formatting tab to hide a selected column. This can be very
useful because it allows you to hide information without having to remove the information from
your schedule. It also allows you to create a schedule with more information that is useful for
calculations or design decisions but is more than would normally be shown on a drawing. When
the time comes to put the schedule on a drawing, you can hide the unwanted columns.
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The Appearance Tab

The Appearance tab of the Schedule Properties dialog box contains the settings that define
how the schedule looks when placed on a sheet. Grid lines and an outline can be chosen from
any of the line styles defined in your project. If you do not choose an option for the outline,
the line style chosen for the grid lines will be used. The option to include grid lines within the
headers, footers, or spacers is also available.

The check box to provide a blank row between the headings and schedule data is selected
by default. If this is not how you normally display your schedules, you have to deselect this box
whenever you create one. The Appearance tab also has settings for the text within a schedule,
as shown in Figure 7.16. The font and text height that you choose for header text will be applied
to all headings, subheadings, and the title of the schedule unless you opt to override these in
the schedule itself. To do that, select the title or heading, and from the ribbon, select Font in the
Appearance panel.

FIGURE 7.16

Appearance tab <LEVEL 1 LIGHTING ANALYSIS>
of the Schedule A | B | L | D | E
. NO iNAME i REQDLEVEL (LUX) : ACTUAL LEVEL (LUX) : LTG DELTA. (LUX)
Properties
dialog box 100 CONF R 500 bx 475 Ix 25 i
101 OFFICE 500 bk 4598 b 2
102 CORRIDOR 150 i 152 b -2 b
103 LOBBY 150 i 215
104 RESTROOM 100 140 b -40 b
Schedule Properties x|
Fields I Filter I Sorting/Grouping | Formatting Appearance |En1bedded Sd’1edule|
—Graphics
Buld schedule; €% Tiop-down
| Bobtom-up
Grid lines: v IThin Lines 'I ™ Grid in headers/footers/spacers
outiine: [~ Im k
Height: I'-;ariable 'I [+ Blank row before data
rText
¥ show Title
V¥ Show Headers
Title text: | 1/4" Arial i
Header text: ISchedu\e Default 'I
[0 RS Sl (< chedule Default
OK I Cancel Help
%
o o
Editing a Schedule

Once you've created a schedule, you can edit it by using the same Schedule Properties dialog
box. When you double-click a schedule in the Project Browser, the schedule is displayed in the
drawing area. Using the Properties box, you can access the tabs for the instance Properties list
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of a schedule view, as shown in Figure 7.17. Each tab has its own Edit button, but clicking any of
these buttons takes you to the Schedule Properties dialog box. Whichever button you click from
the list takes you to the corresponding tab within the dialog box.

FIGURE 7.17
Schedule view
properties E Schedule ~
Schedule: LEVEL 1 LIGHTING ANALYSIS j Edit Type
Identity Data 2
View Template <None
View Name LEVEL 1 LIGHTING AMALYSIS
Dependency Independent
Phasing -
Phase Filter iShow Al i
Phase iMew Construction
Other 3
Fields Edit,
Filter Edit,
Sorting/Grouping Edit.
Formatting Edit,
Appearance Edit,
Embedded Schedule Edit.
Properties help Apply

When you access the Schedule Properties dialog box, you can modify the schedule with any
of the tools or settings that you would use to create a new schedule. One thing you cannot do is
change what is being scheduled. For example, you cannot change a Lighting Fixture schedule to
a Lighting Devices schedule because the Family category defines this.

Some of the formatting options that are defined can be modified in the schedule view, with-
out having to access the Schedule Properties dialog box. In the schedule view, you can select
anywhere within a column and use the Hide button on the ribbon to hide that column. There
is also a Delete button on the ribbon to delete a row in the schedule. Of course, deleting a row
in the schedule will also delete the object being scheduled, as noted in the sidebar “Delete with
Caution.” The majority of formatting tools have now also been added to the updated tab for
modifying schedules and quantities.

To ensure consistency between all your schedules, use view templates. View templates allow
you to quickly apply your company standards to a schedule or a group of schedules. To create
a new schedule view template, simply right-click a schedule and select Create View Template
From View.

When you click in the cell of a column heading, you can change the text of the heading, elim-
inating the need to access the Formatting tab. You can change the title of the schedule with this
method also, although this changes the name of your schedule in the Project Browser. Columns
can be grouped together under a common heading by selecting the columns and clicking the
Group button on the ribbon. Columns must be adjacent to each other to be grouped. The key to
selecting columns for grouping is to hold down the left mouse button when you click the first
column and then drag your cursor to highlight the columns to be included in the group. When
you click the Group button, a new blank header appears above the columns, awaiting input.
This is ideal for grouping similar data: locality details, measurements, and so forth (see Figure
7.18). Column groups can be removed by highlighting all the columns within a group and
clicking the Ungroup button on the ribbon.
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DELETE WITH CAUTION

It is important to understand what will happen if you click the Delete button on the ribbon when
you select arow in a schedule. If your schedule is scheduling objects from your model and you delete
arow, all the objects from that row, and their associated tags and dimensions, will be deleted from
the project. Also, depending on how your schedule is formatted, this could be one object or, if the
Itemize Every Instance button is unchecked, one thousand objects.

Revit x|
This will delete 4 instance(s).
Please note that you are not just removing rows from the

schedule, but also deleting the associated elements and
geometry from the project.

FIGURE 7.18 | UNGROUPED <LEVEL 1 Space Schedule>
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Another relatively recent improvement is the ability to add new rows in the header of your sched-
ule. This lets you use the schedule like a spreadsheet, so you can make it look similar to the data
sheets you have been using for many years in other packages. In Figure 7.19, a row was added by
using the Insert option from the Rows panel on the Modify Schedule/Quantities tab of the ribbon.
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Cells in this row can then be merged and parameters added to each merged cell as required.
Figure 7.20 shows the schedule partially complete. Notice that fields can be added from the
Parameters panel; text can be typed in; the size, font, and alignment of the values can be altered
by using the Appearance panel; and an image—such as your company logo—can be added.

FIGURE 7.20 Modify Schedue/Quantites
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This custom header can also have shading and borders applied either to individual cells or a
selection, using the tools in the Appearance panel, as shown in Figure 7.21 and Figure 7.22. Click
the appropriate button to change linetype, color, display, and so forth.
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One of the best features of using schedules in Revit is that you can edit parameter values of
objects right in the schedule. If you are changing the value of a type parameter, you receive a warn-
ing letting you know that your change will be applied to all objects of that type when you finish
editing the cell. Some cells turn into a drop-down list when you click them. This lets you select
from previously input values for that parameter as long as those values are being used in the proj-
ect. If you click a cell and you cannot edit it, that means that the parameter is a calculated value, it is
a parameter of an object within a linked file, or the parameter does not exist in the object.
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Because a schedule view is actually a view of the model, you can select a cell in a schedule
and click the Highlight In Model button on the ribbon to see where the selected object exists in
the model. This takes you to a view of the model, where the object can be seen. You can continue
to click the Show button for different views. If you have grouped objects in your schedule and
you are not itemizing every instance of the objects in it, then all the selected object types are
shown. Used in conjunction with tiled views, this can aid in the selection and manipulation
of objects.

Some schedules need multiple lines of input within one row, such as for comments or a
description. You can do so by pressing Ctrl+Enter when entering information in a schedule cell
or parameter value. Each time you press Ctrl+Enter, you create a hard return in the value, thus
starting a new line of text. This process does take some practice, however; you cannot use the
drop arrow to fill in subsequent cells because this method picks up only one line and in the
schedule view, you see only the first line of input in the cell. To edit subsequent lines, use the
keyboard arrow keys to navigate to the point in the cell, or use a spreadsheet and copy/paste the
text from there. Do the same if you want to duplicate the data in another row. The multiple lines
appear when the schedule is placed on a sheet.

Scheduling Component and System Family Data

Almost any object type that is placed into a Revit model can be scheduled. This seems like a
very generic concept, but if you consider the possibilities that exist, it is easy to see why using
a parametric model can be a great benefit to your design processes. Having readily accessible
information about the components that make up your design makes coordination and decision
making easier and more efficient.

It is important to know what kind of information about model objects can be scheduled,
because the types of schedules that you can create for model objects depend on the data within
those objects. Some data is inherent in the objects, based on how they are used in the model,
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such as elevation or location. Most of the data used in component object schedules comes from
parameters that are added to the objects either as project parameters or directly in the compo-
nent-family file as shared parameters. Family parameters cannot be scheduled.

Using the organizational and calculation tools within a Revit schedule can help you get the
most from the data within the model components. The following sections cover some possibili-
ties for scheduling building components.

Mechanical Equipment Schedules

The Mechanical Equipment model category covers a wide range of components—chillers,
water heaters, pumps, rooftop units, fans, and more since they all fall under the Mechanical
Equipment category. As you have seen, using filters makes it possible to create specific sched-
ules for different types of Mechanical Equipment components. The key to success with these
schedules is developing a method that makes the filtering easy to use and manage.

When considering the information that is needed in your schedules, you can look at the
parameters that already exist in every component and determine whether they can be used in
lieu of creating a custom parameter. The Description parameter is one example of a parameter
that is in every object. With the ability to change the heading in a schedule, you can use this
parameter for any type of descriptive information that is scheduled about your components.
You do not need to create a parameter for each type of information to be scheduled. For exam-
ple, if your Mechanical Equipment schedule for pumps has a column for the mounting type, you
could use the Description parameter to convey this information.

Every item that is placed into a model is given a Mark value. The Mark parameter is another
useful parameter for scheduling mechanical equipment.

The parameters Family And Type and Type do not appear under the Filter tab as a choice and
therefore cannot be used for filtering objects.

A WARNING ABOUT MARK VALUES

When you manually change the Mark value of an object, the next object that you place that is in
the same category will have a Mark value that is sequential to the value you input. For example, if
you place a boiler and give it a Mark value of B-1, the next Mechanical Equipment object you place
will be given a Mark value of B-2, even if it is not another boiler. Using Mark values to identify
equipment requires you to manage the Mark value of an object when it is placed into your model.
Assuming that boilers are numbered sequentially (B-1, -2, -3), as are pumps (P-1, -2, -3), and so
forth, this field does require managing in the particular schedule for that equipment because this
is considered to be unique data. The data type that requires management only from a project point
of view is the Type Mark parameter. Rather than having a unique number, the Type Mark can
describe something like a lighting fixture reference or power outlet, where there are many objects
with the same reference.

The best reason for using the Mark parameter for Mechanical Equipment schedules is that it
makes it easy to filter the schedule for specific items. Figure 7.23 shows a Mechanical Equipment
schedule for pumps and the filter settings based on the Mark parameter. This setup allows for
having unique Mark values for multiple instances of the same type of component.
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Another way to easily filter your Mechanical Equipment schedules is to create a project
parameter called Schedule Type that is applied to the Mechanical Equipment category. You can
then assign values for this parameter in order to create schedule filter rules. This may be the
preferred method, because the Schedule Type parameter could be applied to all appropriate
model categories and would give you a uniform method for filtering schedules.

If you have a schedule with a column for remarks or notes about an object, the Type
Comments parameter can be a useful alternative to creating a custom parameter. The value of
this parameter can refer to text notes associated with a schedule.

Lighting Fixture Schedules

The Type Mark parameter is useful for assigning a unique identifier to each fixture type within
your project and eliminates the need for a custom parameter. If you use a standard set of fix-
tures for each design, you might consider naming each family type within your fixture families
and using the type name to identify your fixtures in a schedule. The family type name shows
up as Type in the Available Fields list, as shown in Figure 7.24.
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FIGURE 7.24
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The URL parameter can be used for any component and is particularly useful for lighting fix-
tures. You can input a link to the cut sheet of a lighting fixture into its URL parameter for quick
access to the additional information that a cut sheet provides. Figure 7.25 shows an example of
a Lighting Fixture schedule with a URL column. When you click on the URL row, a small box
at the right of the end of the URL cell shows up. The cut sheet file opens when you click that
small box. Although this box is not initially visible, try clicking in the place where it should be.
Notice how the URL responds, even though the box cannot be seen? Anywhere this type of box
appears (URL, Material, Image, etc.), you can click this portion of the cell. That’s a work-saving
of 50 percent! Well, it’s one fewer mouse click anyway, where there were two.

FIGURE 7.25 A [ B
URL parameter TvPE URL
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The paths you provide in URL parameters are not relative, so if you share or submit your
Revit project file, the links are inactive unless you also share the cut sheets and you create new
paths for the URL parameters.
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FIGURE 7.26
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System Family Schedules

Schedules are useful not only for component objects but for system families as well. Duct, Pipe,
Cable Tray, and Conduit schedules can be created for use on construction documents or just for
keeping track of quantities and materials.

DuUcCT SCHEDULES

A lot of information can be taken from a ductwork model. How you organize a Duct schedule
depends on the type of information you are looking for and what you intend to do with it.
Determining the amount of sheet metal for ductwork is one way to use the power of schedul-
ing in Revit MEP 2016. Unfortunately, the Material Takeoff option of the Schedules tool on the
View tab is restricted to component families. However, with some calculated fields and the right
parameters, you can create a schedule that works as a material takeoff.

Figure 7.26 shows a sample Duct schedule with calculated values to determine the total
area of material for both round and rectangular ducts. A duct material project parameter was
created, and values were manually input for different duct types. The total area for each duct
material is calculated at the bottom. This is just a small example of how you can get useful infor-
mation from your model in schedule format. Keep in mind that because Revit is a parametric
modeling tool, as ducts are removed, added, or changed, the schedule reflects those changes
automatically.

Another type of Duct schedule can help you keep track of what type of duct is used for dif-
ferent air systems. A schedule like this enables you to see whether any errors have occurred in
the model based on design criteria. If all return-air ductwork is to be rectangular, for example, a
schedule quickly reveals any duct that does not meet this requirement.

PIPE SCHEDULES

Creating a custom Material Takeoff schedule for pipe is a little easier than for duct because pipe
types can be assigned a material without creating a custom parameter. Figure 7.27 shows a sam-
ple Pipe schedule that is organized to show the total length of each pipe size per material.
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FIGURE 7.27 .
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EXPORTING SCHEDULES

You can export Revit schedules by using the Export tool on the Application menu. The exported
TXT file can be imported into a spreadsheet for further computation or analysis. Although spread-
sheets cannot be natively imported into Revit schedules, there are many third-party applications
that allow the transfer of data between Revit and Excel; these can easily be found with a search
on the Internet.

You can create Pipe schedules to input data quickly into the properties of pipes without
having to locate each pipe in the model. One example where this may be useful is with pipe
insulation. You can create a pipe insulation schedule like the one shown in Figure 7.28, which
groups pipe insulations by their system types.

FIGURE 7.28 .
. <Pipe Schedule=
Sample Pipe
Insulation schedule & | K | c
. System Type Size Thickness
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Hydronic Supphy 20 mme 25 mm
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Insulation Thickness is an instance parameter of the Insulation Category. You can apply a
value to several objects at once by grouping the insulation types and deselecting the Itemize
Every Instance box on the Sorting/Grouping tab of the Schedule Properties dialog box. When
you input a value for the Insulation Thickness parameter, it is applied to all pipes within that
group. Just keep in mind that Insulation is considered a separate object, and pipes that don't
have any insulation will not even appear on the Pipe Insulation schedule. For that reason, it is
best to use two schedules: a Pipe schedule and a Pipe Insulation schedule. From the Pipe sched-
ule, you can see and select the pipes that don’t have insulation. While the pipes without insula-
tion are still selected, you can apply Insulation from the plan view. Once all necessary pipes
have insulation, you can manage them from the Pipe Insulation schedule.

SPACE SCHEDULES

Spaces are typically scheduled to analyze their data to determine the performance of systems.
However, creating a Space schedule can also help with model maintenance or quality control.
A very simple Space schedule can be a useful tool for removing unwanted or misplaced spaces,
reducing the risk of performing analysis of an incorrect model.

Spaces can be placed into a model manually or by using the Place Spaces Automatically tool
on the Modify | Place Space contextual tab. The one drawback to the automated process is that
Revit places a Space object in any enclosed area that is bounded by objects defined as Room
Bounding and that is 0.25 square feet (0.023 square meters) or larger. This often results in Space
objects being placed in pipe and duct chases or in column wraps and other small enclosures. In
a large model, it could be time-consuming to search for all the unwanted Space objects, making
the automation of space placement seem unreasonable. When these spaces are found, deleting
them removes them from the model only. They still exist in the project and could be inadver-
tently used again or have unnecessary analysis performed on them. Additionally, undefined
void spaces larger than the sliver space can affect energy analysis negatively because Revit and
the cloud service interprets these as exterior surfaces instead of interior.

Consider creating a simple Space schedule that will quickly identify any unwanted spaces
and allow you to, with a few clicks, either delete them all completely from the project or set
them to not occupied or heated/cooled so energy analysis works properly. When you link in an
architectural model, one thing you need to do is set the Room Bounding parameter so that it
defines the boundaries of your spaces. Placing a space within the same boundaries as a Room
object will associate that space with the architectural Room object. So, unless your architect has
placed Room objects in areas such as chases or column wraps, you can easily see which of your
spaces match up with the rooms.

Figure 7.29 shows the settings for a Space schedule that can be used to eliminate unwanted
spaces. The schedule is sorted and grouped by room number and level so that all spaces without
an associated level (Not Placed) or room will be listed together at the top of the schedule. Not
Placed spaces could have been created as a fast-track design method or as a result of architec-
tural changes. Either way, it is up to the user to decide whether they are required.

The unwanted spaces can be highlighted in the schedule and then removed from the project
by using the Delete button on the ribbon. You cannot use the Shift or Ctrl keys, but you can click
and drag your cursor to select multiple rows within a Revit schedule.

The Schedule Properties dialog box for a Space schedule contains an additional tab for creat-
ing and managing an embedded schedule. This allows you to create an additional schedule that



is set up within your Space schedule. On the Embedded Schedule tab, you can select the box to
include an embedded schedule within your Space schedule and choose the model category you
want to schedule. When you click the Embedded Schedule Properties button in the lower-left
corner, a new Schedule Properties dialog box appears. You can then set up the embedded sched-
ule in the same way you would set up a regular one. The Appearance tab is not available in an
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embedded schedule because the settings are controlled by the host schedule.

FIGURE 7.29
Settings for a
Space schedule
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parameter, and grand totals are shown.

FIGURE 7.30
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The information within the embedded schedule is included in the host Space schedule, as
shown in Figure 7.31. By creating this type of schedule, you can see how many elements of a
specific category are associated with each space.
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Model Component Schedules

Understanding the basic features of a component schedule will help you begin to develop your
own methods for scheduling your Revit projects. Create a simple component schedule by doing
the following:

1. Open the RMEP2016_Ch07_Dataset.rvt file found at this book’s web page, www. sybex
.com/go/masteringrevitmep2016.

2. Click the Schedules button on the View tab and select Schedule/Quantities.

3. Select the Air Terminals category. Ensure that the Schedule Building Components option
is selected and that Phase is set to New Construction, and then click OK.

4. On the Fields tab, select Type Mark from the Available Fields list and click the Add but-
ton. Repeat the process to add the System Type, Neck Size, CFM Range, Description, and
Count parameters to the schedule.

5. On the Sorting/Grouping tab, select Type Mark in the Sort By drop-down. Deselect the
Itemize Every Instance box in the lower-left corner.


http://www.sybex

SCHEDULING COMPONENT AND SYSTEM FAMILY DATA

6. On the Formatting tab, highlight all the parameters in the Fields list and set Alignment
to Center.
7. On the Appearance tab, select the Outline box and change the line style to Wide Lines.
Click OK to exit the Schedule Properties dialog box. Your schedule should look some-
thing like Figure 7.32.
FFGURE 7'32 <Air Terminal Schedule=
Air Terminal
A | B | [S | D | E F
SChedule Type Mark System Type Neck Size CFM Range Description Count
AB Supphy Air 13 0-100 LAY-IN LOUVER FACE 4
AB Supphy Air 13 100-210 LAY-IN LOUVER FACE 2
A1l Supply Air 10 210-340 LAY-IN PERFORATED FACE 1
E12 Exhaust Air 12x12 - LAY-IN LOUVER FACE 1
R12 Return Air 12x12 - LAY-IN PERFORATED FACE 4
In the second half of this exercise, we take a look at creating a space schedule that also
contains an embedded schedule of air terminals.
8. Click the Schedules button on the View tab and select Schedule/Quantities.

9. Select the Spaces category. Ensure that the Schedule Building Components option is

10.

11.

12.
13.

14.

15.
16.

17.

selected and that Phase is set to New Construction, and then click OK.

On the Fields tab, select Number from the Available Fields list and click the Add button.

Repeat the process to add the Name parameter to the schedule.

On the Filter tab, select Number in the Filter By drop-down and set Begins With as the
rule. Type 1 in the field below the Filter By drop-down.

On the Sorting/Grouping tab, select Number from the Sort By drop-down.

On the Formatting tab, select the Number and Name parameters and set Alignment to
Center.

On the Embedded Schedule tab, select the Embedded Schedule box, select the Air
Terminals category, and click the Embedded Schedule Properties button.

Add the Type Mark, System Type, and Count parameters from the Available Fields list.

On the Sorting/Grouping tab, select Type Mark in the Sort By drop-down. Select the
Grand Totals box in the lower-left corner.

On the Formatting tab, select the Count parameter and select the Calculate Totals box.
Click OK to exit the Embedded Schedule Properties dialog box. Figure 7.33 shows the
resulting schedule.
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FIGURE 7.33
Embedded Air <Space Schedule=
Terminal & Z £
Number Name
schedule Type Mark System Type Count
100 CONF RM
AB Supphy Air 1
AB Supply Air 1
R12 Return Air 1
Grand total: 3 3
101 OFFICE
All Supply Air 1
Ri2 Return Air 1
Grand total: 2
102 CORRIDOR
AB Supply Air 1
AB Supphy Air 1
R12 Return Air 1
Grand total: 3 3
103 LOBBY
AB Supphy Air 1
AB Supphy Air 1
R1Z Return Air 1
Grand total: 3 3
104 i RESTROOM
E12 {Exhaust Air i1
Grand total: 1 1

Using Schedules for Design and Analysis

Scheduling building components to provide information on construction documents or to keep
track of model components and materials is not the only use for schedules in Revit. Using sched-
ules to analyze the performance of MEP systems in relation to the building model can help you
make design decisions. The ability to see and manipulate the information directly in Revit can
improve the efficiency of your design processes.

Traditionally, engineers use several tools to complete building analysis. Some are used
“because we always have and we trust the results” even though these processes can be time-
consuming. It is important to verify your design data so the results can be trusted without just
relying on the output. So, it is a great idea to run some small tests—side by side, your trusted
software with the newfangled one. Revit MEP not only provides a great conceptual level of
analysis, it does it faster than many of the programs around. What’s more, the data from Revit
can be exported to a GBXML format that can then be imported into other programs, allowing
verification, confirmation, and more complex analysis without the time-consuming modeling or
data input procedures required for those other packages.

When it comes to analysis, the focus is mainly on the Space objects in your model. Space
objects hold a lot of information related to energy analysis, by direct input, input from third-
party analysis, or as a result of the characteristics of components associated with the spaces.
Understanding the type of information you can retrieve from spaces during the design process
is the key to developing schedules that are most useful to your workflow.

Analysis can be as simple as checking to see whether the components you are using meet the
engineering requirements or standards around which you are designing. This often requires
that you manually set the requirement information property of your spaces. Selecting each
space and accessing its properties to input this information is an inefficient practice.
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Schedule Keys

A special type of schedule can be created to improve the process of adding information to your
spaces. This is a schedule key, and it allows you to specify values for a parameter based on the
value of a key parameter. One example is in lighting design, where a certain lighting level is
required for specific types of rooms. A schedule key can be created to associate a specific light-
ing level value with each space key parameter value. The parameter associated with the key
can be included in your Space schedule so that each space can be assigned a key and therefore a
required lighting level. The required lighting level could be input manually into the parameter,
but using a key ensures accuracy and consistency.

Click the Schedules button on the View tab and select Schedule/Quantities to create a sched-
ule key. When you select the category you want to schedule, the option to create a schedule key
becomes available on the right side of the dialog box. You can then choose a name for the key
parameter in the Key Name field. A style-based name will automatically be placed in the Key
Name field, but you can change it to whatever you want. After you create the schedule, a param-
eter with this name is added to all the objects in the category for which you are creating a sched-
ule key. Figure 7.34 shows an example of the settings for a Space schedule key. Notice that the
schedule has been named to identify it as a schedule key and not a component schedule.

FIGURE 7.34 £
Space schedule L -
Filter list: Im

key setu;

Y P Category: MName:
...... Grids Al | Space Style Schedule
...... Levels
------ Lighting Devices " Schedule building components
""" Lighting Fixtures & Schedule keys

- Mass
------ Murse Call Devices M
...... Parts I Space Style
...... Rooms
------ Security Devices Rliase:
------ Spaces I j
------ Switch System
------ Telephone Devices
M|

OK I Cancel | Help |

The Key Name parameter is automatically included in the Scheduled Fields area on the
Fields tab of the Schedule Properties dialog box. Here, you can select parameters to which val-
ues are assigned based on the key value. In the case of a Space schedule key for lighting levels,
the Required Lighting Level parameter is chosen, as shown in Figure 7.35.

The schedule key is sorted by the Key Name parameter by default. Unless you will
be placing the schedule on a drawing, there is no need for any other settings within the
Schedule Properties dialog box. The schedule key starts out blank. Click the New button on
the Rows panel of the ribbon to add a row to the schedule. You can then edit the name of the
key and assign a value to the associated parameter. Repeat the process to create additional
rows and build your schedule key. Figure 7.36 shows an example of a Space schedule key for
lighting levels.
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FIGURE 7.35 Schedule Properties x|
Space schedule :
. Fields |Sorﬁnngrouping I Formatting I Appearance |
key Fields tab
Available fields: Scheduled fields {in order):
Heat Load Values d fdd = | Key Name
Latent Heat Gain per person Reguire Lighting Level
Lighting Load Units PP — |
MName
MNumber of People
Occupancy Unit
Plenum Lighting Contribution
Power Load Units
Sensible Heat Gain per person
Specified Lighting Load
Spedified Lighting Load per area Calculated Value, .. |
Spedified Power Load
Spedfied Power Load per area
4 | | >
Edit;.. | Delete | Edit... | Delete |
Select available fields from:
ISpaces j Move Up | Mye Doy |
[ Include elemments in links N
OK | Cancel | Help |
FIGURE 7.36 S Stvle Schedul
=opace e octhedule=
Sample schedule P o
key A | B
Key Name i Require Lighting Level
CLASSROOM 350 k&
CORRIDOR 100 k&
QFFICE 500 x
TOILET 150 i
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Now that you have created the schedule key, each space has a Space Style parameter that can
be assigned a value from the schedule key for the Required Lighting Level parameter. A sched-
ule can be used to assign these values without having to access the properties of each space.
When you are editing a key parameter value in a schedule, a drop-down list appears with all the
key values, as shown in Figure 7.37.

A key parameter can be included in a schedule that is set up for analysis to increase the
functionality of the schedule. Additional parameters were added to the schedule shown in
Figure 7.37 to determine whether the lighting levels in each space meet the design requirements.
A calculated value was added to show the difference between the required level and what is
actually occurring in the space. This type of schedule allows you to quickly see the performance
of the design components used, and you can adjust parameter values of the spaces to investigate
options. Notice in Figure 7.38 that spaces, which have been assigned a Space Style value, have
the corresponding Required Lighting Level parameter value from the key.



This same type of schedule can be created for airflow in spaces. The design airflow value
can be checked against the actual airflow and the value calculated by a third-party analysis or

USING SCHEDULES FOR DESIGN AND ANALYSIS

directly from the Revit MEP 2016 Heating and Cooling Analysis tool.

The ability to see the performance-based data is essential to checking the quality of your
design and for making appropriate changes to the design when necessary. Figure 7.39 shows an
example of a duct airflow schedule that displays the properties related to the performance of the
system rather than information about the physical properties of the ductwork.

FIGURE 7.37

Editing a schedule

key parameter

FIGURE 7.38
Space lighting
level analysis
schedule

FIGURE 7.39
Duct Airflow
schedule

<Space Style Schedule>

A | B | C
Key Name Require Lighting Level Space Type
CLASSROOM 350 |
CORRIDOR - !

Space Type Settings

TOILET
Banking Activity Area - Office ;I Parameter
Barber and Beauty Parlor
Card File and Catalogui Library g
tur ng - Penitentiar Area per Person 156,56 SF
Sensible Heat Gain per person 250,00 BY
Confinement Cells - Penitentiary Latent Heat Gain per person 200,00 BY
gOnﬁgemE”iﬂCE‘E - CUUE_hUUSE Lighting Load Density 1.40 W/
cgr”ri dfr?lffan:igonngm“ purpose Power Load Density 1.00 W ]
CorridorTransition - Manufacturing Fadility Plenum Lighting Contribution 20.0000%
Corridors with Patient Waiting Exam - Hospital Health Occupancy Schedule Schoal O
Court Sports Area - Sports Arena Lighting Schedule School Lig
Courtroom - Courthouse Power Schedule Schoal Lig|
Department Store Sales Area - Retail
Netailed - Manufachiring Failite
<LEVEL 1 LIGHTING ANALYSIS=
A B | C D | E F
SPACE DATA ILLUKMINANCE N LUX
No. NAME STYLE REQUIRED LEVEL | ACTUAL LEVEL : LIGHTING DELTA
100 CONF RM OFFICE 500 b 475 b 25 b
101 OFFICE OFFICE 500 b 498 b 2
102 CORRIDOR CORRIDOR 100 b 152 bx
103 LOBBY CORRIDOR 100 bk 215 x
104 RESTROOW TOILET 150 b 140 b 10 &
<Duct Schedule >
A | B | C | D E [
System Name | Friction f Flow i Pressure Drop | Welocity Velocity Pressure
Mechanical Supply Air 1 0.00 Pa/m 89.67 Lis 0.02Pa 025 m's 0.05Pa
Mechanical Supply Air 1 0.00 Pa/m 89.67 Lis 0.01Pa 0.29 m's 0.05Pa
Mechanical Supply Air 1 0.00 Pa/m 89.67 Lis 0.03Pa 029 m's 0.05Pa
Mechanical Supply Air 1 0.01 Pa/m 89.67 Lis 0.03Pa 048 m's 0.14Pa
Mechanical Supply Air 1 0.01 Pa/m 89.67 Lis 0.02Pa 0.48 m's 0.14Pa
Mechanical Supply Air 1 0.00 Pa/m 89.67 Lis 0.01 Pa 025 m's 0.05Pa
Mechanical Supply Air 1 0.05 Pa/m 89.67 Lis 0.05Pa 0.97 m's 0.56 Pa
Mechanical Supply Air 1 0.05 Pa/m 89.67 Lis 0.08Pa 0.97 m's 0.56 Pa
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@ Real World Scenario
USING THIRD-PARTY DATA

Shelley uses a third-party application—IES—to analyze her HVAC designs. Because the software
she uses is compatible with Revit MEP 2016, she can import the data generated from the third-
party analysis into her Revit projects.

When this data is imported, she wants to be able to see the values as they pertain to each space in
combination with the types of air terminals used in her design. Shelley has created a Space schedule
with an embedded Air Terminal schedule that allows her to view the results from the third-party
analysis in each space alongside the airflow properties of her air terminals. She has added this
schedule to her project template so that it is available for each project on which she works, and now
she has a consistent workflow for analyzing the results.

Panel Schedules

Custom Panel schedules are not created by using the scheduling tools but instead are generated by
a predefined format residing in a panel-schedule template. There are tools to create a panel sched-
ule template with settings for both the appearance of the schedule and the data that is reported.

Once you establish panel schedule templates within your project template, they are available
for use on any project. If you want to create a custom Panel schedule, the first step is to create its
template. You can find the Panel Schedule Templates tool on the Manage tab.

Manage | Modify =

MEP | Panel Schedule
ttings Templates

Manage Templates
> H
zﬁ Edit a Template

Additiona|
Settings

The Manage Templates option gives you access to your panel schedule templates for editing
or duplication. Clicking this option activates the Manage Panel Schedule Templates dialog box.
The first tab on the dialog box lists any templates in your file. The three types of panel templates
that you can create are Branch Panel, Data Panel, and Switchboard, as shown in Figure 7.40.

FiGoRE 7.40 2
Manage Panel
templates Manage Templates | Apply Templates |

Template type: | Switchboard j

Branch Panel
Panel configuration: Data Panel
Templates:

Switchboard (Default) IMake Defaul: |

7 O B 0




USING SCHEDULES FOR DESIGN AND ANALYSIS

Once you have created a panel schedule template, the Make Default button enables you to
establish a selected template as the default. Buttons at the bottom of the dialog box can be used
to edit, duplicate, rename, or delete a template.

The second tab of the dialog box allows you to apply a panel schedule template to any
panel in your project. When you make changes to your panel schedule templates, these can be
assigned to your panel schedules. You can also update the schedules for panels that are using an
older version by selecting the panels from the list and clicking the Update Schedules button as
indicated in Figure 7.41.

FIGURE 7.41 2l
Apply Panel ;
templates Mansge Templates  Apply Tempiates |

Template type: IBranch Panel j

Panel configuration: ITwo Columns, Circuits Across j

Apply templates:
Branch Panel (Default ) :i

Branch Panel (Default )
Pre2011 Branch Template

Asterisks denote panel schedules assodated with an older version of a template. To
apply the current template, choose panel schedules and select Update Schedules.

To build a custom template, start by clicking the default template in the list on the Manage
Templates tab of the dialog box. Use the Duplicate button at the bottom of the dialog box to copy
the default template. Select the newly created template in the list, and use the Edit button to
begin customizing your Panel schedule.

DEFAULT TEMPLATES

To see a good example of how a panel schedule template can be formatted, check out the default
templates in the Electrical-defaults.rte project template file. These defaults can be trans-
ferred to any file by using the Transfer Project Standards tool. If you want to start completely from
scratch, you can use the default panel schedule templates from other project templates, which are

totally blank.

All the tools for editing and formatting a panel schedule template are located on the Modify
| Panel Schedule Template contextual tab that appears on the ribbon when you click to edit a
template. Every panel schedule template has a header area, a circuit table, a load summary area,
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FIGURE 7.42 E Choose Category: et f @
General Settings T J 35
Set Template Add Parameter: et F R
el lempia TEEZE ROWS
area for a panel Options | and Columns
schedule template Template | Parameters | Columns
Set Template Options ﬂll
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and a footer. That does not mean that you have to use all four of these areas. You can access the
settings for the overall appearance and behavior of a panel schedule template by clicking the Set
Template Options button on the contextual tab.

There are three main areas for the overall settings. Figure 742 shows the General Settings
options. The Total Width setting determines the size of the schedule when placed on a sheet.
The height is determined by the row height settings within the schedule. Column widths are
defined directly in the schedule template view. The number of slots shown is determined by the
panel family used or defined here in the template options. You can deselect the boxes to remove
the header, footer, or loads summary, but the circuit table cannot be removed.

These settings apply to the entire panel schedule template. You can further customize the
appearance in the template view,

Mame:  MyCo Branch Panel
Type: Branch Panel

Circuit Size
Table Total width: MNumber of slots shown:
— | 12.0000™ {” Variable based on maximum number of one-pole breakers
=
= ¥ Fixed to a constant value: | 47
Loads
Parts
Summary
Show in panel schedule:
¥ Header
¥ Loads Summary
[V Footer
Borders

Qutside border of template; W IThin Lines 'I
Border between parts: W IThin Lines 'I

oK I Cancel | Apply |

4

The Circuit Table options allow you to define the format for the columns that display circuit
loads. Single-phase and three-phase panels can be created, with the three-phase loads column
appearing in the center of your schedule no matter what you do to format the other columns.
The values in these columns cannot be edited, and you cannot replace them with another
parameter. In Revit MEP 2016 you have the ability to show the phase values as either Load or
Current.

The Loads Summary options let you set which load classifications will be listed when the
loads summary is included in your schedule. All load classifications that exist in your project are
shown on the left, and the ones that appear in the schedule are listed on the right. If you choose
the option for displaying only those loads that are connected to the panel, all the classifications
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move to the Scheduled Loads list. When you create a Panel schedule, only the classifications that
are connected appear; however, the loads summary has blank rows for the unused classifications,
as shown in Figure 7.43.

The tools on the Modify | Panel Schedule Template contextual tab of the ribbon are the same
kind of tools that you would find in a spreadsheet program. You can merge cells, add or delete
columns and rows, set the borders and shading of cells, and set the alignment of column data.
You can also adjust the font for a cell or group of cells. Many of these tools are also available on
a menu that appears when you right-click a cell in the schedule view. You can adjust row and
column heights and widths by clicking and dragging the borderlines in the schedule view.

The Parameters panel of this tab has a drop-down for selecting a category and a drop-
down for selecting parameters within a chosen category to be placed in a column. You can
place unique parameters in individual cells in any area of the schedule except for the circuit
table. When you click a cell in the circuit table and select a parameter, that parameter popu-
lates all the cells in that column and the corresponding column on the other side of the table.
When you click a cell in the Circuit Table area, the only category available in the drop-down is
Electrical Circuits. In other areas of the schedule, you can choose parameters from the Electrical
Equipment and Project Information categories.

FIGURE 7‘43 Load Classification Connected Load Demand Factor | Estimated Demand Panel Totals
HYAC 73502 VA 100.00% 73502 VA
Loads summary Lighting 9780 VA 125.00% 12225 VA
Other VA 0.00% 0VA
Receptacles 29520 VA B6.94% 19760 VA Total Conn. Load: | 112927 VA
Water Heater 125 WA 125.00% 156 VA Total Est. Demand: | 105643 VA

Total Conn. Current: | 136 A
Total Est. Demand Current | 127 A

You can set the units to be used in the circuit table with the Format Unit button on the
Parameters panel. There is also a button for creating a calculated value in a cell. This tool works
the same way as in a building component schedule. The Combine Parameters button allows you
to put multiple parameters in a single cell. It is similar to the tool for building a label in an anno-
tation or tag family. You choose the parameters for a cell, the options for a prefix or suffix, and
how the parameters will be separated if necessary.

Using Schedules for Project Management

You can apply the scheduling capabilities of Revit to other areas of your project to facilitate proj-
ect management and organize construction documents. You can even use schedules as a way to
coordinate plan notes and ensure coordination between notes and their callouts.

Sheet List

Another type of schedule available on the Schedules button is a Sheet List schedule. A Sheet

List schedule is built with the same tools as a model component schedule, but all the parameters
are related to sheets. Creating a Sheet List schedule is useful for managing your project docu-
mentation because the schedule allows you to track what sheets have been created, revised, and
checked. You can create custom parameters that apply to sheets for management by other means.
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FIGURE 7.44 Shest List
. =oneel LIST=
Sheet List
schedules A ! B | < . D . E
Sheet Mumber | Sheet Name i Sheet lzsue Date : Current Revision : Submitted

EE01 Panel Schedules O3M0EM 4 [
E301 Morth Lewel 1 - Lighting Plan 030614 Hl
MED Duct Sections 030614 -
w707 Wechanical Schedules 030614 [
E201 Level 2 Lighting 0353014 c2 [
100 MECHAMICAL LEGEND 040314 -
E101 Electrical Povwer Rizer Diagram 040614 1 ~
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If you are required to submit a list of all the drawings in a submittal package, you can use a
Sheet List schedule. Using a Sheet List schedule ensures that all the sheets created in your proj-
ect are listed. Some submittals do not require all sheets to be submitted, so a custom parameter
that allows you to control what sheets are included in a submittal is a good way to manage your
sheet list.

As with most schedules that appear on construction documents, it is a good practice to have
two Sheet List schedules in your project: one that has all the parameters that you need for track-
ing and making changes and another that is actually included in your construction documents.
This keeps you from having to hide and unhide columns when working in the schedule view.
Figure 744 shows a Sheet List schedule with a parameter for whether a sheet is submitted and,
on the bottom, the corresponding Sheet List schedule that appears in the construction docu-
ments. The schedule on the bottom is filtered by the Submitted parameter so that only sheets
that are selected appear in the list.

<Drrawing List>
n B | C 0
NUMBER MAME | ISSUE DATE REY
E101  iElectrical Pover Rizer Diagram i D40EN4 P |
E201  Level 2 Lighting . 03m0nd oz |

Even though you may have established how sheet views are organized in the Project
Browser, it may not meet your requirements for listing the sheets included in a project submit-
tal. You can use a custom parameter (Publish Order) to sort your Sheet List schedule in the order
you require. You can use a numbering system in combination with the items being listed alpha-
betically to arrange the sheets in your schedule, as shown in Figure 7.45.

Notice that different decade groups are used for each discipline so that sheets can be orga-
nized within a discipline. This allows the electrical site plan to be listed before the plan sheets,
for example, without requiring a unique number to be provided for each sheet.
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FIGURE 7.45 <Sheet List>

Sorting the Sheet
. A B | C | [1] E F
List schedule Sheet Mumber Sheet Mame | Sheet Issue Date | Current Revision | Submitted Publish Order
EG01 Panel Schedules 030614 1 ¥ 1
E301 Morth Level 1 - Lighting Plan 03814 1 Vv 5
G Duct Sections 030614 Cc2 v 2
701 Mechanical Schedules 03A06/14 c2 d &
E201 Level 2 Lighting 0373014 c2 Vv 3
K100 MECHAMICAL LEGEND 0403714 1 ~ v
E101 Electrical Power Rizer Diagram 0408014 1 v 4
<Drawing List>
A B | c | b
MUMEER MAME | ISSUEDATE | REY
EE01  :Panel Schedules 0306414 5]
MEDT  Duct Sections 030614 c2
E201 Level 2 Lighting 0343041 4 c2
E10 Electrical Povwwer Riser Diagram D40EN 4 21
E301 Porth Level 1 - Lighting Plan 030614 1
M7 :Mechanical Schedules 0306414 c2
M100  MECHAMICAL LEGEMD 040314 1

View List

A View List schedule is another type of schedule that can be created from the Schedules button
on the View tab. Similar to a Sheet List schedule, a View List schedule can help you keep track
of the views that exist in your project.

WHY NOT USE THE PROJECT BROWSER?

It may seem a bit redundant to create a View List schedule when all views are organized in the Project
Browser, but a View List schedule enables you to view the properties of several views quickly and
all at one time. It also allows for quick comparison and editing of multiple views.

When printing a set of construction documents, you want to be sure that all your views that
should be on a sheet have been placed onto the appropriate sheet. Not only does this save you
the time it would take to visually inspect each sheet, it can also save paper and wear and tear on
your printer.

A View List schedule is constructed with the same tools as a Sheet List schedule, except only
parameters that apply to views can be used in the schedule. Unfortunately, not all view param-
eters can be scheduled, but there are many that are useful for project management. When work-
ing in a project that includes phases, a View List schedule can be a useful tool for ensuring that
views are set to the proper phase and have the proper phase filter applied.
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To create a View List schedule that shows only views that are placed on sheets, you can use
a filter. If you use the Sheet Number parameter as a filter with the Does Not Contain rule and
leave the value blank, the expected result would be a schedule that shows only those views that
are placed on a sheet.

Yiew List Properties

'Fields  Filker |Sorting,|’Gr0uping | Formatting | Appearancel

Filter bry: ISheet Murnber j Idoes nat contain j I‘

And: I(nuna) j I j I j

Normally, you would apply a filter to remove all the scheduled items that do not meet your
filter requirements. However, using these settings actually removes all views that meet the
requirements of the filter, causing your schedule to list all the views that have no value for the
parameter.

Note Block

A Note Block schedule is based on an annotation family that is used in your project. Note Block
schedules are useful for managing plan notes on your construction documents as an alternative
to keynoting. As note annotations are placed in a view, they can be given a description, and then
a Note Block schedule can be created to list the descriptions of each instance of the annotation.
Figure 7.46 shows the properties of a note annotation family used for plan notes.

FIGURE 7.46 1
Note annotation
properties
MyCo_Indicator - ° 7___,.--"
2 i
2 11T
- =1 52 Edi +
Generic Annotations (1) J Edit Type :

A Usage parameter has been created to determine to which sheet the note belongs. The
Description parameter holds the contents of the note. Once a note annotation is placed in a view,
it can be copied for each instance to create the next note in the list.

A Note Block schedule is created by choosing the Note Block option from the Schedules but-
ton on the View tab. The annotation family that is used for plan notes is selected to be sched-
uled. The title of the Note Block schedule should be a description of where the notes are located
to make it easy to locate the Note Block schedule in the Project Browser. The Note Number,
Description, and Usage parameters are added to the schedule. The schedule is then filtered by
the Usage parameter so that only note annotations that appear on a specific sheet appear in
the schedule, and the Usage parameter is hidden. The schedule is sorted by the Note Number
parameter.

It is important to establish the Usage parameter value for the first note annotation placed
into a view and then to copy that view whenever a new note is required. Copying the note
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annotation ensures that the Usage parameter value is the same for each note in the plan view.
The Note Block view and its associated plan view can be tiled so that as you add note annota-
tions to the plan view, you can see them appear in the schedule. The Properties palette gives
you instant access to the Description parameter of the note annotation so changes can be
made easily.

One benefit of using a Note Block schedule over static text for plan notes is that if you need
to change what a note says, you can deselect the Itemize Every Instance option in the schedule
to see each unique note; then, when you change the description of the note, it changes for all
instances.

Another benefit is that if you need to delete a note, you can delete it from the Note Block
schedule and all instances are removed from the associated plan view. This ensures that you
do not have a note annotation in the plan view that references a note that does not exist in the
plan notes. It also eliminates the need for having a note in the notes list with a value of Not Used
because the notes can easily be renumbered in the Note Block schedule when a note is removed.
Renumbering the notes in the schedule automatically updates the annotations in the plan view.

When you place the Note Block schedule onto a sheet with its associated plan view, you will
want to adjust the Appearance settings so that the schedule title and headings are not shown,
giving the schedule the appearance of a list rather than a schedule, as shown in Figure 7.47.

FIGURE 7.47
PLAN NOTES
Note Block plan
M [ COORDINATE LOCATION WITH
notes on a sheet \ i
E @ 1200 AFFL
[2)G o arAL

Q =8 2N MOUNT ON A 100mm THICK CONCRETE
[3] HOUSEKEEPING PAD. SEE STRUCTURAL
DRAWINGS FOR PAD DETAILS
PAINT TO MATCH EXISTING
4 | ADJACENT SURFACE
PROVIDE 2No. 75mm CONDUITS
[5]Up 70 second FLOOR

Q LEVEL 1 ELECTRICAL

1:100

The symbolic representation for each note is provided by attaching a suitable image to the
family, in the Type Image field, prior to loading the family into the project.

It can be easy to get carried away when importing images. It is a good idea to review each
one to ensure project file performance isn't unduly affected by large files.

USING SCHEDULES ACROSS PROJECTS

One of the most popular ways to take a schedule from one project to another is to use the Insert
Views From File command located under the Insert tab. Another, even easier way is to simply open
the two projects in the same Revit session and use Ctrl+C/Ctrl+V from either the sheet view or the
Project Browser, to copy/paste.
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The Bottom Line

Use the tools in Revit MEP 2016 for defining schedules and their behavior. The capabilities
of schedules in Revit MEP 2016 can increase your project coordination and the efficiency of
your workflow. The ability to track items within a model can help you better understand the
makeup of your design.

Master It The information in schedules comes from information stored within the
objects of a Revit model. Explain why editing the data of an object in a schedule changes
the properties of the object.

Schedule building components. Scheduling building components is the primary use of the
scheduling tools in Revit. Schedules are used on construction documents to provide additional
information about components so that drawings do not become too cluttered.

Master It Understanding what information can be used in a schedule is important
to setting up a specific component schedule within your Revit project. What types of
parameters can be included in a schedule? What types cannot?

Create schedules for design and analysis. Scheduling can go beyond counting objects and
tracking their information. You can also create schedules that assist in making design
decisions by providing organized analytical information.

Master It The information stored in Space objects often comes from their relationship
with other objects. Some of the data for analysis needs to be input manually. Explain how
using a schedule key can assist in adding data to a Space object.

Schedule views and sheets for project management. You can schedule notjust the
components that make up a model but also the views and sheets within your project. Special-
ized schedules for views and sheets are useful for project management.

Master It A Note Block schedule enables you to list information about annota-
tion families within your project. What are some of the benefits of using a Note Block
schedule instead of static text for plan notes?
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Chapter 8

HVAC Cooling and Heating Load
Analysis

Accurate modeling of a building is essential in designing and sizing an energy-efficient HVAC
system for today’s market. The majority of time during the mechanical design phase of a project
can be spent on correctly modeling the building in a load-simulating program, such as Trane
TRACE 700, DOE-2, or Carrier’s Hourly Analysis Program (HAP).

Although these programs are essential to you, the mechanical designer, setting up the build-
ing accurately for equipment sizing within these programs can often be a tedious task. Each
space is set up individually, and typically the physical layout and use of each space will be
different. Alterations to the building design or space usage by the architect or building owner
during this phase will cause you to return to any previously modeled spaces and coordinate
the necessary changes. This is time-consuming and can often be a point of contention between
disciplines when changes occur later in the design phase.

Autodesk® Revit® MEP software enables you to model the building spaces accurately as
well as quickly and efficiently track any building design and construction changes on the fly,
all within the project file. Revit MEP also gives you the option either to model the HVAC loads
within the program itself or to export the space load data via a Green Building XML (gbXML)
schema file to an external simulation software program. An addition to this workflow is the
ability to analyze the mass model.

In this chapter, you will learn to do the following:

¢ Prepare your Revit MEP model for analysis

Perform heating and cooling analysis with Revit MEP 2016

¢ Perform a conceptual energy analysis on your building
¢ Analyze duct and pipe system pressure with Revit MEP 2016
¢ Export gbXML data to load-simulating software

Modeling Spaces for Building Load Analysis

The key to any successful building load analysis, as well as energy analysis, lies with accurately
modeling the spaces within the building. Components that need to be modeled for each space
include, but are not limited to, building construction, such as walls, roofs, and floor slabs; exter-
nal shading and windows; internal loads, such as the number of people, the activity within the
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FIGURE 8.1
Sample building
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space, the heat gain from lighting, and the equipment operated within the space; and external
factors, such as solar heat gain to the space, weather and typical outdoor temperatures, and infil-
tration. These are but a handful of factors that need to be addressed for each space that is being
created. Each of these factors has several significant inputs that can affect the reporting of heat-
ing and cooling loads within the space.

Creating Spaces
First things first—spaces need to be created in the project file. Why? It seems redundant to cre-
ate spaces, seeing as how the architectural model already has rooms created and defined, right?

Not so.

In Revit MEP, spaces are created within room-bounding elements such as walls, floors, ceil-
ings, roofs, and room separation lines that exist in a linked architectural model or from these
types of elements within your MEP model. This means that the same elements that define a
room in the architectural model define the spaces in your MEP model. Spaces carry the engi-
neering data that is necessary for analysis, whereas rooms contain the information required
by the architects. After loading your MEP project and linking in the appropriate architectural
model, you want to make sure that the elements that make up a room—walls, doors, ceilings,
and so on—will define your MEP space accurately. Figure 8.1 shows a sample building model
with rooms.

Selecting the architectural link in your project activates the Edit Type button in the
Properties palette. Clicking this button lets you enable the selected link to be room bounding.
This option allows the boundaries of the designed rooms, in the link, to define the boundaries of
the MEP spaces to be modeled. Figure 8.2 shows the Edit Type button and the Room Bounding
type parameter.

When you're placing a space, if the link is not set to Room Bounding, you get a warning that
the placed space is not in a properly enclosed region, and subsequently, if HVAC analysis is
attempted, Revit will not be able to calculate load data for that space.
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Placing Spaces

Revit allows you to create spaces within your model in two ways: by placing spaces manually
or by letting Revit locate boundaries and place spaces automatically. If your building has many
rooms, allowing the program to place the spaces automatically for you can save time.

When using automatic placement, be sure that all the spaces created are the actual spaces that
you intend to model. Check that areas such as utility chases, furrowed columns, and air spaces
in wall constructions were not included when spaces were placed. To remove any unwanted
spaces from the project file, open the System Browser, which is located on the View tab under
User Interface (or you can press F9), and set the view to Zones by choosing Zones from the View
drop-down menu at the top of the dialog box.

Select the desired spaces to remove by highlighting the space name, right-clicking, and
selecting Delete, as shown in Figure 8.3. Click OK in the pop-up window to remove the spaces
and any associated space tags permanently.

FIGURE 8.3
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If you were just to select a space within an open view and delete it without using the System
Browser, the space and its associated tag would be deleted from the model, but the space would
still be present in your project and be part of the database. This allows you to place it elsewhere
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in the model without losing important information you may have already provided. You can
also delete a space from a space schedule—it has the same result as deleting from the System
Browser. This does have an effect on any building analysis performed as well as any HVAC
systems that will be set up in the building. Systems are covered in depth in Chapter 9, “Creating
Logical Systems,” and Chapter 10, “Mechanical Systems and Ductwork.”

Creating a Space Properties Schedule

When you're simulating the heating and cooling loads of a building, correctly modeling and
accounting for space usage can be time-consuming. Often, design loads have to be revisited
because of inaccurate space modeling or design changes, incomplete accounting of space usage,
components, or internal loading. Creating a working schedule of the building space properties
in Revit MEP will help you account for, and coordinate, these factors.

Typical of all schedules within Revit, a Space schedule provides a choice of several fields to
display, to help track and modify data pertaining to each space. A working schedule such as
this for space properties is an essential tool that enables you to track how changes in certain
properties affect the loads within the spaces. Note that the schedule shown in Figure 8.4 is not
intended to be provided to a client on a project sheet but rather to be used as a personal design
tool within Revit to help you, the designer, organize the space data to better fit your personal
workflow. Create this schedule as you see fit, using the many fields, sorting, and other format-
ting options available to organize the data you need readily.

FIGURE 8.4 <Space Propetties>
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In this schedule, you will also see any not placed spaces (which are spaces that exist in the
project but not in the model), as well as any redundant and not enclosed spaces. They can also be
deleted from the project by deleting them from this schedule. To do this, simply right-click the
appropriate row in the schedule and select Delete Row.

During the initial Space Properties schedule creation, you might find the following
fields useful:

Name Designate the space name.

Number Assign each space a number.

Space Type Describe how the space will be used.
Number of People Specify the space occupancy.

Area List the space area in square feet or meters.

Construction Type Describe the space’s physical construction in this field. We go over the
various construction options later in this chapter.

Condition Type Describe the type of space conditioning (such as Heated And Cooled,
Heated, Cooled, or Unconditioned).
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Occupiable Thisisa Yes/No check box that shows whether this space will be occupied. This
is important because you don’t want spaces that are not intended to be occupied to be calcu-
lated as if they are.

Modifying Space Properties

Notice that the program defaults to a generic space naming and numbering convention when
placing spaces. It also sets the Space Type and Construction Type values as <Building>, indicat-
ing that the spaces will be modeled generically by relying on default building characteristics
that are defined in the Building/Space Type Settings dialog box, shown in Figure 8.5, within the
project file.

FIGURE 8~5 Building/Space Type Settings ﬂﬂ
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SPACE NAMING

When creating spaces, Revit MEP assigns each one a generic space name and number. To reflect the
linked architectural room names and numbers in your working schedule, add the fields Room: Name
and Room: Number from the Rooms category in the Available Fields drop-down, located on the Fields
tab in the Schedule Properties dialog box. Edit the space names and numbers to match the linked file.
You can then hide the Room: Name and Room: Number columns to streamline your schedule and
unhide them periodically to view any changes that may have occurred during the design. The Space
Naming Utility add-in is another essential tool that, if installed, will name and number the spaces
automatically per the architectural link. It is available for download from the Autodesk website for
subscription customers.
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How a space will be used is the overall factor driving the internal loads within a space. An
enclosed office space is modeled differently from the conference room next door, and an office
break room is modeled differently from a typical restaurant dining room. Lighting, population
density, activity levels, equipment, and ventilation loads all vary with the space type.

If you open the Manage tab and then choose MEP Settings > Building/Space Type Settings,
you will be able to view and modify the space type options within Revit MEP as well as the
global building types (see Figure 8.5).

In the Building/Space Type Settings dialog box, you can choose to define overall building
types or individual space usage types. Defining an overall building type can be a good option if
you want to do a quick takeoff of a typical building type for the overall model or when perform-
ing a preliminary energy analysis, which we touch on later in this chapter. You are given similar
parameters to define how you model a building, as well as options to set building operating
times (Opening Time and Closing Time) and an Unoccupied Cooling Set Point parameter.

Revit MEP has several predefined options to model how the building, as well as each space,
is utilized, and each option has preset parameter and schedule values for the internal loads.
Parameters such as Area Per Person, Lighting Load Density, Power Load Density, and Sensible
Heat Gain Per Person should all be familiar to you. You can use the preset values within the
program, or you can input more accurate design load values based on typical code-driven or
industry-standard values.

You can access the Space Type Settings dialog box from the Properties palette when a space
is selected in your view. You can also access it from within your Space Properties schedule by
locating the cell in the Space Type column (if used in your Space Properties schedule) for the
space you would like to modify and then selecting the ellipsis that appears next to the current
type name when you click in the field. If you click the People or Electrical Loads button in the
Properties palette when a space object is selected, the default values within these windows are
the values listed in the Space Type Settings dialog box. Figure 8.6 shows the dialog box for estab-
lishing the occupancy and heat gain values, whereas Figure 8.7 shows the schedule settings
accessed from the Space Type Settings dialog box.
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